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1 What is Data Control Tower (DCT)?

Today’s application and data landscape is an increasingly complex ecosystem of hosting architectures, often
represented by a multi-cloud landscape coupled with an explosion of different platforms and services. This
fragmented picture of heterogeneous silos makes data governance, automation, and compliance a herculean, if
not, an impossible task.

Multicloud Increases Data Complexity, Risk

Every cloud offers proprietary point solutions with differing functionality, APls

On Premises Cloud
Private Datacenter SaaS, PaaS, laaS

—: | & aws A 3

Data Monolithic, Siloed Apps DataPlex
Governance and Data Sources SFDC Platform AWS DataZone Azure AD Data Catalog
Data Manual, Ticket-Driven GCP DM
Automation Workflows Sandbox AWS DMS Redgate e
Data i 5 ic i
) SR, SHELE DataMask AWS DDM Purview ElfEiy
Compliance Infrastructure Masking

Data Control Tower (DCT) is an enabling Delphix platform that introduces a data mesh to unify data governance,
automation, and compliance across all applications and cloud platforms.

Data governance is achieved through operational control and visibility of test data across multicloud applications,
databases, environments, and releases. DCT brings data cataloging, tagging, and data access controls for central
governance of all enterprise data, while providing the right data at the right time to development teams.

Data automation at Cl/CD speed and enterprise scale is easier and more powerful, by combining DCT with
Continuous Data. A unified API gateway, self-service automation tools, and plug-and-play DevOps integrations
streamline the initial configuration and day-to-day workflows.

DCT with Continuous Compliance provides robust data compliance in lower environments, all while reducing
costs and enabling fast, quality software development.

What is Data Control Tower (DCT)? - 10
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2 Release notes

This section is used to learn what the newest version of Data Control Tower has to offer. In addition, the fixed and
known issues per version are detailed.

2.1 New features

2.1.1 Release 8.0.0

« Operations dashboard
Monitor and manage enterprise data activities in real time using a new central view. This provides visibility
to the current status across the full complement of Delphix transactions, including provision, refresh,
teardown, and compliance jobs.

« Provisioning wizard enhancements
The data provisioning wizard has been expanded to support additional types, including Oracle Single
Instance Linked CDBs and Microsoft SQL Server Single Instance workflows. This will now allow you to
provision more data types directly from Data Control Tower.

« Advanced search tags support
The advanced search capabilities now support all user-generated tags. You can use personalized tags
related to your unique business needs to refine your search results, such as team names or other specific
data points.

2.1.2 Release 7.0.0

+ Provision VDB Ul
Extending the Developer Experience capability in DCT, users can now provision single-tenant Oracle
databases from the user interface using an intuitive wizard workflow.

+ Refresh VDB Ul enhancements
The VDB list can now be opened in a searchable, paginated list selector from within a dialog by clicking
the select button in the input. Additionally, refreshing a VDB by a bookmark is now available.

« VDB template import
Importing and removing imported VDB templates from connected engines is now an available action from
the "VDB Config Templates" page.

« Environment details enhancements
Managing cluster environment infrastructure has been made easier with the ability to edit host details
directly from the page.

2.1.3 Release 6.0.0

« Developer Self-Service Ul
Developers and admins now have the ability to centrally orchestrate common Continuous Data and
developer operations from the DCT Ul. This includes the ability to refresh, rewind, bookmark, and bookmark
share (refresh to relative). This functionality also exposes the notion of time flows (non-active timelines),
which is a critical tool for viewing past work on a VDB, such as the chronology of test results.

« Central Compliance Orchestration
The compliance job Ul now enables job orchestration and reporting. This includes Job Copy and Execute
functions as well as a complete historical job execution log within each compliance job’s details view.

« Bookmark Ul
Developers and admins now have added visibility of bookmarks, both globally and contextualized, to

Release notes - 11
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individual VDBs. These visualizations are dual purpose; for administrators, these screens help with reporting
and tagging on bookmarks, while for developers, these screens act as a catalog of actionable data
references.

+ Global Bookmark List
View all bookmarks across your entire connected Delphix ecosystem. This screen will show bookmarks for
both single VDBs and VDB groups.

« VDB Bookmark List
See all bookmarks tied to this individual VDB. This is helpful for sharing bookmarks with team members who
have a compatible VDB (same parent and provision point).

« Environment Detail Page
Users can now orchestrate common environment actions via the DCT Ul including enable, disable,
environment refresh, and delete, as well as editing host details. Note, editing host details is only applicable
to standalone environments at this time.

+ Access Visibility
Object detail pages will include an access tab that provides visibility to user access and the associated
permissions for each user. This is a critical enabler for permissions visibility and auditing.

« Copy/delete functionality on role scopes
Scoped roles can now be copied and deleted within the DCT UL. This will enable easier administration,
especially around the use of custom roles, as admins can now copy and modify new roles from templates.

« External Postgres DB support
DCT now supports the use of an external Postgres database to house DCT metadata. Previously, DCT
supplied and managed its own database, requiring persistent storage within the container platform.

2.1.4 Release5.0.1

2.1.4.1 Enhancements

« Data scoped Access Group
+ Enhancementin Roles
Associated permissions in roles are changed from 'string' type to 'permission object' type. For details,
see the Role schema in the API References(see page 150).
+ Custom Roles
In addition to the 5 pre-seeded fixed roles (Admin, Monitoring, DevOps, Masking, and Owner), DCT
provides flexibility to create new custom roles as per user need. Users (Accounts) can create new
custom roles by encapsulating any combination of permissions. The custom roles can be configured
through a Ul configuration screen (screenshot below), in addition to a set of APIs to manage roles. For
details, see the API References(see page 150).
« Updates to existing RBAC model
For better usability and allow to set more granular permissions there are following enhancements in the
RBAC model:
+ Renamed Access Group "Policy" to Access Group "Scope"
+ Renamed the following APIs related to Access Group actions
« Add scope to an Access Group

POST: /access-groups/{accessGroupId}/policies — POST /access-

groups/{accessGroupId}/scopes
« Remove scope from Access Group
DELETE /access-groups/{accessGroupId}/policies/{policyId} -

DELETE /access-groups/{accessGroupId}/scopes/{scopeld}

Release notes - 12
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» Get Access Group scope
GET /access-groups/{accessGroupId}/policies/{policyId} — GET /

access-groups/{accessGroupId}/scopes/{scopeld}
« Update Access Group scope
PATCH /access—groups/{accessGroupId}/policies/{policyId} -

PATCH /access-groups/{accessGroupId}/scopes/{scopeld}
+ Add object tags to Access Group scope
POST /access-groups/{accessGroupId}/policies/{policyId}/object-

tags — POST /access-groups/{accessGroupId}/scopes/{scopeld}/
object-tags

+ Remove object tags from Access Group scope
POST /access-groups/{accessGroupId}/policies/{policyId}/object-

tags/delete — POST /access-groups/{accessGroupld}/scopes/

{scopeld}/object-tags/delete
+ Add objects to Access Group scope
POST /access-groups/{accessGroupId}/policies/{policyId}/objects

— POST /access—-groups/{accessGroupId}/scopes/{scopeld}/objects
+ Remove objects from Access Groups scope
POST /access-groups/{accessGroupId}/policies/{policyId}/objects/

delete — POST /access-groups/{accessGroupId}/scopes/{scopeIld}/

objects/delete

+ Renamed the "everything" flag to "scope_type"
In order to make it more understandable, we have renamed the everything flag to scope_type. There
are three possible values for scope_typei.e. SIMPLE, SCOPED and ADVANCED. The value SIMPLE
corresponds to everything=true and SCOPED corresponds to everything=false. The value ADVANCED
for scope_type is new enhancement to setting permissions which allows users to set permissions
(e.g. READ, DELETE) for an object. There is more information about ADVANCED scope in next section.
+ Access Group Scope: Advanced scope type
In Add objects to access group scope API, now user can define permissions level checks as well for an
object. For example, earlier when object_id and and object_type are provided in request payload, all
permissions that are defined in scope are applied to this object. But now user can define specific
permissions.
« Masking Jobs
« CRUD APIs, COPY, Connectors CRUD
« Masking Job Execution
+ Connector Credentials
« Execution API

2.1.4.2 Custom Roles

+ Accounts can create new instances of role encapsulating any combination of permission.

+ Role name must be unique.

« Custom roles can be updated. Accounts can add or remove permissions to/from the custom roles.
« Custom roles can be deleted. (If they are not associated with any Access Group).

Release notes - 13



2.1.5 Release 4.0

Environment Overview List
Un-virtualized Source Sizing Report
Global VDB Templates

Scoped Access Control

LDAP/AD and SAML/SSO Configuration Ul

2.1.6 Release 3.0

Cluster Node (RAC) management APIs

Ability to disable username/password authentication globally
LDAP/Active Directory groups

CDBs/vCDBs APIs

VDB Provisioning / update for EDSI (AppData) platforms
Engine registration wizard

Access Groups Management Ul

Compliance Engine Management

2.1.7 Release 2.2

2.1.7.1 Deployment

Introducing Kubernetes and OpenShift support

2.1.7.2 APIs

Registration of Continuous Compliance Engines

Masking Connectors

“Move Masking Job”

Masking of mainframe objects

Provisioning enhancements for Oracle multi-tenant and RAC
LDAP/Active Directory authentication

Password management

Data Control Tower - Data Control Tower Home

Initial access management by Permissions, Roles, Policies, and Access Groups (permissions applied to all

objects of a type e.g. Stop VDB permission on all VDBs)

Distributed tracing and logging (Trace ID propagated down call stack)

Bulk delete of tags

2.1.7.3 Ul

« Continuous Data

+ Added tag support to the Infrastructure page
» New dSources page
« New VDBs page

+ Insights
+ Added an export behavior to the Storage Summary report

« New dSource Inventory report

Release notes - 14
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+ New VDB Inventory report

+ Admin
« New Accounts page

2.2 Fixed issues

2.2.1 Release 8.0.1 changes

Bug Number

APIGW-4324

APIGW-4317

2.2.2 Release 8.0.0 changes

Bug Number

APIGW-3764

APIGW-3771

APIGW-3783

APIGW-3985

APIGW-3990

Description

Fixed an issue where users who upgraded to DCT 8.0.0 were not able to
interact with the Ul or connect to the GraphQL service container.

Fixed an issue where an error would occur when searching for a VDB in the
relative refresh UL.

Description

Removed THE requirement on setting credentials if a masking job
execution happens on the origin engine.

Allows the policy name to be empty when provisioning a VDB.

Allows for an existing ImagePullSecret to be provided to to pull docker
images.

Fixed the "VDB Container is part of a container" error while refreshing
from bookmark directly on the VDB > Bookmark tab.

Fixed the broken view for a bookmark that has multiple VDBs on the Data
> Bookmark tab.
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2.2.3 Release 7.0.1 changes

Bug Number Description

APIGW-3592, Previously, a non-admin user that was granted access to a VDB, but not its

APIGW-3594 environment, would get an error accessing the VDB overview. A fix has been
implemented to show that the access error is with the environment and not
the VDB.

APIGW-3775 Fixed an issue where refreshing from the bookmark wizard was not showing

compatible bookmarks.

APIGW-3831 Fixed a certificates import failure if the truststore is on OpenShift.

2.2.4 Release 6.0.1 changes

Bug Number Description
APIGW-3460 Fixed a request timeout issue.
APIGW-3395 Fixed an issue where the refresh wizard did not update snapshots when

selecting different datasets.

2.2.5 Release 6.0.0 changes

Bug Number Description

APIGW-3223 Fixed an issue where DCT failed to get info from detached dSources.

2.2.6 Release 5.0.3 changes

Bug Number Description
APIGW-3344 Fixed an issue causing provision failure from RAC dSource to non-RAC
target.
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2.2.7 Release 5.0.2 changes

Bug Number
APIGW-2979

APIGW-2981

2.2.8 Release 5.0.1 changes

Bug Number

APIGW-2463

APIGW-2735

APIGW-2828

2.2.9 Release 3.0.0 changes

Bug Number

APIGW-1785

Data Control Tower - Data Control Tower Home

Description

VDB refresh will no longer fail if the refresh target name is not unique.

Fixed an issue where all the Compliance jobs and source jobs on the
engine will be deleted when a Compliance engine is unregistered.

Description

The default docker-compose.yaml file is now provided with log size and
rotation configured for all containers.

Fixed an issue where DCT migration failed with "could not create unique
index environments_host_pkey".

Helm chart now allows cronjob resource limits to be set via the
values.yaml.

Description

Fixed an issue where Nginx sometimes failed to start after a server
restart.
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3 DCT concepts

3.1 Introduction

Data Control Tower (DCT) provides new and novel approaches to general Delphix workflows, delivering a more
streamlined developer experience. This article will introduce these concepts to Delphix and how they work with
DCT.

a For VDB Provisioning, the Ul supports these data platforms:
+ Oracle Single Instance Single Tenant
+ Oracle Single Instance Multi Tenant (for Linked CDB only)
+ MSSql Single Instance

For Infrastructure Connection Wizard, only UNIX standalone environments can be added via the Ul.

3.2 Concepts

3.2.1 Virtual Database (VDB) groups

Virtual Database (VDB) groups are a new concept to Delphix, which enable the association of one or more VDBs as a
single VDB group. This allows for bulk operations to be performed on the grouped VDBs, such as bookmark,
provision, refresh, rewind, and others. This will assist in complex application testing scenarios (e.g. integration and
functional testing) that require multiple data sources to properly complete testing.

With VDB groups, developers can now maintain data synchronicity between all grouped VDBs, which is particularly
useful for complex timeflow operations. For example, updating VDBs to reflect a series of schema changes across
data sources, or to reflect an interesting event in all grouped datasets. In order to maintain synchronicity among
grouped datasets, timeflow operations (refresh, rewind, etc.) must use a bookmark reference.

DCT concepts - 18
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In the above example, a VDB Group reference is created for three VDBs. At the end of the above timeline group, a
developer decides to rollback those VDBs to a previous snapshot. By issuing a single command via the VDB groups
endpoint, DCT will move all three back, ensuring that they all maintain referential synchronicity.

Bookmarks and VDB groups are loosely related; a VDB group can exist in the absence of any bookmarks, and a
bookmark can exist without any VDB group. It is important to note that the bookmark represents data, while the
VDB group represents the databases to make this data available.

a DCT will automatically stop an operation from executing if one or more objects are incompatible (e.g.
provisioning a VDB group into a set of environments, where one of the VDBs is incompatible, such as an
Oracle on Linux VDB provisioned onto a Windows environment).

VDB groups based operations will return a single job to monitor the overall status of the series of
individual VDB operations. If one of those individual operations is unable to complete, DCT will report a
“fail”, but any individual operations that are able to successfully complete will still do so.

3.2.2 Comparing Self-Service containers to VDB groups

As mentioned above, VDB groups are a crucial DCT concept that enable Self-Service functionality outside of the
Self-Service application. Consider VDB groups acting similarly to Self-Service containers, in that it provides
grouping and synchronization among VDBs, but VDB groups can provide a more flexible approach for users. Here
are some additional points for example:

» The same VDB can be included in multiple VDB groups

+ Including a VDB in a VDB group does not prevent operations on the VDB individually
+ VDBs can be added to or removed from VDB groups

+ VDB groups do not have their own timeline
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3.2.3 Bookmarks

DCT Bookmarks are a new concept that represents a human-readable snapshot reference that is maintained within
DCT. This is not to be confused with Self-Service bookmarks, maintained separately within the Self-Service
application. With DCT Bookmarks, developers can now reference meaningful data (e.g. capturing a schema version
reference to pair with an associated code version, capturing test failure data so that developers can reproduce the
error in a developer environment, etc.) and use those references for any number of use-cases (e.g. versioning data
as code, quickly provisioning a break/fix environment with relevant data, etc.). DCT Bookmarks are compatible with
both VDBs and VDB groups, and can be used as a reference for common timeflow operations such as:

+ Provisioning a VDB or VDB group from a bookmark
+ Refreshing a VDB or VDB group to a bookmark
« Rewinding a VDB or VDB group to a bookmark

(@ DCT Bookmarks have associated retention policies, the default value is 30 days, but policies can be
customized anywhere from a day to an infinite amount of time. Once the Bookmark expires, DCT will
delete the bookmark.

Bookmarks are compatible with individual VDBs and VDB groups. Bookmark Sharing is only available for
engines on version 6.0.13 and above.

DCT Bookmarks, when created, initiate a snapshot operation on each and every VDB in order to maintain
synchronicity between each VDB. In that same vein, bookmark-based VDB group operations will have each
VDB-specific sub-process run in parallel (as opposed to sequentially) to reduce drift between grouped
VDBs.

3.2.4 Jobs

Jobs in DCT are the primary means of providing operation feedback (PENDING, STARTED, TIMEDOUT, RUNNING,
CANCELED, FAILED, SUSPENDED, WAITING, COMPLETED, ABANDONED) for top-level operations that are run on DCT.
Top-level operations represent the parent operation that may have one or more child-based jobs (e.g. refreshing a
VDB group is the parent job to all of the individual refresh jobs for the grouped VDBs under the VDB group
reference).

a Top-level jobs will report a “FAILED” status if one or more child jobs fail. For child jobs that can complete,
DCT will continue to complete those jobs even if a parent job reports a failure.

3.2.5 Tags

DCT Tags enable a new business metadata layer for users and consumers to filter, sort, and identify common
Delphix objects, to power any number of business-driven workflows. A tag is comprised of a (Key:Value) pair that
associates business-level data (e.g. location, application, owner, etc.) with supported objects. DCT 2.0 and above
support the following Tags:

« Continuous Data Engines
« Environments

« dSources

« VDBs
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Developers and administrators add and remove tags using tag-specific object endpoints (e.g. /vdbs/{vdbId}/

tags ) and can leverage tags as search criteria when using the object-specific search endpoints (e.g. using filtering
language to narrow results).

Some sample tag-based use-cases include:

«+ Refreshing all the VDBs owned by a specific App Team using an “Application: Payment Processing” tag. This
would be accomplished by querying “what VDBs have the (Application: Payment Processing) tag" and
feeding those VDB IDs into the refresh endpoint.

» Driving accountability for VDB ownership by tagging primary and secondary owners for each VDB (e.g.
(primary_owner: John Smith), (secondary_owner: Jane Brown)). That way, if a VDB is overdue for a refresh,
tracking down an owner is a simple tag query.

E Tags are registered as an attribute that is specific to an object as opposed to a central tagging service. As
a result, tag-based querying can only be done on a per-object type basis.

A supported object can contain any number of tags.

3.2.6 Tag-based filtering

All taggable objects support tag-based filtering for API queries that adhere to the search standards documented in
API| References(see page 150). A few examples of how tag-based filtering can be used are as follows:

ListallVDBs of type 'Oracle' , of which IP address containsthe '10.1.100" string and which have been
tagged with the 'team' tag, 'app-dev-1'.

database_type EQ 'Oracle' AND -ip_address CONTAINS '10.1.100' and tags CONTAINS { key
EQ 'team' AND value EQ 'app-dev-1'}

3.3 Nuances

3.3.1 Stateful APIs

All applicable DCT APIs are stateful so that running complex queries against a large Delphix deployment can be
done rapidly and efficiently. DCT accomplishes this by periodically gathering and hosting telemetry-based Delphix
metadata from each engine.

3.3.2 Local data availability

DCT currently relies on existing Continuous Data and Compliance constructs around data-environment-engine
relationships. This means that DCT operations require VDBs to live on the engine where the parent dSource lives
and so on.
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3.3.3 Engine-to-DCT APl mapping

Wherever possible, DCT has looked to provide an easier-to-consume developer experience. This means that in some
cases, an APl on DCT could have an identical APl on an engine. However, there are many instances of providing a
higher level abstraction for ease of consumption; one example is the data inventory APIs on DCT (sources,
dSources, VDBs), which are a simplified representation of data represented by the source, sourceconfig, and
repository endpoints on the local engine (source, dSource, and VDB detail are all combined under those three
endpoints).

3.3.4 Local references to global UUIDs

In order to avoid collision of identically-named and referenced objects, DCT generates Universally Unique
IDentifiers (UUID) for all objects. For existing objects on engines like dSources and VDBs, DCT will concatenate the
local engine reference with the engine UUID (e.g. 'Oracle-1' onengine '3cec810a-

ee@f-1llec-8ea0-0242ac120002"' will be representedas 'Oracle-1-3cec8l0a-
ee0f-1lec-8ea®-0242ac120002"' on DCT).

3.3.5 Environment representations

Environments within Delphix serve as a reference for the combination of a host and instance. This is coupled with
the fact that environments can be leveraged by multiple engines at the same time and that engines often have a
specific context to some of the elements that comprise an environment. For example, an environment could have
both an Oracle and ASE instance installed and that Engine A leverages an Oracle-based workflow and Engine B
leverages an ASE workflow. DCT will create two identifiers to represent the specific host and instance combinations.
Thus, in DCT, Engine A will be connected to a different uniquely identified Environment than Engine B.

As mentioned earlier with Engine-to-DCT APl mapping, DCT aims to simplify the user experience with Delphix APIs
by combining different Continuous Data endpoints into a simplified DCT API. The Environment API does this by
combining environment, repository, and host endpoints so that writing queries against Delphix data is a much
simpler process. One example would be identifying all environments that have a compatible Oracle home for
provisioning:

repositories CONTAINS { database_type EQ 'Oracle' and allow_provisioning EQ true AND
version CONTAINS '19.2.3'}

3.3.6 Supported data sources/configurations

DCT is compatible with all Delphix-supported data sources and configurations.

3.3.7 Process feedback

Whenever a DCT request completes, it will return a JOB ID as its response. This Job ID can be used in conjunction
with the jobs endpoint to query the operation status.
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4 Deployment

Data Control Tower is a container-based architecture and is currently certified with Kubernetes and OpenShift to
align with common enterprise container standards. The DCT architecture is comprised of multiple micro-services
that are each run on individual pods. This lends DCT to be a highly flexible and resilient deployment by enabling
customers and IT organizations to enact their own backup, scaling, and resiliency standards associated with
hosting container-based applications. Below is an architectural diagram of all the services that make up DCT as well
as the persistent storage for maintaining relationship metadata.

Kubernetes Cluster
Worker Node \
Namespace \
CEiSEpices @ ul 7@ data-bookmarks ITD

/®@Graphm 7@ data-library < _.‘@ Po@
@ @& , %,\

Port 443, 80 ] o jobs >

Y

Port 443, 80
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@ Persistent Storage v \
gateway-data _— gwdatabase-data
L 9 (168) = (wGB)/
-

DCT is multi-cloud enabled, which means that a single DCT instance can be deployed to orchestrate (via HTTPS)
Continuous Data and Continuous Compliance workloads with Delphix engines located in other networks.
Alternatively, DCT can be localized to engines located within a network. DCT is a lightweight management
application, which means that it does not require a highly performant connection to complete its work and can
serve as a central management layer for Delphix engines globally.
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C )( ) Delphix

Continuous Data Engine

This section will explain all of the required steps to deploy DCT on your container platform of choice.

4.1 Password policy default enablement

In order to enforce better security, a user password policy was enabled by default in DCT version 8.0. When a new
user is created or a password is changed for an existing user, the given password must meet the following criteria:

« Password must be a minimum of 15 characters

+ Password must contain a digit

« Password must contain a capital letter

+ Password must contain a lowercase letter

« Password must contain a special character

« Username cannot be used as the password

+ Previous two (2) passwords cannot be reused

« Maximum of five (5) incorrect password attempts allowed

To allow passwords without any restrictions or criteria, disable the password policy using the DCT API.
API: /management/accounts/password-policies

HTTP method: PATCH

Request body:

{

"enabled": false

}

/* Or, if you want to enforce a different password policy, use something similar to
this request body: */

{

"enabled": true,
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"min_length": 10,
"reuse_disallow_limit": 1,

"digit": true,

"uppercase_letter": true,
"lowercase_letter": true,
"special_character": false,
"disallow_username_as_password": true,
"maximum_password_attempts": 3

Change in password policy will not impact the existing user’s password. The new password policy will
only be applicable when the password is changed or a new user is created.

4.2 Supported engine versions

Data Control Tower has minimum engine versions that are actively tested against to ensure optimal
interoperability. Please ensure that all connected engines meet the version requirements:

Delphix Engine Version
Continuous Data 6.0.0.1 or higher
Continuous Compliance 6.0.13.0 or higher

4.3 Kubernetes

4.3.1 Installation and setup for Kubernetes

4.3.1.1 Hardware requirements

The hardware requirements for Data Control Tower (DCT) on Kubernetes are listed below. In addition to these
requirements, inbound port 443 must be open for API clients, and outbound port 443 to engines. This is the
minimum total resource request for the Kubernetes deployment of DCT. Individual service-level resource requests
are contained in values.yaml file and can be overridden during deployment.

CPU: 4-Core
Memory: 16GB
Storage: 50GB
Port: 443

The recommended minimum 50 GB of storage is shared across the Kubernetes cluster (i.e. hosts). All pods and/or
services use this storage for mounted volumes and other utilities including image storage. In a single node cluster,
if shared volumes are not externalized the host requires the full 50 GB. If the persistent volume is mounted
externally, the host requires 39 GB of storage, since the default storage required by the database (10 GB) and
gateway (1 GB) draws from the external storage. The default storage configuration for the database and gateway
can be modified in values.yaml.
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4.3.1.2 Installation requirements (Kubernetes)

DCT requires a running Kubernetes cluster to run, kubectl command line tool to interact with Kubernetes cluster
and HELM for deployment on to the cluster.

Requirement DCT Recommended Version Comments
Kubernetes Cluster 1.25 or above
HELM 3.9.0 or above HELM installation should support HELM v3.

More information on HELM can be found at
https://helm.sh/docs/ . To install HELM, follow
the installation instructions at https://helm.sh/
docs/intro/install/ .

DCT also requires access to the HELM
repository from where DCT charts can be
downloaded. The HELM repository URL is
https://dlpx-helm-dct.s3.amazonaws.com?.

kubectl 1.25.0 or above To install kubectl follow the instructions at
https://kubernetes.io/docs/tasks/tools/ .

If an intermediate HELM repository is to be used instead of the default Delphix HELM repository, then the
repository URL, username, and password to access this repository needs to be configured in the
values.yaml file under imageCredentials section.

4.3.1.3 Installing DCT

The latest version of the chart can be pulled locally with the following command:

curl -XGET https://dlpx-helm-dct.s3.amazonaws.com/delphix-dct-7.0.0.tgz -o delphix-
dct-7.0.0.tgz

This command will download a file with the name delphix-dct-7.0.0.tgz in the current working directory. The
downloaded file can be extracted using the following command:

tar -xvf delphix-dct-7.0.0.tgz

This will extract into the following directory structure:

delphix-dct

1 https://dlpx-helm-dct.s3.amazonaws.com/

Deployment - 26


https://dlpx-helm-dct.s3.amazonaws.com/
https://helm.sh/docs/
https://helm.sh/docs/intro/install/
https://dlpx-helm-dct.s3.amazonaws.com/
https://kubernetes.io/docs/tasks/tools/

Data Control Tower - Data Control Tower Home

|- values.yaml
|- README .md
|- Chart.yaml
|- templates
|-<all templates files>

For pulling the Docker images from the registry, temporary credentials would need to be configured/overridden in
the values.yaml file. For getting the temporary credentials, visit the Delphix DCT Download? page and login with
your customer login credentials. Once logged in, select the DCT Helm Repository link and accept the Terms and
Conditions. Once accepted, login credentials will be presented. Note them down and edit the

imageCredentials.username and imageCredentials.password propertiesin the values.yaml file
as shown below:

# Credentials to fetch Docker 1images from Delphix internal repository
imageCredentials:

# Username to login to docker registry
username: <username>

# Password to login to docker registry
password: <password>

imageCredentials:
username: <username>
password: <password>

After extracting the chart, install it using the following command:

helm 1install dct-services delphix-dct

a8 delphix-dct is the name of the folder which was extracted in the previous step. In the above directory
structure, the values.yaml file contains all of the configurable properties with their default values. These
default values can be overridden while deploying DCT, as per the requirements. If the values.yaml file
needs to be overridden, create a copy of values.yaml and edit the required properties. While deploying
DCT, values.yaml file can be overridden using the following command:

helm dinstall dct-services -f <path to edited values.yaml> <directory

path of the extracted chart>

Once deployment is complete, check the status of the deployment using the following command:

helm 1list

NAME NAMESPACE REVISION UPDATED

STATUS CHART APP VERSION

dct-services default 1 2023-01-10 19:33:41.713202 -0900
deployed delphix-dct-7.0.0 7.0.0

2 https://download.delphix.com/folder/1144/Delphix%20Product%20Releases/DCT
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a HELM will internally refer to the kubeconfig file to connect to the Kubernetes cluster. The default
kubeconfig file is present at location: ~/.kube/config

If the kubeconfig file needs to be overridden while running HELM commands, set the KUBECONFIG
environment variable to the location of the kubeconfig file.

8 Assuming an ingress controller configuration on the Kubernetes cluster is present, when accessing DCT
after the deployment, the ingress controller rule needs to be added for proxy service, along with port 443
(if SSL is enabled) and port 80 (if SSL is disabled).

4.3.2 DCT logs for Kubernetes

All DCT containers log to stdout and stderr so that their logs are processed by Kubernetes. To view container level
logs running on the Kubernetes cluster use:

kubectl logs <pod_name> -n dct-services

Log aggregators can be configured to read from stdout and stderr forall of the pods as per the
requirements.

4.3.3 Admin topics for Kubernetes

4.3.3.1 Deployment upgrade for Kubernetes
This article covers the upgrade process for DCT deployments on Kubernetes.

Create a new folder called dct-[version], where [version] is the latest version to which the platform is being
upgraded (i.e. if on 5.0.2, it would be 6.0.0).

$mkdir dct-[version]

Download the new version of chart using the following command in tandem with the newly created folder.

$cd dct-[version]
$curl -XGET https://dlpx-helm-dct.s3.amazonaws.com/delphix-dct-[version].tgz -o
delphix-dct-[version].tgz

a This command will download a file named delphix-dct-[version].tgz in the folder dct-[version].

The downloaded file is then extracted using the following command:
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$tar -xvf delphix-dct-[version].tgz

Which will extract into the following directory structure:

delphix-dct
|- values.yaml
|- README.md
|- Chart.yaml
|- templates
|-<all templates files>

Copy the values.yaml file from the previous version parallel to the dct-[version] folder.
a This values.yaml file contains modified values from the existing previous version of deployment.

Since the Docker Registry (AWS ECR) expires after 12 hours, the Docker Registry should be modified in the
values.yaml (from the previous existing version) with the latest password. It can be obtained from https://
download.delphix.com®. Here are some notes in regards to this step in the process:

« This password update in values.yaml is only required if the user using Delphix provided a Docker Registry
directly in the deployment (i.e. values.yaml).
« Incase a user is using their internal Docker Registry, they should first pull the next version of the Docker
images from the Delphix provided registry, using a new password.
+ Steps to pull Docker images from the Docker Registry:
Docker login command (password from https://download.delphix.com®)

$docker login --username AWS --password [PASSWORD] 762392488304.dkr.ecr.us-west-2.ama
zonaws.com/delphix-dct

Pull Docker images of DCT Services:

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:nginx-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:app-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:data-bookmarks-[VERSION]
$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:delphix-data-library-
[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:graphql-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:ui-[VERSION]

3https://download.delphix.com/
4 https://download.delphix.com/
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$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:jobs-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:postgres-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:virtualization-[VERSION]

The last step is to run the helm upgrade command:

helm upgrade -f values.yaml dct-services delphix-dct

4.3.3.2 Factory reset DCT for Kubernetes

To clean DCT installation run following command:

helm delete dct-services

& This process will delete services pod and database both.

4.4 OpenShift

4.4.1 Installation and setup for OpenShift

4.4.1.1 Hardware requirements

The hardware requirements for Data Control Tower to deploy on OCP are listed below. In addition to these
requirements, inbound port 443 or 80 must be open for API clients. This is the minimum total resource requirement
for the deployment.

CPU: 4-Core
Memory: 16GB
Storage: 50GB
Port: 443

4.4.1.2 Installation requirements (OpenShift)

DCT requires a running OpenShift cluster to run, oc command line tool to interact with OpenShift cluster and HELM
for deployment on to the cluster.

Requirement DCT Recommended Version Comments

OpenShift Cluster 4.12 or above

Deployment - 30



Data Control Tower - Data Control Tower Home

Requirement DCT Recommended Version Comments

HELM 3.9.0 orabove HELM installation should support
HELM v3. More information on
HELM can be found at https://
helm.sh/docs/ . To install HELM,
follow the installation instructions
at https://helm.sh/docs/intro/
install/ .

DCT also requires access to the
HELM repository from where DCT
charts can be downloaded. The
HELM repository URL is https://
dlpx-helm-
dct.s3.amazonaws.com®.

oc 4.11.3 or above To install oc follow the instructions
at https://docs.openshift.com/
container-platform/4.8/
cli_reference/openshift_cli/
getting-started-cli.html.

If an intermediate HELM repository is to be used instead of the default Delphix HELM repository, then the
repository URL, username, and password to access this repository needs to be configured in the
values.yaml file under imageCredentials section.

4.4.1.3 Installation process
Jumpbox setup

OC login
Run the OC login command to authenticate OpenShift CLI with the server.

oc login https://openshiftl.example.com --token=<<token>>

Verify KubeConfig
HELM will use the configuration file inside the SHOME/.kube/ folder to deploy artifacts on an OpenShift cluster.

Be sure the config file has the cluster context added, and the current-context is set to use this cluster. To verify the
context, run this command:

5 https://dlpx-helm-dct.s3.amazonaws.com/
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oc config current-context

Create a new project

Create a new project named dct-services using the command below:

oc new-project dct-services --description="DCT Deployment project" --display—-name="dc
t-services"

Installing Helm
Install HELM using the following installation instructions mentioned at https://helm.sh/docs/intro/install/.

DCT also requires access to the HELM repository from where DCT charts can be downloaded. Run the following
commands to add the repository:

curl -XGET https://dlpx—helm-dct.s3.amazonaws.com/delphix-dct-7.0.0.tgz -o delphix-
dct-7.0.0.tgztar -xvf delphix-dct-7.0.0.tgz

Deploy DCT chart

Find and update fsGroup values.yaml file

The fsGroup field is used to specify a supplementary group ID. All processes of the container, the owner of the
volume, and any files created on the volume are also part of this supplementary group ID.

For OpenShift deployment, this value need to be specified in the values.yaml file.

Find the allowed supplementary group range:

oc get project dct-services -o yaml

A response should appear as follows:

apiVersion: project.openshift.io/vl
kind: Project
metadata:
annotations:
openshift.io/description: ""
openshift.io/display-name: ""
openshift.io/requester: cluster-admin
openshift.io/sa.scc.mcs: s0:c32,c4
openshift.io/sa.scc.supplemental-groups: 1001000000/10000
openshift.io/sa.scc.uid-range: 1001000000/10000
creationTimestamp: "2023-01-18T10:33:04Z"
labels:
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kubernetes.io/metadata.name: dct-services
pod-security.kubernetes.io/audit: restricted
pod-security.kubernetes.io/audit-version: v1.24
pod-security.kubernetes.io/warn: restricted
pod-security.kubernetes.io/warn-version: v1.24
name: dct-services
resourceVersion: "99974"
uid: ccdd5c9f-2ce5-49b4-91a7-662e0598b63b
spec:
finalizers:
- kubernetes
status:
phase: Active

Copy the first value from the openshift.io/sa.scc.supplemental-groups line, before the slash (e.g.
1001000000).

Paste this value in the values.yaml file:

# Define SecurityContextConstraints for the pod
podSecurityContext:
fsGroup: 1001000000

Create values.yaml file

Create a values.yaml file and update the properties according to your environment. A sample values.yaml file can
be downloaded below.

values.yaml

(see page 30)

Deploy DCT
Run the following command to deploy the DCT chart:
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helm install -f <path to edited values.yaml> dct-services apigw-repo/delphix-dct -
version=7.0.0

Verify deployment

All the images will be downloaded and then deployed. If some pods restarted at the startup, this is expected. After
some time, a total of 9 pods will be in running status and one job pod will be in completed status.

oc get pods -n dct-services

Find API key

For the very first deployment bootstrap APl key will be printed in logs, please view gateway pod logs and find for
“NEWLY GENERATED API KEY”. the value is the API key.

oc logs <gateway-pod-name> -n dct-services

4.4.1.4 Configure Ingress
DCT only works with HTTPS Ingress, the Ul does not support HTTP.

Creating route
To create a route, you can use the OpenShift console and create a new one for the DCT service.

If SSL is terminated at this route, only then should the useSSL value in values.yaml be updated to false, so that 80
port will be exposed in proxy service and can be used to configure the route. The following screenshot shows the
route that forwards requests to 80 port of proxy service:
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If SSL is not terminated at the Route level, then create a PassTrough route and use 443 port of the proxy service, and

configure the SSL certificate and key in the values.yaml file:
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NetworkPolicies
hat the router watches to route traffic to the service
Service *
Storage
© proxy -
Builds Service to route to
© Add alternate Service
Observe
Target port *
443 —» B443 (TCP) -
Compute "
Target port for traffic
User Management Security

Secure Route
Administration

Routes can be secured using several TLS terminat
TLS termination *

Passthrough -

Insecure traffic
Redirect -

4.4.2 OpenShift authentication

4.4.2.1 Introduction

DCT uses Nginx/OpenResty as an HTTP server and a reverse proxy for the application. Using the default
configuration, all connections to DCT are over HTTPS and require the user to authenticate. There are three
supported methods for authentication; APl keys, Username/Password, and OpenID Connect.

4.4.2.2 Enable OAuth2 authentication

By default APIKey authentication will be enabled and when DCT starts it will generate a new API key(see page 55) in
logs if you want to enable openld connect authentication then follow below procedure:

Update the below properties in the values.yaml file and restart DCT:
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# flag to enable api_key based authentication

apiKeyEnabled: false

# flag to enable OAuth2 based authentication

openIdEnabled: true

# URL of the discovery endpoint as defined by the OpenId Connect Discovery
specification. This needs to be set if 'openIdEnabled' is set to true
openIdServerUrl: https://delphix.okta.com/oauth2/default/.well-known/oauth-
authorization-server

# OAuth2 jwt claim name that should be used as client_id
jwtClaimForClientId: sub

# OAuth2 jwt claim name that should be used as client_name
jwtClaimForClientName: sub

4.4.3 DCT logs for OpenShift

AlLDCT containers log to stdout and stderr, so that their logs are processed by OpenShift. To view container level
logs running on the OpenShift cluster, use this command:

oc logs <pod_name> -n dct-services

Log aggregators can be configured to read from stdout and stderr for all of the pods as per the requirements.

4.4.4 Admin topics for OpenShift

4.4.4.1 Deployment upgrade for OpenShift
This article covers the upgrade process for DCT deployments on Kubernetes.

Create a new folder called dct-[version], where [version] is the latest version to which the platform is being
upgraded (i.e. if on 5.0.2, it would be 6.0.0).

smkdir dct-[version]

Download the new version of chart using the following command in tandem with the newly created folder.

$cd dct-[version]
Scurl -XGET https://dlpx-helm-dct.s3.amazonaws.com/delphix-dct-[version].tgz -o
delphix-dct-[version].tgz

a This command will download a file named delphix-dct-[version].tgz in the folder dct-[version].

The downloaded file is then extracted using the following command:

Deployment - 37



Data Control Tower - Data Control Tower Home

$tar -xvf delphix-dct-[version].tgz

Which will extract into the following directory structure:

delphix-dct
|- values.yaml
|- README.md
|- Chart.yaml
|- templates
|-<all templates files>

Copy the values.yaml file from the previous version parallel to the dct-[version] folder.
a This values.yaml file contains modified values from the existing previous version of deployment.

Since the Docker Registry (AWS ECR) expires after 12 hours, the Docker Registry should be modified in the
values.yaml (from the previous existing version) with the latest password. It can be obtained from https://
download.delphix.com®. Here are some notes in regards to this step in the process:

« This password update in values.yaml is only required if the user using Delphix provided a Docker Registry
directly in the deployment (i.e. values.yaml).
« Incase a user is using their internal Docker Registry, they should first pull the next version of the Docker
images from the Delphix provided registry, using a new password.
+ Steps to pull Docker images from the Docker Registry:
Docker login command (password from https://download.delphix.com’)

$docker login --username AWS --password [PASSWORD] 762392488304.dkr.ecr.us-west-2.ama
zonaws.com/delphix-dct

Pull Docker images of DCT Services:

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:nginx-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:app-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:data-bookmarks-[VERSION]
$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:delphix-data-library-
[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:graphql-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:ui-[VERSION]

6 https://download.delphix.com/
7 https://download.delphix.com/
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$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:jobs-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:postgres-[VERSION]

$ docker pull

762392488304 .dkr.ecr.us-west-2.amazonaws.com/delphix-dct:virtualization-[VERSION]

The last step is to run the helm upgrade command:

helm upgrade -f values.yaml dct-services delphix-dct

4.4.4.2 Factory reset DCT for OpenShift

To clean DCT installation run following command:

helm delete dct-services:

& This process will delete both services pod and database.

4.5 Docker Compose

4.,5.1 Installation and setup for Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity, and production
DCT workloads in Docker Compose are not fully supported. Installations starting on Docker Compose may
be migrated to Kubernetes or OpenShift by using the steps in the technical documentation. In-place
upgrades from Docker Compose to Kubernetes or OpenShift are not supported.

4.5.1.1 Hardware requirements

The hardware requirements for Data Control Tower are listed below. In addition to these requirements, inbound
port 443 must be open for API clients, and outbound port 443 to engines.

CPU: 4-Core
Memory: 2GB
Storage: 50GB
Port: 443

4.5.1.2 Installation requirements (Docker Compose)

DCT requires Docker and Docker Compose to run, thus, Linux versions and distributions that have been verified to
work with Docker are supported. To see a list of supported distributions, please reference this Docker article®.

g https://docs.docker.com/engine/install/#server
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This example uses a Docker installation® and is completed on an Ubuntu 20.04 VM.

To begin, uninstall any old versions of Docker.

sudo apt-get remove docker docker-engine docker.io containerd runc

Next, update the package lists and install Docker.

sudo apt-get update
sudo apt-get install docker.io

Last, install Docker Composet®.

sudo curl -L "https://github.com/docker/compose/releases/download/1.29.1/docker—-
compose-$(uname -s)-$(uname -m)" -o /usr/local/bin/docker-compose
sudo chmod +x /usr/local/bin/docker-compose

8 Docker-Compose is packaged with Docker engine version 20.10.15 and up.

Running Docker as non-root (optional)

To avoid prefacing the Docker command with sudo, create a Unix group called docker and add users to it. When the
Docker daemon starts, it creates a Unix socket accessible by members of the Docker group. See Docker Post
Installation!! documentation for details.

sudo groupadd docker
sudo usermod -aG docker S$USER

4.5.1.3 Unpack and install DCT

Once Docker and Docker Compose are installed, DCT can be installed. Begin by downloading the latest version of

the tarball from the Delphix Download site'2. Next, transfer the file to the Linux machine where Docker is installed.
Run the following commands to extract the containers and load them into Docker:

tar -xzf delphix-dctx.tar.gz
for image in x.tar; do sudo docker load --input $image; done

9 https://docs.docker.com/engine/install/

10 https://docs.docker.com/compose/install/

11 https://docs.docker.com/engine/install/linux-postinstall/
12 https://download.delphix.com/folder
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45.1.4 RunDCT

To run DCT, navigate to the location of the extracted docker-compose.yaml file from the tarball and run the
following command. Using —-d in the command will start up the application in the background.

sudo docker-compose up -d

Running docker ps should show 9 containers up and running:

sudo docker ps

CONTAINER ID IMAGE COMMAND CREATED
STATUS PORTS NAMES

75a9df0caed7 delphix-dct-proxy:6.0.0 "/sbin/tini -- /boot.." 7 seconds
ago Up 4 seconds 0.0.0.0:443->8443/tcp delphix-dct-proxy:3.0.0

a23f4fbe0220 delphix-dct-app:6.0.0 "java -jar /opt/delp.." 7 seconds
ago Up 5 seconds delphix-dct-app:6.0.0

96ba8018fab3 delphix-dct-data-library:6.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-data-library:6.0.0
8e5ble671lacc delphix-dct-jobs:6.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-jobs:6.0.0

96049058025 delphix-dct-data-bookmarks:6.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-data-bookmarks:6.0.0
20d1782cb3bb delphix-dct-ui:6.0.0 "node ./index.js" 7 seconds
ago Up 5 seconds delphix-dct-ui:6.0.0

4fae43c79e8d delphix-dct-virtualization:6.0.0 "/Jusr/bin/tini -- ./." 7 seconds
ago Up 5 seconds delphix-dct-virtualization:6.0.0
83d7d661d8a0 delphix-dct-graphql:6.0.0 "/bin/sh -c 'BASE_UR.." 7 seconds
ago Up 6 seconds delphix-dct-graphql:6.0.0

3dded474e28b delphix-dct-postgres:6.0.0 "docker-entrypoint.s.." 7 seconds
ago Up 6 seconds 5432 /tcp delphix-dct-postgres:6.0.0

4.5.2 Bootstrapping APl Keys

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

There is a special process to bootstrap the creation of the first API key. This first API key should only be used to
create another key and then promptly deleted, since the bootstrap APl will appear in the logs. This process can be
repeated as many times as needed, for example, in a case where existing API keys are lost or have been deleted. It
also means that the Linux users with permissions to edit the docker-compose file implicitly have the ability to get
an APl key at any time. There is no mechanism to lock this down after the first bootstrap key is created.

Begin by stopping the application with the following command:

sudo docker-compose stop
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Once the application is stopped, edit the docker-compose.yaml file and modify the following lines to the DCT
section, to setthe API_KEY_CREATE to the string value "true":

services:
gateway:
environment:
API_KEY_CREATE: "true"

Start DCT again with sudo docker-compose up .You will see the following output in the logs for the app
container (the key will be different from this example):

NEWLY GENERATED API KEY: 1.0p9PMkZO4Hgy®ezwjhXOFi4lEKrD4pflejgqjdopfKtywlSWRIGOFIaWaj
uKcBT3

Copy the API Key and shut down the DCT app. The API key can now be used to authenticate with DCT. Remember
that the API Key value must be prefixed with apk. An example cURL command with the above API Key appears as
follows:

curl --header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWROGOfIaWajuKcBT3"

Edit the docker-compose.yaml file to set the API_KEY_CREATE environment variable value back to "false" and

restart DCT again with sudo docker-compose up -d.

4.5.3 Custom configuration

Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

45.3.1 Introduction

DCT was designed for users to configure Delphix applications in a way that would meet their security requirements,
which handled with a custom configuration. This article provides background information on performing custom
configurations, which are referenced throughout DCT articles and sections.

4.5.3.2 Bind mounts

Configuration of DCT is achieved through a combination of API calls and the use of Docker bind mounts*3. A bind
mount is a directory or file on the host machine that will be mounted inside the container. Changes made to the
files on the host machine will be reflected inside the container. It does not matter where the files live on the host
machine, but the files must be mounted to specific locations inside the container so that the application can find
them.

The DCT and proxy containers can both be configured via separate bind mounted directories. Each container
requires all configuration files to be mounted to the /etc/config directoryinside the container. Therefore, it is

13 https://docs.docker.com/storage/bind-mounts/
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recommended to create a directory for each container on the host machine to store all of the configuration files and
mountthemto /etc/config.Thisisdone by editingthe docker-compose.yaml . Under proxy services,
add a volumes section if one does not already exist; this is used to mount the configuration directory on the host to

/etc/config.Forexample,if /my/proxy/config isthe directory on the host that contains the
configuration files, then the relevant part of the compose file would look like this:

services:
proxy:
volumes:
- /my/proxy/config:/etc/config

To change the configuration of the DCT container, make a similar change under its service section, the only
difference being the directory on the host. After making this change, the application will need to be stopped and
restarted.

The structure of /my/proxy/config will need to match the required layoutin /etc/config.When each
container starts, it will create default versions of each file and place them in the expected location. It is highly
recommended to start from the default version of these files. For example, if /my/proxy/config isthebind

mount directory on the host, it could be populated with all the default configuration files by running the following
commands.

First, create an nginx directoryinside /my/proxy/config onthe host.

cd /my/proxy/config
mkdir nginx

Find the id of the proxy container with docker ps. Look for the container with a delphix-dct-proxy image name. To
determine the user and group ownership for any configuration files, start the containers and open a shell to the
relevant one (nginx in this example), then examine the current user/group IDs associated with the files.

$ docker ps

CONTAINER ID IMAGE COMMAND CREATED
STATUS PORTS NAMES

ac343412492a delphix-dct-proxy:3.0.0 "/bootstrap.sh" 8 minutes ago Up

8 minutes 0.0.0.0:443->443/tcp, :::443->443/tcp dct-packaged_proxy_1

In the above example, ac343412492a is the id. Run the following command to copy the default files to the bind
mount.

docker cp <container id>:/etc/config/nginx /my/proxy/config/nginx

One can always go back to the original configuration by removing the bind-mount and restarting the container or
using docker cp as in the previous example to overwrite the custom files with the default versions.
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4.5.4 Docker logs

Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

DCT leverages the Docker logging! infrastructure. All containers log to stdout and stderr so that their logs are
processed by Docker. Docker supports logging drivers for a variety of tools such as Fluentd, Amazon CloudWatch,
and Splunk to name a few. See Docker documentation here® on how to configure them. These changes will need to

be made to the docker-compose.yaml file. This link® explains how to alter the compose file to adjust the logging
driver. For example, if you want to use syslog for the proxy container then it would look like this:

services:
proxy:
logging:
driver: syslog
options:

syslog-address: "tcp://192.123.1.23:123"

4.5.5 Migration topics

4.5.5.1 Migrate to Kubernetes

Overview

Installations starting on Docker Compose may be migrated to Kubernetes by moving the persistent data store using
the following steps. In-place upgrades from Docker Compose to Kubernetes are not supported.

a8 During the migration process, there will be a downtime period where the service cannot be used.

Migration Process

Stop DCT services. In order to avoid a situation of losing data, stop serving the upcoming traffic with:

~$ docker-compose stop

Copy the Postgres Docker volume folder data on a local machine with:

~$ mkdir database
~$ docker cp {dbcontainer_Id}:/var/lib/postgresql/data ./database

Copy the encryption key Docker volume folder data on a local machine with:

14 https://docs.docker.com/config/containers/logging/
15 https://docs.docker.com/config/containers/logging/configure/
16 https://docs.docker.com/compose/compose-file/compose-file-v3/#logging
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~$ mkdir data_key
~$ docker cp {gateway_container_id}:/data ./data_key

a Mounted Docker volume folder content for database is copied in database folder on local machine.

Mounted Docker volume folder content for encryption key is copied in the data_key folder on local
machine.

Move the copied volume folders (database and data_key from the previous step) to the Kubernetes host machine
where DCT is up and running.

Update the values.yaml file to add the list of certificates which were used in the previous DCT version (present in
mounted trustStore). Update the deployment with the new values.yaml file.

Terminate the proxy pod to stop serving external traffic with:

~$ kubectl scale --replicas=0 deployment/proxy -n dct-services

Terminate the database to stop internal threads using the database with:

~$ kubectl scale --replicas=0 deployment/database -n dct-services

Create adummy pod to access the Persistent Volume. Use the Pod.yaml as an example:

apiVersion: vl
kind: Pod
metadata:
Namespace: dct-services
name: dummy-pod
labels:
app: dummy-pod
spec:
containers:
- image: ubuntu
command:

- "sleep"

- "604800"
imagePullPolicy: IfNotPresent
name: ubuntu

restartPolicy: Always
volumes:
- name: gwdatabase-data
persistentVolumeClaim:
claimName: gwdatabase-data

Followed by this command to actually create the dummy pod:
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~$ kubectl apply -f pod.yaml -n dct-services

Restore previous DCT version volume data with DCT deployed on the Kubernetes setup (in Persistent Volume).

Move the encryption key with:

~$cd data_key
~$ kubectl cp data dct-services/{gateway_pod_name}:/

Move the Postgres data with:

~$cd database
~$ kubectl cp data dct-services/{dummy_pod_name}:/var/lib/postgresql

Delete the dummy pod with:

~$ kubectl delete pod dummy-pod -n dct-services

Start the database pod (scale to 1) with:

~$ kubectl scale --replicas=1 deployment/database -n dct-services

Delete or patch the gateway pod with:

~ % kubectl delete pod {gateway_pod_name} -n dct-services

Delete or patch the data-library pod with:

~ % kubectl delete pod {data-library_pod_name} -n dct-services

Delete or patch the jobs pod with:

~ % kubectl delete pod {jobs_pod_name} -n dct-services

Delete or patch the data-bookmarks pod with:

~ % kubectl delete pod {data-bookmarks_pod_name} -n dct-services

Start the proxy service to serve the external service:
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4.5.5.2 Migrate to OpenShift

Overview

Installations starting on Docker Compose may be migrated to OpenShift by moving the persistent data store using
the following steps. In-place upgrades from Docker Compose to OpenShift are not supported.

a During the migration process, there will be a downtime period where the service cannot be used.

Migration Process

Stop DCT services. In order to avoid a situation of losing data, stop serving the upcoming traffic with:

~$ docker-compose stop

Copy the Postgres Docker volume folder data on a local machine with:

~$ mkdir database
~$ docker cp {dbcontainer_Id}:/var/lib/postgresql/data ./database

Copy the encryption key Docker volume folder data on a local machine with:

~$ mkdir data_key
~$ docker cp {gateway_container_id}:/data ./data_key

a « Mounted Docker volume folder content for database is copied in database folder on local
machine.

« Mounted Docker volume folder content for encryption key is copied in the data_key folderon
local machine.

Move the copied volume folders (database and data_key from the previous step) to the Kubernetes host machine
where DCT is up and running.

Update the values.yaml file to add the list of certificates which were used in the previous DCT version (present in
mounted trustStore). Update the deployment with the new values.yaml file.

Terminate the proxy pod to stop serving external traffic with:

~$ oc scale --replicas=0 deployment/proxy -n dct-services

Terminate the database to stop internal threads using the database with:
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~$ oc scale --replicas=0 deployment/database -n dct-services

Create a dummy pod to access the Persistent Volume. Use the Pod.yaml as an example:

apiVersion: vl
kind: Pod
metadata:
Namespace: dct-services
name: dummy-pod
labels:
app: dummy-pod
spec:
containers:
- image: ubuntu
command:

- "sleep"

- "604800"
imagePullPolicy: IfNotPresent
name: ubuntu

restartPolicy: Always
volumes:
- name: gwdatabase-data
persistentVolumeClaim:
claimName: gwdatabase-data

Followed by this command to actually create the dummy pod:

~$ oc apply -f pod.yaml -n dct-services

Restore previous DCT version volume data with DCT deployed on the Kubernetes setup (in Persistent Volume).

Move the encryption key with:

~$cd data_key
~$ oc cp data dct-services/{gateway_pod_name}:/

Move the Postgres data with:

~$cd database
~$ oc cp data dct-services/{dummy_pod_name}:/var/lib/postgresql

Delete the dummy pod with:

~$ oc delete pod dummy-pod -n dct-services

Start the database pod (scale to 1) with:
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~$ oc scale --replicas=1 deployment/database -n dct-services

Delete or patch the gateway pod with:

~ % oc delete pod {gateway_pod_name} -n dct-services

Delete or patch the data-library pod with:

~ % oc delete pod {data-library_pod_name} -n dct-services

Delete or patch the jobs pod with:

~ % oc delete pod {jobs_pod_name} -n dct-services

Delete or patch the data-bookmarks pod with:

~ % oc delete pod {data-bookmarks_pod_name} -n dct-services

Start the proxy service to serve the external service:

~$ oc scale --replicas=1 deployment/proxy -n dct-services

4.5.6 Admin topics for Docker Compose

4.5.6.1 Backup DCT on Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

This article discusses how to backup DCT. The data that needs to be backed up is the Docker volumes used by the
DCT container, gwdatabase container, and the configuration directories on the host that are bind mounted to the
containers.

The Docker volumes named {xxx}delphix-dct-data and {xxx}delphix-dct-database-data
should be backed up to prevent data loss. This Docker article!” explains how to backup a data volume.

The bind mount directories containing the configuration files are standard directories that can be backed up as
desired. A simple approach would be to create a tar file of the contents. If /my/config is the bind mount directory
on the host, then this can be done with the following command:

tar -czf gateway-backup.tgz /my/config

17 https://docs.docker.com/storage/volumes/#backup-restore-or-migrate-data-volumes
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4.5.6.2 Deployment upgrade for Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

& DCT versions 2.0.0 through 6.0.2 running on Docker Compose, that are being upgraded to DCT 7.0.0 or
later, may experience potential failure to start post-upgrade, resulting in a "permission denied" error in
the logs. Operations post-upgrade may also fail with internal errors.

Theissue is due to the UID running the application containers changing from UID 1000 (in DCT 2.0.0
through 6.0.2) to UID 1010 (in DCT 7.0.0 and later). Resolving the issues requires the following one-time
change and no container restart is required:

1. Change ownership of the volume associated to the gateway container to the new UID:

docker exec -u 0 -1it <gateway-container-name> chown
delphix:delphix /data

2. If bind mounts have been used to configure DCT, they must grant permission to the user with UID
1010 (GUID 1010) to read/write files, for example:

chown 1010:1010 /path/to/nginx/bind/mount

Introduction

This article describes the procedure to upgrade the DCT version without losing any data. Docker Compose uses the
concept of ‘project’ to create unique identifiers for all of a project’s containers and other resources (like volumes,
etc.).

Get the current project name and note it down using the following command:

The volume name would be of the format {project-name}_gateway-data and {project-name}_gwdatabase-
data. In the below example, the project name is delphix-dct.

docker volume 1s

DRIVER VOLUME NAME

local delphix-dct_gateway-data
local delphix-dct_gwdatabase-data

Bring down DCT services using the following command:

docker compose down

Refer to the Installation and Setup article to download and extract the new release tarball, then load Docker
images.

Navigate to the extracted directory which contains the docker-compose.yaml file. By default, Docker Compose
uses the extracted folder name as project-name.

& Edit the docker-compose.yaml file. Changes made to the docker-compose.yaml prior to upgrade file must
be applied to the newly extracted docker-compose.yaml file.
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With that, either rename the extracted folder to match the project-name and run:

docker compose up -d

OR run the below command with the project-name noted above from step #1 above

docker compose -p <project-name> up -d

If the -p argument is used to deploy DCT services, then the corresponding command to bring down the
DCT services would be:

docker compose -p <project-name> down

4.5.6.3 Factory reset DCT for Docker Compose

& Docker Compose should only be used to deploy DCT in an evaluation/testing capacity.

This article explains how to factory reset DCT. Factory resetting means deleting all of the configuration and data
associated with DCT. Perform this step only if you are absolutely sure about this and understand the implications.

Bring all of the DCT services down with this command:

docker compose down

List all Docker volumes being used and note down the volume names:

docker volume 1s

DRIVER VOLUME NAME

local dct_gateway-data
local dct_gwdatabase-data

Delete the Docker volumes that are listed from the previous command:

docker volume rm dct_gateway-data
docker volume rm dct_gwdatabase-data
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4.6 Engines: connecting/authenticating

4.6.1 Introduction

After DCT Authentication is complete, the HTTPS should be securely configured on DCT and able to be
authenticated against. The next step is to register an engine with DCT so that it can fetch results. DCT connects to
all engines over HTTPS, thus some configurations might be required to ensure it can communicate successfully.

4.6.2 Truststore for HTTPS

If the CA certificate that signed the engine's HTTPS certificate is not a trusted root CA certificate present in the JDK,
then custom CA certificates can be provided to DCT. If these certificates are not provided, a secure HTTPS
connection cannot be established and registering the engine will fail. The insecure_ssl engine registration
parameter can be used to bypass the check, however, this should not be used unless the risks are understood.

Get the public certificate of the CA that signed the engine’s HTTPS certificate in PEM format. IT team help may be
required to get the correct certificates. Base64 encode the certificate with:

cat mycertfile.pem | base64 -w 0

Copy the Base64 encoded value from the previous step and configure in values.yaml file under
truststoreCertificates section. e.g. section will look like this:

truststoreCertificates:
<certificate_name>.crt: <base64 encode certificate string value in single line>
<certificate_name> can be any logically valid string value for e.g. “engine”.

All the certificates configured in truststoreCertificates section will be read and included in the trustStore which
would be then used for SSL/TLS communication between DCT and Delphix Engine.

4.6.3 Authentication with engine

All authentication with the Delphix Engine is done with the username and password of a domain admin engine user.
There are two methods of storing these credentials with DCT. They can either be stored and encrypted on DCT itself
or retrieved from a password vault. We recommend fetching the credentials from a vault. Currently only the
HashiCorp vault is supported.

4.6.4 HashiCorp vault

There are two high-level steps to configuring a HashiCorp vault. The first is to set up authentication with the vault
and register the vault. The second is to tell DCT how to get the specific engine credentials needed from that
registered vault. A single vault can be used for multiple different Delphix Engines.
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4.6.4.1 Vault authentication and registration

First, DCT needs to be able to authenticate with the vault. DCT supports the Token'®, AppRole!®, and TLS
Certificates?? authentication methods. This is done by passing a command to the HashiCorp CLI?. Itis
recommended to first ensure that successful authentication is done and one can retrieve the credentials with the
HashiCorp CLI directly to ensure the correct commands are passed to DCT.

Adding a vault to DCT is done through API calls to the /v2/management/vaults/hashicorp endpoint. All
authentication methods requires the location of the vault is provided through the env_variables property in the
POST body like so:

"env_variables": {
"VAULT_ADDR": "https://10.119.132.40:8200"
}

4.6.4.2 Token

To use the token authentication method, this needs to be included as part of the env_variables field. The full
example to register the vault would appear as:

curl —--location —--request POST 'https://<hostname>/v2/management/vaults/hashicorp' \
-—header 'Content-Type: application/json' \
-—header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"env_variables": {
"VAULT_TOKEN": "<your token>"
"VAULT_ADDR": "https://10.119.132.40:8200"

} 1

A response should be received similar to the lines below:

{
"qd": 2,
"env_variables": {
"VAULT_TOKEN": "<your token>"
"VAULT_ADDR": "https://10.119.132.40:8200"
}
1

Note the id of the vault, this will be needed in the next step to register the engine.

18 https://www.vaultproject.io/docs/auth/token
19 https://www.vaultproject.io/docs/auth/approle
20 https://www.vaultproject.io/docs/auth/cert

21 https://www.vaultproject.io/docs/commands
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4.6.4.3 AppRole

To use the AppRole authentication method, this needs to be included as part the login_command_args field, as
shown below.

"login_command_args":
[ "write", "auth/approle/login", "role_id=1", "secret_id=123"]

The full example to register the vault would appear as:

curl --location --request POST 'https://<hostname>/v2/management/vaults/hashicorp' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
-—header 'Authorization: apk <your API key>' \
--data-raw '{
"env_variables": {
"VAULT_ADDR": "https://10.119.132.40:8200"
I
"login_command_args":
[ "write", "auth/approle/login", "role_id=1", "secret_id=123"]
}l

A response should be received similar to the lines below:

{
I|-id|l: 2,
"env_variables": {
"VAULT_TOKEN": "<your token>"
"VAULT_ADDR": "https://10.119.132.40:8200"
}
3

4.6.5 TLS certificates

The configuration of mutual TLS authentication requires an additional step. This feature currently is NOT supported
for Kubernetes deployment of DCT. This will be covered in later releases.

4.6.5.1 Retrieving engine credentials

Once DCT can authenticate with the vault, it needs to know how to fetch the relevant engine credentials. When
registering an engine, the user will need to provide the HashiCorp CLI commands through the

hashicorp_vault_username_command_args and hashicorp_vault_password_command_args
parameters.

The relevant part of the engine registration payload will look like the following:
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'{

"hashicorp_vault_id": 1

"hashicorp_vault_username_command_args": ["kv", "get", "-field=username", '"kv-
v2/delphix-engine-secrets/engineUser"]
b

"hashicorp_vault_password_command_args": ["kv", "get", "-field=password", '"kv-
v2/delphix-engine-secrets/engineUser"]

} 1

The hashicorp_vault_id will be the ID that was returned as part of the previous step. Note that the exact paths to
fetch the username and password will vary depending on the exact configuration of the vault.

4.7 Accounts: connecting/authenticating

There are 5 supported methods for authentication; APl keys, Username/Password, LDAP/Active Directory, SAML/
SSO0, and OpenlID Connect. These authentication methods are detailed on the corresponding pages in this section.

a DCT uses Nginx/OpenResty?? as an HTTP server and a reverse proxy for the application. Using the default
configuration, all connections to DCT are over HTTPS and require the user to authenticate. The Nginx/

OpenResty configuration files can be edited via /etc/config bind mounts, for the proxy container to
customize the HTTP server and change options (such as TLS versions).

4.7.1 APl keys

4.7.1.1 APl keys

APl keys are the default method to authenticate with DCT. This is done by including the key in the HTTP
Authorization request header?® with type apk. A cURL example using an example key of
1.0p9PMkZ04HgyOezwjhX0OFi41lEKrD4pflejgqjdopfKtywlSWRIGOfIaWajuKcBT3 would appear as:

curl —--header 'Authorization: apk
1.0p9PMkZ04HgyOezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWRIGOfIaWajuKcBT3"

a cURL (like web browsers and other HTTP clients) will not connect to DCT over HTTPS unless a valid TLS
certificate has been configured for the Nginx server. If this configuration step(see page 71) has not been
performed yet and the risk is comprehended, you may disable the check in the HTTP client. For instance,
this can done with cURL using the --insecure flag. The cURL version must be 7.43 or higher.

22 https://openresty.org/en/
23 https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Authorization
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Create and manage API Keys

The initial APl key created should be used to create a new admin secure key. This is done by creating a new Account
entity and setting the generate_api_key. The "username" attribute should be the desired name to uniquely identify
the account.

curl --location --request POST 'https://<hostname>/v2/management/accounts' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
-—header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdopfKtywlSWROGOfIaWajuKcBT3"' \
--data-raw '{

"username": "secure-key",

"generate_api_key": true

} 1
a If the cURL version being used is below 7.43, replace the --data-raw option with --data.

A response should be received similar to the lines below:

{
"id": 2,
"token": "2.vCfCOMnpySYZLshuxap2aZ7xqBKANQvV7hFnobe7xuNTHS9AF2NQnVIOXXw4UyET6"
"username":"secure-key"

}

Now that the new and secure API key is created, the old one must be deleted for security reasons since the key
appeared in the logs. To do this make the following request:

curl --location --request DELETE 'https://<hostname>/v2/management/api-clients/<id>"'
\

--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk

2.vCfCOMnpySYZLshuxap2aZ7xqBKANQvVThFnobe7xuNTHS9AF2NQNVIXXw4UyET6'

The id referenced above is the numeric id of the Account. It is the integer before the period in the token. For
example, theid of 1.0p9PMkZ04HgyOezwjhXOFi41lEKrD4pflejgqjdopfKtywlSWROGOfIaWajuKcBT3
is 1.

Finally, to list all of the current Accounts, make the following request:

curl --location --request GET 'https://<hostname>/v2/management/accounts/' \
--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk <your API key>'
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4.7.2 Username/password

When creating an account, a username and password combination can be associated with the account (whether an
API Key was generated for the account or not). To do so, specify the “username” and “password” properties in the
API request, for example:

curl -k --location --request POST 'https://<hostname>/v2/management/accounts' \
--header 'Content-Type: application/json' \
-—header 'Accept: application/json' \
-—header 'Authorization: apk
1.0p9PMkZ04Hgy0ezwjhXOFi41EKrD4pflejgqjdOpfKtywlSWROGOfIaWajuKcBT3" \
--data-raw '{
"username": '"some-username",
"password": "some-password",
"generate_api_key": false
"is_admin'": true

} 1

8 The is_admin property will create the account with admin privileges. Remove this property to create an
account without admin privileges.

The username and password combination can then be used to login via the Ul, or to fetch a temporary access token
valid for 24 hours. To do so, call the ‘login’ APl endpoint:

curl -k --location --request POST 'https://<hostname>/v2/login' \
--header 'Content-Type: application/json' \
-—header 'Accept: application/json' \
--data-raw '{
"username": '"some-username",
"password": '"some-password"

} 1

Aresponse should be received similar to the lines below:

"access_token":"eyJhbGciO0iJIUzI1INiJ9.eyIpc3MiOiJhcGlndylzZXJ2aWNlcylhcHATLCIzdWIA
0iI4I4wiZXhwIjoxNjYyNTUyMzI3LCIpYXQiOjE2NJIONjUSMjcsInVzZXJuYW1lIjoic29tZS11c2VybmFtZ
SJ9.Cx_hGU9noywWSemtK6gjsA85FTgIRQgyJizR5t_akNps",

"token_type":"Bearer",

"expires_in":86400

}

The access token can be used as HTTP Authorization request header?* with type Bearer. A cURL example using the
access token retrieved above would appear as:

24 https://developer.mozilla.org/en-US/docs/Web/HTTP/Headers/Authorization
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curl --header 'Authorization: Bearer
eyJhbGci07iIIUZIINTJ9.eyIpc3MiniIhcGlndy1zZXJI2aWNlcylhcHATLCIZdWIi0i I4TiwizZXhwIjoxNjYy
NTUyMzI3LCIpYXQi0jE2NjIONjU5MjcsInVzZXJuYW1lIjoic29tZS11c2VybmFtZSJ9.Cx_hGUInoyWSemtK
6gjsA85FTgIRQgyJizR5t_akNps'

The password for an account can be updated with the change_password APl endpoint, passing in both the old and
new passwords, such as in this example:

curl -k --location --request POST '<hostname>/v2/management/accounts/3/
change_password \

--header 'Content-Type: application/json' \

-—-header 'Accept: application/json' \

-—header 'Authorization: Bearer
eyJhbGci0i1JIUzI1INiJ9.eyIpc3MiOilhcGlndylzZXJ2aWNlcylhcHATLCIZzdWIi0iI4IiwiZXhwIjoxNjYy
NTUyMzI3LCIpYXQiOjE2NjIONjU5S5MjcsInVzZXJuYW1lIjoic29tZS11c2VybmFtZSJ9.Cx_hGU9noyWSemtK
6gjsA85FTgJRQgyJizR5t_akNps' \

--data-raw '{

"old_password": '"some-password",
"new_password": "new-password"

} 1

Following security best practices, the password is not stored on DCT and cannot be retrieved. If the password has
been lost, an account with admin privilege can reset the password for a particular account. It is recommended to
change the password reset by an admin account on the first login, or with the change_password API, as described
above.

curl -k --location --request POST '<hostname>/v2/management/accounts/2/
password_reset' \

--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: Bearer
eyJhbGci0iJIUZzI1INiJ9.eyIpc3MiOiJhcGlndylzZXJ2aWNlcylhcHATLCIzdWIi0iI4IiwiZXhwIjoxNjYy
NTUyMzI3LCIpYXQiOjE2NFIONjU5MjcsInVzZXIuYWLlIjoic29tZS11c2VybmFtZSI9.Cx_hGUInoyWSemtK
6gjsA85FTgJRQgyJizR5t_akNps' \

--data-raw '{

"new_password": "new-password"

} 1

In the above example, the admin is resetting the password of an account with id 2 to “new-password”.

4.7.2.1 Password policies

The password policy feature allows users to enable and customize the password policy enforced for local
username/password authentication (does not apply to LDAP/Active Directory or SAML/SSO based authentication).

4.7.2.2 Understanding password policies

The password policy is a set of requirements that local passwords must satisfy.
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« min_length: A password must be longer than this length.

+ reuse_disallow_limit: The user should not reuse old passwords. This tells the number of last used
passwords disallowed to be reused as the new passwords.

« uppercase_letter: A password must have at least one capital letter.

+ lowercase_letter: A password must have at least one lower case letter.

« digit: A password must have at least one digit.

« special_character: A password must have at least one special character, such as #, $, !

« disallow_username_as_password: A password should not be the same as the user name.

« maximum_password_attempts: The number of allowed attempts for incorrect password, after which the
account gets locked.

4.7.2.3 Default password policy

By default, DCT does not enforce any password policy.

4.7.2.4 Changing the password policy

To change the current password policy, call the password policy APl endpoint, as shown in the example below:

curl --location --request PATCH 'https://<hostname>/v2/management/accounts/password-
policies' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"enabled": true,
"maximum_password_attempts": 2,
"min_length": 5,
"reuse_disallow_limit": 3,
"digit": true,
"uppercase_letter": true,
"lowercase_letter": true,
"special_character": true,
"disallow_username_as_password": true

} 1

Changing the password policy does not affect existing passwords.

4.7.2.5 Disabling local username/password authentication

Username/password authentication (with passwords locally in DCT) can be disabled for individual accounts by not
setting or unsetting their password property, or across the DCT instance using the global properties API. Disable
username/password authentication to force authentication to use an alternate authentication method (LDAP/
Active Directory, SAML/SSO, etc.) as shown in this example:

curl --location --request PATCH 'https://<hostname>/v2/management/properties' \
--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk <your API key>' \
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--data-raw '{"disable_username_password": true}'

4.7.3 LDAP/Active Directory

4.7.3.1 Configuration

LDAP/Active directory can be used to authenticate login requests, and optionally to retrieve additional information
about accounts, thereafter referred to as LDAP Search.

Configuring authentication

The following attributes must be set to configure LDAP/Active Directory authentication.

Property Name Description
enabled Whether the LDAP/Active Directory feature is enabled.
auto_create_users Whether DCT must automatically create account

records for successful authentication attempts using a
username which does not match any accounts.

If this is disabled, an administrator must create a DCT
account with an ldap_principal attribute matching the
value from the LDAP/Active Directory server prior to
the first login attempt.

If this is enabled, any user with valid credentials in the
LDAP/Active Directory server can authenticate to DCT,
by default with an empty authorization set (i.e not
being able to view any data or perform any action).

hostname The host name or IP address of the LDAP/Active
Directory server.

port Port of the LDAP/Active Directory server. This is
usually 389 for non SSL, and 636 for SSL.

enable_ssl Whether the connection to the LDAP/Active Directory
server must be performed over SSL. It is highly advised
to use SSL. Without SSL, communication between DCT
and the LDAP/Active server can be intercepted.

insecure_ssl, unsafe_ssl_hostname_check, The SSL protocol requires the LDAP/Active Directory

trustore_file_name, truststore_password server to expose a certificate signed by a Certificate
Authority (CA) trusted by the JDK which is running
DCT. Refer to the dedicated section below to see how
to configure an Active Directory/LDAP server of which
certificate is not recognized.
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Description

Microsoft Active Directory only: The DNS name of a
domain in the same forest as the accounts which
login. DCT will append the msad_domain_name to the
username provided at login to form a user principal
name (UPN).

Example: if the msad_domain_name is http://
mycompany.co and a user logs in with username john,
DCT will perform an LDAP request to the Active
Directory server to authenticate

john@mycompany.co®.

If the LDAP server is not Microsoft Active Directory, the
username_pattern is used to create a DN string for
user authentication. The pattern argument {0} is
replaced with the username at runtime.

Example: If the username_pattern is
uid={0},ou=People and a user logs in with username
john, DCT will perform an LDAP request with DN
uid=john,ou=People.

The LDAP/Active Directory Integration can be configured both via DCT Ul and API. The below image shows an
example of how the configuration can be set in the Ul as a way to Authenticate users, auto create new users, as well
as map group attributes for authorization within the DCT Access Control system.

25 mailto:john@mycompany.co
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Edit LDAP Settings

Enabled

Auto-create Users
Hostnama

activedirectory.acme.com

Port

636

Domains

MEAD Domain Mama

acme.com

Username Pattern
Search Base
CN=Users,DC=acme,DC=com

Group Attribute

department

Email Attribute

mail

First Narne Attribute

givenName

Last Name Attribute

sn

Object Class Aftribute

person

Search Aftribute

sAMAccountName

The following example requests enable LDAP authentication over SSL with an Active Directory server at address

activedirectory.company.co

26

using the us.company.co?’ domain:

26 http://activedirectory.company.co

27 http://us.company.co
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curl --location --request PUT 'https://<hostname>/v2/management/ldap-config' \
--header 'Content-Type: application/json' \

--header 'Accept: application/json' \

--header 'Authorization: apk <your API key>' \

--data-raw '{

"enabled": true,

"auto_create_users": true,

"hostname": "activedirectory.company.co",
"enable_ss1": true,
"port": 636,

"domains": [{
"msad_domain_name":"us.company.co"
} 1

Validating the configuration

Updating the LDAP/Active Directory configuration does not guarantee that the provided values are correct, as
validating those requires a user to authenticate to DCT. This can be achieved with the ldap-config/validate API
endpoints, using the credentials valid for the LDAP/Active Directory server. When provided with a username/
password combination, the ldap-config/validate APl endpoint will authenticate with the LDAP server. If the
response status code is 200, the configuration is correct. Otherwise, the response code will be 400, and the
response body will provide information to resolve the configuration problems. For example:

curl --location --request POST 'https://<hostname>/v2/management/ldap-config/
validate' \

-—header 'Content-Type: application/json' \

-—header 'Accept: application/json' \

-—header 'Authorization: apk <your API key>' \

--data-raw '{

"username'": "<ldap-username>",

"password": "<ldap-password>"

} 1

a Because of a defect in version 3.0.0 of DCT, the above request might fail with a response similar to:

search failed for john.doe with search base null' ,search attribute
"null'

This indicates that authentication works, and search (see below) is not configured.

Login

One the configuration has been updated, accounts can login (via the Ul or API) using the same Ul form/API endpoint
they would be using for the local username/password authentication feature. For example:

curl -k --location --request POST 'https://<hostname>/v2/login' \
--header 'Content-Type: application/json' \
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--header 'Accept: application/json' \
--data-raw '{

"username'": "<ldap-username>",
"password": "<ldap-password>"

} ]

When LDAP/Active directory is enabled, DCT first attempts to validate passwords with the LDAP/Active Directory
server, and falls back to local password authentication in case of failure. Enabling LDAP/Active directory is thus a
non disruptive operation for existing accounts.

In order to force a transition to LDAP/Active Directory only password authentication, the DCT administrator must
either update the account records to remove the password, or disable local password authentication entirely.

4.7.4 SAML/SSO

The SAML 2.0 protocol allows DCT to delegate authentication to a SAML 2.0 compatible Identity Provider (Active
directory federation services, Azure active directory, Ping federate, Okta, OnelLogin, etc.). It only applies to web
browser based interaction, and cannot be used for APl access (scripting, integration).

Setting up SAML/SSO requires configuration changes both in the Identity Provider and DCT, so that trust can be
established across both products.

When using SAML/SSO, DCT will uniquely identify accounts by email address, so make sure that records at the
identity provider are configured with a unique email address.

DCT supports automatic account creation (or just in time account provisioning) when using SAML/SSO. When
automatic account creation is enabled, accounts are created automatically when users login for the first time.

DCT allows group membership to be retrieved from the Identity Provider, which can be used to control access
control authorization within DCT via DCT Access Groups. Using Identity Provider group membership allows DCT
authorization to be managed per account group, and guarantees that authorizations in DCT reflect the organization
structure which is expressed by group membership of the identity provider.

SAML/SSO is not mutually exclusive with other authentication methods, so enabling SAML/SSO is not disruptive
(accounts configured with local password or LDAP/Active Directory authentication can still authenticate). In order
to switch to SAML/SSO exclusively as authentication method for web browser interaction, perform the SAML/SSO
configuration steps below and disable LDAP/Active Directory and Username/Password authentication. Note that
API Key based authentication cannot be entirely disabled, but only administrators can create accounts with API
keys.

4.7.4.1 ldentity provider setup

Require that an administrator of the Identity provider used by your organization sets up a SAML 2.0 integration with
DCT (an integration is sometimes called a Relying party trust, or an application).

The exact instructions are product specific, but the following input values must be provided:

Name + Alternative name depending Value
on product
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Single Sign-on URL « SAML Assertion Consumer https://<dct-hostname>/v2/saml/
Service SSO
« ACS

+ Recipient URL
+ Destination URL
+ Relying party SAML 2.0 SSO

+ Service URL
+ Reply URL
Audience URI « SPEntity ID Any value can be selected, as long
« Relying Party trust identifier as the same value is set in the
Identify Provider configuration and
DCT configuration. We
recommend:
https://<dct-hostname>
Binding « POST
Protocol SAML 2.0 WebSSO protocol

The identity provider must be configured to include the email address as Nameld attribute, and DCT will use the
email attribute as a unique identifier for users when connecting via SAML/SSO.

4.7.4.2 DCT SAML/SSO setup

Once the configuration has been performed at the Identity provider, use the saml-config APl endpoint to configure
DCT accordingly. If DCT has network access to the Identity Provider server, and the Identity Provider provides a
“metadata URL”, you can point DCT directly to the metadata URL. Otherwise, for instance when a firewall blocks
network access from DCT to the Identity Provider, copy the metadata from the Identity Provider using a web
browser and provide it directly to DCT.

The Identity provider (IDP) metadata is a standardized XML document providing the SAML Service Provider (DCT)
with the necessary information to verify the validity of incoming login requests and initiate a SAML/SSO login flow.

The metadata URL is sometimes called “App Federation Metadata URL”, and is sometimes only known by reading
the Identity Provider’s product documentation (for instance Active Directory Federation Services, or ADFS,
publishes the metadata URL at https://<hostname>/federationmetadata/2007-06/federationmetadata.xml).

If auto_create_users isenabled, DCT will create accounts automatically when they login with SAML/SSO for

the first time. If this is disabled, an administrator must create a DCT account with an email attribute matching the
value from the SAML/SSO Identity provider before they can login. When auto_create_users is enabled, any user
configured to authenticate via the Identity provider can authenticate to DCT, by default with an empty
authorization set (i.e not being able to view any data or perform any action).

Example 1: With network access, point DCT to the metadata URL.

curl --location --request GET 'https://<hostname>/v2/management/saml-config' \
-—header 'Content-Type: application/json' \

-—header 'Accept: application/json' \

--header 'Authorization: apk <your API key>' \
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--data-raw '{
"enabled": true,
"auto_create_users": true,
"metadata_url": "<idp-metadata-url>",

} ]

Example 2: Without network access, provide the IDP metadata directly.

curl --location --request PUT 'https://<hostname>/v2/management/saml-config' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"enabled": true,
"auto_create_users": true,

"metadata": "<json-escaped-idp-metata-xml-blob>",
} !
The IDP metadata must be JSON escaped. On a terminal with ./jg?® installed, this can be achieved with
the following command: jq --slurp --raw-input <<< 'xml-metadata-here'
4.7.4.3 Login

The SAML 2.0 protocol defines two login procedures: The Service Provider initiated flow starts by having users point
their web browserto https://<dct-hostname>/v2/saml/login to login, while the Identity provider
initiated flow starts at the Identity provider (details specific to Identity provider vendor). DCT supports both flows.
The SAML/SSO authentication method is not intended for APl interaction, and cannot be used with the Swagger Ul.

After successful authentication, the web browser is redirected to the Ul landing page and the the navigation bar can
be used to go to the desired page. The session expires 24 hours after login.

4.7.4.4 Troubleshooting
There was an issue in SAML authentication: The assertion cannot be used before <timestamp>

The above error message, which is accompanied by com.coveo.saml.SamlException: The assertion cannot be
used before <timestamp=> error in the application logs, indicates that DCT was not able to validate the timestamp of
the authentication provided by the Identity Provider. This is usually due to the system clock of the machine running
DCT being incorrectly configured. Consider using NTP to maintain the machine’s clock up to date.

There was an error fetching data

The above error message indicates that the current account does not have permission to view the data displayed on
the page. Remember that, while DCT creates accounts automatically upon login when auto_create_users is
enabled, by default accounts are created without any authorization and thus cannot see any data. Review the
section below to see how SAML/SSO group membership can be assigned automatically at account creation.

28 https://stedolan.github.io/jq/
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4.8 Configure LDAP/Active Directory groups

In addition to being an authentication method, the LDAP/Active Directory integration can optionally also be used to
retrieve additional attributes about the accounts authenticating: first name, last name, email address and group
membership.

DCT only supports retrieving groups which are exposed as an attribute of the LDAP/Active Directory user record.
DCT can not fetch groups membership from group records at the LDAP/Active Directory, and thus also does not
support nested groups.

Group memberships are retrieved at authentication time, using the account credentials. DCT does not need
credentials of an LDAP/Active Directory administrator, but will only be able to retrieve group memberships if LDAP/
Active Directory users have the right to read the corresponding attribute.

This can be enabled by setting additional arguments to the domain APl object.
search_base The Context name in which to search. Being specific
enables faster LDAP search.

To construct the search_base DN string according to
your LDAP/Active Directory server, using an LDAP
browser, navigate to a user, and then construct the
search_base DN in reverse order from the User, up the
folder hierarchy. For example:

If a User DN is:
CN=some-user-id,CN=Users,DC=mycompany,DC=co
The corresponding search base might be:

CN=Users,DC=mycompany,DC=co

email_attr Name of the attribute in the LDAP/Active Directory
server containing email addresses.

Example: mail

last_name_attr Name of the attribute in the LDAP/Active Directory
server containing last names
Example: sn

first_name_attr Name of the attribute in the LDAP/Active Directory

server containing first names

Example: givenName

group_attr Name of the attribute in the LDAP/Active Directory
server containing group(s) membership. This can be a
multi-valued attribute.

Example: memberOf
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Name of the attribute in the LDAP/Active Directory
server of which value corresponds to the username
provided to the DCT login requests.

For Active Directory, this is usually sSAMAccountName.

Example: If the search base is
CN=Users,DC=mycompany,DC=co and the
search_attr is principalName, DCT will search for a
record with a principalName matching the username
provided to the login request under the
CN=Users,DC=mycompany,DC=co sub tree.

Restricts search to records with an objectClass
matching this value.

Example: person

4.8.1 Active Directory example

The following requests enable LDAP authentication over SSL with an Active Directory server at address
activedirectory.company.co?’, using the us.company.co® domain, and configures optional attributes to retrieve

first name, last name, email address, and group membership from the users sub-tree.

curl --location --request PUT 'https://<hostname>/v2/management/ldap-config' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{

"enabled": true,

"auto_create_users": true,

"hostname": "activedirectory.mycompany.co",
"enable_ss1": true,
"port": 636,

"domains": [{

]
}l

"msad_domain_name":"mycompany.co",
"search_base":"CN=Users,DC=mycompany,DC=co",
"email_attr": "mail",

"first_name_attr": "givenName",
"last_name_attr": "sn",

"group_attr": "memberOf",
"object_class_attr":"person",

"search_attr": "sAMAccountName"

29 http://activedirectory.company.co
30 http://us.company.co
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With the above config, when a user logs in with username John, DCT will:

1. Authenticate with the Active Directory server using the user principal name john@mycompany.co3! and
supplied password.

2. Search in the CN=Users,DC=mycompany,DC=co sub tree a record with objectClass=person and
sAMAccountName=john.

3. Create or update a DCT Account record with the attributes extracted from the Active Directory server.

4. Foreach group membership found in the memberOf of the Active Directory server, an account tag is

created with key=login_groups and value is the group name. These tags are protected (i.e cannot be
modified within DCT) and can be securely used to control access groups membership.

As explained above, the ldap-config/validate APl endpoint can be used to validate that each of the attributes
corresponding to LDAP/Active Directory attributes.

4.8.2 Attributes mapping

As explained above, the only required attribute in the SAML Response (the message sent by the Identity Provider to
DCT during login) is the Nameld attribute which must be configured to a unique email address.

In addition to this, DCT allows for first name, last name, and group membership attributes to be included. The first
and last names attributes will be stored as properties of the account object. For each group membership found in
the SAML response attribute, an account tag is created with key=login_groups and value is the group name. These
tags are protected (i.e cannot be modified within DCT) and can be securely used to control access groups
membership.

In other to enable these optional attributes, update the Identity provider configuration to include them in the SAML
response, and use the saml-config APl endpoint to configure DCT with the name of the attributes configured in the
Identity provider:

curl --location --request PUT 'https://<hostname>/v2/management/saml-config' \
--header 'Content-Type: application/json' \
--header 'Accept: application/json' \
--header 'Authorization: apk <your API key>' \
--data-raw '{
"enabled": true,
"auto_create_users": true,
"metadata": "<json-escaped-idp-metata-xml-blob>",
"first_name_attr": "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/
givenname",
"last_name_attr": "http://schemas.xmlsoap.org/ws/2005/05/identity/claims/surname",
"group_attr": "http://schemas.xmlsoap.org/claims/Group"

} 1

With the above configuration, and a SAML Response as the following produced by the Identity Provider during login:

<?xml version="1.0" encoding="UTF-8"7?>

<saml2:Assertion ID="id97923983167603821157180516" IssuelInstant="2022-12-01T10:07:12.
856Z" Version="2.0"

xmlns:saml2="urn:oasis:names:tc:SAML:2.0:assertion">

31 mailto:;john@mycompany.co
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<saml2:Issuer Format="urn:oasis:names:tc:SAML:2.0:nameid-format:entity">http://
www. idp-demo.com/exklfupjwzlYcMo290h8</saml2:Issuer>
<saml2:Subject>
<saml2:NameID Format="urn:oasis:names:tc:SAML:1.1:nameid-format:unspecified">
john.doe@company.co</saml2:NameID>
<saml2:SubjectConfirmation Method="urn:oasis:names:tc:SAML:2.0:cm:bearer">
<saml2:SubjectConfirmationData NotOnOrAfter="2022-12-01T10:12:12.857Z2"
Recipient="https://localhost/v2/saml/SS0" />
</saml2:SubjectConfirmation>
</saml2:Subject>
<saml2:Conditions NotBefore='"2022-12-01T10:02:12.857Z" NotOnOrAfter="2022-12-01T1
0:12:12.857Z2">
<saml2:AudienceRestriction>
<saml2:Audience>https://dct-demo.delphix.com</saml2:Audience>
</saml2:AudienceRestriction>
</saml2:Conditions>
<saml2:AuthnStatement AuthnInstant="2022-12-01T10:05:07.916Z" SessionIndex="id166
9889232855.2084756273">
<saml2:AuthnContext>
<saml2:AuthnContextClassRef>urn:oasis:names:tc:SAML:2.0:ac:classes:Passwo
rdProtectedTransport</saml2:AuthnContextClassRef>
</saml2:AuthnContext>
</saml2:AuthnStatement>
<saml2:AttributeStatement>
<saml2:Attribute Name="http://schemas.xmlsoap.org/ws/2005/05/identity/claims/
givenname" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring">John
</saml2:AttributeValue>
</saml2:Attribute>
<saml2:Attribute Name="http://schemas.xmlsoap.org/ws/2005/05/identity/claims/
surname" NameFormat="urn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring">Doe
</saml2:AttributeValue>
</saml2:Attribute>
<saml2:Attribute Name="http://schemas.xmlsoap.org/claims/Group" NameFormat="u
rn:oasis:names:tc:SAML:2.0:attrname-format:unspecified">
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring">Dev-Team
</saml2:AttributeValue>
<saml2:AttributeValue
xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" xsi:type="xs:st
ring">QA
</saml2:AttributeValue>
</saml2:AttributeStatement>
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</saml2:Assertion>

Would automatically create or update a DCT account with the following properties:

{
"id": 94,
"username": "john.doe@company.co",
"firstName": "John",
"lastName'": "Doe",
"email": "john.doe@company.co",
"tags": [
{
"key": "login_groups",
"value": "Dev-Team"
1,
{
"key": "login_groups",
"value": "QA"
}
]
}

4.9 Replace HTTPS certificate for DCT

By default, to enable HTTPS, DCT creates a unique self-signed certificate when starting up for the first time. This
certificate and private key are configured in the values.yaml file under:

proxy:
crt:<certificate_value>
key:<key_value>

To use your own certificates, these default values need to be replaced. They are Base64 encoded values of the
certificate and key, respectively.
+ To generate the Base64 encoded value of the certificate:
cat mycertfile.pem | base64 -w 0
+ To generate the Base64 encoded value of the key:
cat mykey.key | base64 -w 0

Generating a new TLS certificate and key could require the assistance of your Security or IT departments. A new key
pair (public and private key) will need to be created, in addition to a certificate signing request (CSR) for that key
pair. Your IT department should be able to determine the correct certificate authority (CA) to sign the CSR and
produce the new certificate. The common name of the certificate should match the fully qualified domain name
(FQDN) of the host, as well as the FQDN as a Subject Alternative Name (SAN).

Deployment - 71



Data Control Tower - Data Control Tower Home

4,10 External database support

4.10.1 Overview

DCT uses a PostgreSQL database to store all the persistent data powering the application (engines, VDBS,
compliance jobs, accounts, permissions, etc.). By default, a PostgreSQL container image is packaged along with the
DCT application and deployed along other pods onto the Kubernetes cluster, storing its persistent data into the

gwdatabase-data persistent volume.
Alternatively, DCT can be configured to use an external PostgreSQL database instead, to which DCT connects over

TCP and can then run anywhere (typically outside of the Kubernetes cluster).

& External database support is only available for Kubernetes and OpenShift deployments. Docker Compose
installations are not eligible.

4.10.2 Requirements

+ Database type: PostgreSQL
« Min supported version: 13.4
« Max supported version: 14.7

4.10.3 Setup

4.10.3.1 PostgreSQL database setup

The following databases must be created prior to connecting DCT: app, jobs, data-library, and bookmarks.

& Quotes must be used to create or connect to the "data-library" databases, since its name contains a
hyphen (-). Creating the database with a different name (such as data_library) will NOT work.

A PostgreSQL user must be created for DCT, with either the admin privilege or ALL privilege on the above databases.
The following SQL script exemplifies the creation of required databases, granting privileges to a pre-existing

dct_user (role) user.

Shell

CREATE DATABASE '"bookmarks'";
GRANT ALL PRIVILEGES ON DATABASE "bookmarks" TO dct_user;

CREATE DATABASE "data-library";
GRANT ALL PRIVILEGES ON DATABASE "data-library" TO dct_user;

CREATE DATABASE "jobs";
GRANT ALL PRIVILEGES ON DATABASE "jobs" TO dct_user;
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CREATE DATABASE "app";
GRANT ALL PRIVILEGES ON DATABASE "app" TO dct_user;

4.10.3.2 DCT setup

Edit the values.yamlfile to set useExternalDatabase totrue,and also provide the dbHost , dbPort,

dbUser ,and dbPassword ,then run the following.

Shell

helm upgrade -f values.yaml dct-services delphix-dct

& Previous versions of DCT required the aforementioned properties to be base64 encoded, but the values
must be plain text values, as shown in the following excerpt:

useExternalDatabase: true

dbHost: "database-host.company.co"
dbPort: 5432

dbUser: "dct_user"

dbPassword: "dct_user_password"

& fthe password is stored as exemplified above in the values.yaml file, make sure to store this file in a
secure location. Alternatively, set the value using the --set option flag in the helm upgrade command, as
shown in the following excerpt:

helm upgrade -f values.yaml --set dbPassword=dct_user_password dct-

services delphix-dct

4.10.4 Backup and recovery

When using an external database, the gwdatabase-data persistent volume (created at default by DCT) to store

database data is not used. Backing up and restoring the external database is not managed by DCT. Frequent or
continuous backups are required, otherwise, DCT data will be lost.

The gateway-data persistent volume must still be backed up because it contains an encryption key, which is
used to encrypt sensitive data at the application-level, before being sent to the database. A backup of the external
database cannot be restored successfully without a corresponding backup of gateway-data ,as DCT would not
be able to decrypt some of the data in the database. The encryption key in gateway-data does not change after
having been initially created, so backups of it do not need to be scheduled at the same time as database backups.
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4.10.5 External database migration or upgrade

The external database can be migrated to a different host, and/or upgraded to a different version at any time, as
long the version requirements above are met. If the database is unavailable for a period of time, the DCT application
will temporarily fail (internal server errors on all API calls), but will recover automatically without the need for a
restart. However, in case of planned maintenance, upgrade, or migration, the following procedure should be
followed:

Stop (shutdown) the DCT application.

Upgrade or migrate the database.

If necessary, set the updated database properties in values.yaml, and run helm upgrade .
Start the DCT application.

H W e

4.10.6 DCT upgrade

Before upgrading to a new DCT version, review the documentation to identify if the external database version is
compatible. If the external database version is unknown, call the metadata-database APIendpointto get the
information.

curl -k --location --request GET 'https://<dct-server>/v3/management/metadata-
database' \

--header 'Accept: application/json' \

--header 'Authorization: apk <api-key>'

{
"external": false,
"version": "14.7",
"database_product_name": "PostgreSQL",
"major_version": 14,
"minor_version": 7,
"min_supported_major_version": 13,
"min_supported_minor_version": 4,
"max_supported_major_version": 14,
"max_supported_minor_version": 7,
"compatible": true

}

If the version of the external database is not compatible with the requirements of the DCT version being upgraded
to, follow the instructions in the External database migration or upgrade section above before upgrading.

The selected PostgreSQL version to upgrade to must be compatible with both the currently running DCT
version and the upgrade version.

After the upgrade, verify if the external database is compatible with DCT by inspecting the compatible property

ofthe metadata-database APIendpoint (as shown above).
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4,11 DCT data backup and recovery

(@ This method is only applicable for Kubernetes and OpenShift.
« For Kubernetes, use the kubectl command prefix.
« For OpenShift, use the oc command prefix.

4.11.1 Data backup of Persistent Volumes used by DCT

Based on customer need or backup policy, they need to take a backup of data in Persistent Volumes. In DCT,
gateway and database services are using Persistent Volume hence customer need to take backup of data folder
mounted on mounted path.

Take the backup (copy) of the data folders for the gateway Persistent Volume:

kubectl cp {gateway_pod_name}:/data data -n dct-services

Take the backup (copy) of the data folders for the database Persistent Volume:

kubectl cp {database_pod_name}:/var/lib/postgresql/data/ dct_database -n dct-services

4.11.2 Restore data backup in a new DCT setup

Deploy DCT services with the same version for which data back-up was taken. This deployment will create a new
Persistent Volume data folder for the cluster.

Use the following steps to copy the backup data in this new deployment.

First, stop all services.

Terminate proxy pod to stop serving external traffic:

kubectl scale --replicas=0 deployment/proxy -n dct-services

Terminate the database to stop internal threads using the database:

kubectl scale --replicas=0 deployment/database -n dct-services

Terminate the gateway to stop using Persistent Volume data:

kubectl scale --replicas=0 deployment/gateway -n dct-services

Createa dummy pod to access the Persistent Volume using pod.yaml, as shown below.
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apiVersion: vl
kind: Pod
metadata:
Namespace: dct-services
name: dummy-pod
labels:
app: dummy-pod
spec:
containers:
- image: ubuntu
command:

_ "S‘Leep"

- "604800"
imagePullPolicy: IfNotPresent
name: ubuntu

restartPolicy: Always
volumes:
- name: gwdatabase-data
persistentVolumeClaim:
claimName: gwdatabase-data

Create the dummy pod with:

kubectl apply -f pod.yaml -n dct-services

Copy the backup Persistent Volume data into a new cluster.

Move the encryption key:

kubectl cp data dct-services/{gateway_pod_name}:/data

Move the Postgres data:

kubectl cp dct_database dct-services/{dummy_pod_name}:/var/lib/postgresql/data

Delete the dummy pod.

kubectl delete pod dummy-pod -n dct-services

Startthe database pod (scaleto 1):

kubectl scale --replicas=1 deployment/database -n dct-services

Restart all services.
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Delete or patch the gateway pod:

kubectl delete pod {gateway_pod_name} -n dct-services

Delete or patch the data-library pod:

kubectl delete pod {data-library_pod_name} -n dct-services

Delete or patch the jobs pod:

kubectl delete pod {jobs_pod_name} -n dct-services

Delete or patch the data-bookmarks pod:

kubectl delete pod {data-bookmarks_pod_name} -n dct-services

Start the proxy service to serve the external service:

kubectl scale --replicas=1 deployment/proxy -n dct-services

4.12 Exporting DCT logs to Splunk

4.12.1 Overview

This article provides some tips for configuring DCT (running on Kubernetes) to send logs to Splunk and extract
useful information in Splunk.

4.12.2 Setting up a Splunkinstance

Authenticate with Splunk via the web portal and install the third-party Monitoring Kubernetes3? app directly via the
Splunk Ul, then enable HTTP Event Collector in Splunk and save the HTTP Event Collector token for future use.

4.12.3 Enable Splunk log forwarding

Once the Splunk instance is setup, follow the instructions to install Splunk logic in the Kubernetes cluster to

forward logs to Splunk. This blog post33 is a useful resources to understand the log collection and configuration
options.

32 https://splunkbase.splunk.com/app/3743
33 https://faun.pub/logging-in-kubernetes-using-splunk-c2785948fdc0
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git clone https://github.com/splunk/splunk-connect-for-kubernetes.git
cd splunk-connect-for-kubernetes/helm-chart/splunk-connect-for-kubernetes
edit values.yaml

Edit values.yaml, at the minimum the host property (hostname of the Splunk collector) and token (of the HTTP Even
Collector) must be set.

global:
logLevel: 1info
splunk:
hec:
# host is required and should be provided by user
host: <insert-splunk-http-event-collector-hostname-here>
# port to HEC, optional, default 8088
port:
# token 1is required and should be provided by user
token: <insert-token-here>

Install the helm chart and and after a few minutes DCT logs will be visible in Splunk.

helm 1dinstall splunk-connect-for-kubernetes . -f values.yaml --set splunk-kubernetes-
logging.fullnameOverride=splunk-logging

4.12.4 Search for events in Splunk

In the Splunk Cloud Ul, via the “Monitoring Kubernetes” App, you can “search” for data sent by Kubernetes, as
exemplified in the screenshot below. The bootstrap APl key can be found as shown.
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« > C

splunk Apps ¥  Messages¥  Seftings ¥  Activity | Q Find

Overview Workloads ¥ Monitoring ¥ Top~ Events Logs Cluster»

Setup+ Search Alerts Dashboards

Q & https://prd-p-h6jvj.splunkcloud.com/en-US/app/monitoringkubernetes/sc Ty ® L e 1 E ﬂ =

2 EyalKaspiv @~

Monitoring Kubernetes

Review v Security v

sourcetype = kube:container:.gateway

NeW Sea rCh Save As v Create Table View Close
NEWLY Last 24 hours ¥ n
v 1event (2/5/23 9:00:00.000 AM to 2/6/23 9:46:47.000 AM) Job~ A B standard_perf (search ® Smart
i default) v Mode ¥
No Event Sampling » +
Events (1) Patterns Statistics Visualization
Format Timeline v — Zoom Out Thour per column
> Show Fields List = ~ Format 20 Per Page *
i Time Event
> 2/6/23 NEWLY GENERATED API KEY: 1.r2hSuyelRLY86GF1q7nPHIngQNo20rQLzVKzPZmsVTbbdBt44qpDz1c13N8XSWef
9:38:33.646 AM

host = docker-desktop : source = /var/log/containers/gateway-77bdbd85bc-8htfh_apigw-services_gateway-640fb...

The example screenshot below shows a search for \”nginx\”, with use of the “extract new fields” wizard on the
bottom left, which has Splunk parse the Nginx access logs. A regexp is used to name some of the fields like
ipaddress, endpoint, accountid, etc. The example runs a search to return API requests associated with accountid.
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<« - C QO B https://prd-p-h6jvj.splunkcloud.com/en-US/app/monitoringkubernetes/search? ¥ ® ¥ 0 1 E gy =

splunk Apps ¥  Messages ¥  Settings v  Activity v | Q Find 2 EyalKaspiv @~

Overview Workloads ¥ Monitoring ¥ Top~ Events Logs Cluster v Review v Security ¥ Monitoring Kubernetes

Setup v Search Alerts Dashboards

New SearCh Save As ¥ Create Table View Close

index=_* OR index=* sourcetype=kube:container:proxy AND account!="[:]" AND| endpoint!="\"POST /v2/management/accounts/search Last 24 hours ¥ n

?limit=50&sort=first_name HTTP/1.1\"200"
v 27 events (2/5/23 10:00:00.000 AM to 2/6/23 10:09:16.000 AM) Job A | B standard_perf (search ® Smart Mode
) default) v v
No Event Sampling v i

Events (27) Patterns Statistics Visualization

Format Timeline v —Zoom Out " hour per column

> Show Fields Table + # Format 20 Per Page v 2 Next >

i _time host = endpoint * account =

> 2/6/23 docker-desktop "POST /v2/management/accounts/5/tags HTTP/1.1"201 [4:admin-user-1]
9:51:49.353
AM

> 2/6/23 docker-desktop "POST /v2/management/accounts HTTP/11"201 [4:admin-user-1]
9:51:42.976
AM

> 2/6/23 docker-desktop "POST /v2/reporting/virtualization-storage-summary-report/search?limit=15&sort=-used_percentage HTTP/1.1"200 [4:admin-user-1]
9:51:35.547
AM

> 2/6/23 docker-desktop "POST /v2/reporting/virtualization-storage-summary-report/search?limit=50&sort=-used_storage HTTP/1.1"200 [4:admin-user-1]
9:51:35.547
AM

> 2/6/23 docker-desktop "POST /v3/access-groups/admin-user-1/policies HTTP/11"200 [1:-]
9:51:24.846
AM

4.13 Generating a support bundle

4.13.1 Find the “collect_bundle.sh” script

« The support bundle tar file is available on the downloads site34.
+ Once the file is downloaded, untar the file to find the script.

dlpxuser@delphix:~/test$ tar -xzvf dct-support-bundle-1.0.1.tar.gz
X ./

x ./collect_bundle.sh

x ./README

X ./VERSION

34 https://download.delphix.com/folder/1144/Delphix%20Product%20Releases/DCT
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4.13.2 Execute the “collect_bundle.sh” script when DCT is running in Kubernetes

« Transfer the "collect_bundle.sh" script to the machine where you have permissions to execute kubectl
commands against the DCT pods.

& You mustinstall the bash shell to generate a DCT support bundle, if it is not already.

+ Execute the “collect_bundle.sh” script, which assumes a Kubernetes deployment by default. The script may
need to run with "sudo", if root permissions are needed to run the kubectl commands.
« If the namespace is not the default "dct-services", use the "-n" flag and pass the correct namespace.

dlpxuser@delphix:~/test/tools/support-scripts/$ ./collect_bundle.sh -n
<custom_namespace>

DCT support bundle collection started at Thu Jun 22 12:35:05 EDT 2023
Collecting logs from all DCT containers...

4.13.3 Execute the “collect_bundle.sh” script when DCT is running in Docker-
Compose

« Transfer the "collect_bundle.sh" script to the machine where you have permissions to execute docker
commands against the DCT Docker-Compose application.

& You mustinstall the bash shell to generate a DCT support bundle, if it is not already.

« Execute the “collect_bundle.sh” script with the "-d" parameter. The script may need to run with "sudo", if
root permissions are needed to run the docker commands.

dlpxuser@delphix:~/test/tools/support-scripts/$ ./collect_bundle.sh -d

DCT support bundle collection started at Thu Jun 22 12:35:05 EDT 2023
Collecting logs from all DCT containers...

4.13.4 Find the generated support bundle tar file

The resulting support bundle will be located at dct-support-*x**.tar.gz ,inside the currentdirectory.

dlpxuser@delphix:~/test$ 1ls -1ltr
total 316

-rw-r--r-— 1 65436 staff 104189 Feb 17 08:52 dct-support-<current_timestamp>.tar.gz

The support bundle tar file contains the following information:
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+ DCT logs for all of the containers.

« Ajava heap dump, .hprof, if one exists.

« Ajavathread dump and memory stats.

» The output of docker stats, if running in Docker-Compose.

+ The output of cpuinfo, meminfo, and mpstat for each container, if running in Kubernetes.
+ The output of kubectl get pods -0 json for each container, if running in Kubernetes.

® + The collect_bundle.sh generates a support bundle from a DCT engine running in Docker or
Kubernetes.

« The resulting support bundle willbe at . /dct-support-****.tar.gz inside the container.

+ The user must have privileges or permission to execute the docker or kubectl, commands in order
to generate the support bundle.
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5 Data governance

5.1 DCT administration

DCT delivers a management layer on top of all connected Delphix engines through surfacing object inventories,
instrumenting all common Delphix operations, delivering a business metadata layer with tagging, and using those
tags to drive attribute-based access control. This provides the ability for administrators to deliver a highly curated
and secure Delphix experience for automation and end-users.

Catalog Tagging Attribute-based Access Control
Database Action Data Tags Engineering Team Alpha
eCommerce_Customers Provision Network
eCommerce_Payments Engineering Team Central Permission

- High
warehouse_Inventory Teardown Priority Create Update
warehouse_catalog Environment Data Center m Delete View

ERP_logistics SRE_Environment VDB Profile  (EEEe Refresh Rewind

ERP _Accounts Test_Environment Primary Owner

Analytic_Environment

Self-Service Access to Multicloud Tag Data for Protect Data with Global Attribute-Based
Data+Operations, Catalog, APls, Integrations Control & Visibility User Access Management

This section contains configurations handled under the Admin page in the DCT interface.

5.1.1 Tags

5.1.1.1 Tags management

DCT powers data governance with tags. These key-value pairs can be used to associate any business-level data with
any Delphix object, to drive greater intelligence in automation, administrative workflows, data access, and
reporting. Advanced search for tags is available.

Tags are individual attributes on every object exposed in DCT; from VDBs, to compliance jobs, and even users. There
are no limits on tag count per object and character limits are set for flexibility to enable robust grouping.

5.1.1.2 Administrative tagging

Tags can be managed from the Ul by selecting “View Tags” for a particular object on its global list page. The below
example shows the tag configuration screen for a dSource “AGDatabaseSQL2016” and multiple tags have been
added to characterize that particular object:
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Add Tags for "AGDatabaseSQL2016".

(App Team: Alpha Q> ¥ Remove
(Application: Finance Q) ¥ Remove
(Data Center: West Coast Q) # Remove
(Primary Owner: John Smith 0) ¥ Remove
CSecondary Owner: Jane Doe 0) ¥ Remove
Enter Tag Key Enter Tag Value + Tag

Cancel Add Tags

kDCT tags enable complex searching to enable intelligent reports. A demonstration using the above example
dSource and using expression-based search to filter dSources with the {App Team: Alpha} tag.

dSources
View Tags for "AGDatabaseSQL2016". x
An overview of data sources across your Delphix infrastructure.
App Team: Alpha
Search Application: Financo |«
[tags CONTAINS {key EQ 'App Team' AND value EQ 'AIpha'}IM Expression Search v
Data Center: West Coast
Primary Owner: John Smith
Expression Search
‘Secondary Owner: Jane Dos. v
Delphix supports expression-based searching. See below for examples of the se¢
w0
Status Name 1 Type ETgE \'_NB
UNKNOWN AGDatabaseSQL2016 MSSaql amit-engine View tags (5) > View >
UNKNOWN AppFS_cust_master Unstructured Files Test Engine View tags (1) > View »
UNKNOWN AppFS_master Unstructured Files Test Engine View tags (1) > View >

2022 Delphix. All Rights Reserved. Private and Cot
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5.1.1.3 Tags powering attribute-based Access Control

Tags also power the DCT permissions system for both Accounts (users) and Role Scopes (object entitlements). The
below example shows an Access Group (Alpha Team) with the Accounts tab on display. Notice that the accounts tab
has {App Team: Alpha} under “tag mapping”, which automatically attributes any users with the {App Team: Alpha}
tag.

Data Compliance Insights Admin

< Access Groups Alpha Team

Accounts Roles Access

-_—
Tag Mapping Edit Associated Accounts + Manually Add Accounts
e
App Team: Alpha Search Search (All) v
| S

(-] Username T Name Email Addition

—_—
4 John Smith John Smith johnsmith@company.com App Team: Alpha View >
| ——

The same goes for Scoped Roles under the “Roles” tab. The Alpha Team role has been mapped to the {App Team:
Alpha} tag and all dSources with that same tag are automatically attributed.

Data Compliance Insights  Admin

View Select dSources

< Access Groups A|Dha Team

Accounts Roles Access

Edit
Roles . . Alpha Team Role Scope Jus— P

Alpha Team 0 Copy / Edit

Alpha Team >

Object Tag Mappings J |
Give permissions to objects with dS ﬂ Preview |}

the following tags.

Ow= Manage Tags Ow Provision Ow Read Ow Refresh

Ow Set Tags at Object Creation Ow Snapshot

5.1.2 Authentication

Authentication methods can be combined to accommodate the various types of workflows, whether they are web
based interaction for human beings, or automated interactions for third party software, scripting, etc. Please see
the individual pages in the Accounts: connecting/authenticating(see page 55) section under deployment for more
information.

+ API Keys: Each account can optionally be associated with an APl key. The APl key is a long string of
characters which does not automatically expire. API keys are typically used for machine to machine
communication. APl key authentication can not be disabled.

« Username/Password: Each account can optionally be associated with a username/password combination.
DCT stores passwords a cryptographic hash of the password and salt using the Bcrypt algorithm in its
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internal database. The password policies feature of DCT can be used to define the minimum requirements of
valid passwords (min length, special characters requirements, etc.) and temporarily block accounts after
failed login attempts. Username/Password authentication can be disabled across the DCT instance via the
global properties feature, for instance when the company policy is to prefer delegated authentication (LDAP/
Active Directory/SAML/SSO0).

+ LDAP/Active Directory: When using LDAP/Active Directory, API clients authentication with a username/
password combination, but DCT does not store the password locally in its internal database, and instead
connects over the LDAP protocol to validate passwords. More over, additional attributes such as first and
last name, email addresses and group membership can be read from the LDAP/Active directory system,
enabling access to DCT to be controlled via enterprise systems like directory services.

« SAML/SSO: The SAML 2.0 protocol, implemented by DCT, allows web Ul sessions to authenticate via an
enterprise identify provider (Active directory federation services, Azure active directory, Ping federate, Okta,
Onelogin, etc.). When using the SAML/SSO authentication method, DCT does not store any credentials in its
internal database, but instead delegates authentication to the identify provider, via web browser
redirection. The SAML/SSO protocol is only intended for web browser based interaction.

« OpenlD connect: OpenID connect (an extension of OAuth2.0) can be used for computer based systems
(scripts, integrations) to login to DCT, providing additional security over API keys.

5.1.3 Access groups

DCT Access Groups provides global user management and permissions for all objects within the connected
ecosystem. This entitlement authorization system is both managed and enforced for operations triggered through
DCT APIs and/or user interface.

a This is mutually exclusive to the permissions system on local Continuous Data, Continuous Compliance,
and Self-Service applications. However, DCT’s system does enable users to operate on objects within
local engines, as DCT will perform those operations on the users behalf, if the user has the correct
permissions within DCT.

User A belongs to Access
Group “Alpha”, which has
provision permissions on
VDB “A”

DCT requests the
provisioning of a new VDB
from VDB “A” on User “A”’s
behalf.

Data Engine

5.1.3.1 Access Group structure

Access Groups represent a singular, global set of users and permissions. It operates as the point to manage access
and authorization for all users; both human users accessing the DCT Ul, and automation by means of generating
API keys to leverage the DCT APIs.

Access Groups are comprised of two sets of configurable objects, accounts and roles.
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Access Groups can have any number of accounts and roles (e.g. a role pairing DevOps permission sets for
a subset of VDBs, and a role pairing Compliance permission sets for a subset of Compliance Jobs).

Access Groups

Membership Attribution
Assigned Membership AD Group

= DCT Account Tag

(Users and API Keys)

AL

Manually Allocated Accounts
Role Mode b

t Simple (Permissions for objects [N P Role Type
LndeRatlpe Standard Role
Scoped (Permissions over a > — <
subset of objects
Advanced (Allocate objects by ~
L individual permission /

Custom Role

5.1.3.2 Accounts

Accounts represent generalized users; a human user, an APl key, or both. An account can belong to multiple Access
Groups, but it is strongly recommended to maintain a dedicated Access Group for an account or group of accounts,
to prevent privilege creep. Accounts can be attributed to Access Groups via LDAP/Active Directory Group attributes,
DCT Account Tags, or manually adding accounts.

5.1.3.3 Roles

Roles can be considered a collection of permissions. Attributing a role into an Access Group first starts by
identifying a “mode”. DCT currently supports both simple and scoped modes for roles, with the plan to introduce
advanced mode in a subsequent release.

Simple mode is meant to apply general sets of permissions as universal, for all applicable types of objects. For
example, a simple mode with a “Monitor” set of permissions will give viewing rights for all VDBs, dSources,
environments, etc.

Scoped mode is more closely related to the Continuous Data Engine model of applying a set of permissions on
specific groups of applicable objects. For example, scoped mode with a “DevOps” set of permissions grants view,
refresh, provision, etc. permissions over the defined set of VDBs. Scoped roles can be automated.

In addition to modes, roles can be configured with role types. The current release only includes “standard” roles,
which are comprised of:
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Admin role

DSOURCE/SNAPSHOT ,VDB/MANAGE_TAGS ,MASKING_JOB_SET/
SET_TAGS_AT_OBJECT_CREATION,BOOKMARK/SET_TAGS_AT_OBJECT_CREATION,VDB/

UPDATE ,MASKING_JOB_SET/REMOVE_JOB, LDAP/VALIDATE,DSOURCE/

UPDATE ,DSOURCE_CONSUMPTION_REPORT/READ,ENVIRONMENT/DISABLE,GLOBAL_PROPERTIES/
READ,VDB_GROUP/DELETE ,GLOBAL_PROPERTIES/UPDATE,ACCOUNT/DELETE,DATABASE_TEMPLATE/
UPDATE, ENVIRONMENT /REFRESH,CDB/MANAGE_TAGS,VDB/CREATE,JOB/READ,DATABASE_TEMPLATE/
READ,REPORT_SCHEDULE/READ,VDB/PROVISION,DSOURCE/MANAGE_TAGS,VDB/

SNAPSHOT , STORAGE _SUMMARY _REPORT /READ,DSOURCE/PROVISION,SAML/UPDATE,VDB/

REFRESH, ACCOUNT /MANAGE_TAGS ,ACCOUNT/PASSWORD_RESET ,ENGINE/UPDATE ,ACCOUNT/
READ,BOOKMARK/DELETE ,REPORT_SCHEDULE/CREATE,VDB_GROUP/MANAGE_TAGS ,PASSWORD_POLICY/
READ,VDB_GROUP/READ,VCDB/READ,MASKING_JOB/READ,CDB/READ,JOB/

ABANDON, CONNECTIVITY_CHECK/EXECUTE ,MASKING_JOB_SET/COPY,API_CLASSIFICATION/
UPDATE,ENGINE/CREATE_ENVIRONMENT,ACCESS_GROUP/UPDATE,VDB/DELETE,VAULT/
DELETE,MASKING_JOB/DELETE,API_USAGE_REPORT/READ,MASKING_JOB_SET/UPDATE,DSOURCE/
READ,VDB_GROUP/CREATE, LDAP/UPDATE ,ACCOUNT/CREATE ,SMTP_CONFIG/VALIDATE,CONNECTOR/
UPDATE,VDB/READ, SMTP_CONFIG/READ,ENVIRONMENT/READ,ROLE/READ, SOURCE/
UPDATE,ENVIRONMENT /DELETE ,ENVIRONMENT /CREATE,VDB/START,VDB/DISABLE,VAULT/
READ,VDB_GROUP/REFRESH,BOOKMARK/READ ,DATABASE_TEMPLATE/IMPORT,DATABASE_TEMPLATE/
UNDO_IMPORT,ACCESS_GROUP/DELETE,VAULT/CREATE,VDB/ENABLE,ENGINE/
SET_TAGS_AT_OBJECT_CREATION,SOURCE/MANAGE_TAGS,BOOKMARK/UPDATE,VCDB/UPDATE,VDB/
SET_TAGS_AT_OBJECT_CREATION,DSOURCE_USAGE_REPORT/READ,SAML/READ,MASKING_JOB_SET/
MANAGE_TAGS, ENVIRONMENT /MANAGE_TAGS ,REPORT_SCHEDULE/DELETE,DSOURCE/
REFRESH,DATABASE_TEMPLATE/DELETE,VDB/STOP,ACCOUNT /UPDATE ,ENGINE/MANAGE_TAGS,BOOKMARK/
CREATE ,PASSWORD_POLICY/UPDATE,MASKING_JOB_SET/DELETE,ACCESS_GROUP/READ,VDB_GROUP/
UPDATE, ENVIRONMENT /SET_TAGS_AT_OBJECT_CREATION,VDB/CREATE_VDBGROUP,DATABASE_TEMPLATE/
CREATE,VDB_GROUP/SET_TAGS_AT_OBJECT_CREATION,LDAP/READ,BOOKMARK/
REFRESH_FROM_BOOKMARK, REPORT_SCHEDULE /UPDATE , BOOKMARK/
PROVISION_FROM_BOOKMARK,ENVIRONMENT/ENABLE,VDB/CREATE_BOOKMARK,VCDB/

MANAGE_TAGS ,MASKING_JOB/UPDATE ,BOOKMARK/MANAGE _TAGS,VDB_INVENTORY_REPORT/READ,ENGINE/
CREATE,CONNECTOR/EXECUTE ,ENVIRONMENT /UPDATE ,PRODUCT_INFO/READ,SMTP_CONFIG/

UPDATE ,ACCESS_GROUP/CREATE ,ACCOUNT/SET_TAGS_AT_OBJECT_CREATION,CONNECTOR/
READ,API_CLASSIFICATION/READ,CDB/UPDATE,ENGINE/DELETE,MASKING_JOB_SET/READ,SOURCE/
READ, ENGINE/READ

Monitor role

BOOKMARK/READ,SMTP_CONFIG/UPDATE,PRODUCT_INFO/READ,API_USAGE_REPORT/READ,JOB/
READ,REPORT_SCHEDULE/CREATE ,DSOURCE /READ,REPORT_SCHEDULE/READ,VDB_GROUP/
READ,SMTP_CONFIG/VALIDATE,VCDB/READ,DSOURCE_CONSUMPTION_REPORT/READ,SOURCE/
READ,DSOURCE_USAGE_REPORT/READ,CDB/READ,VDB/READ,REPORT_SCHEDULE /UPDATE ,ENVIRONMENT/
READ,SMTP_CONFIG/READ,ENGINE/READ,STORAGE_SUMMARY_REPORT/READ,REPORT_SCHEDULE/
DELETE,VDB_INVENTORY_REPORT/READ
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DevOps role

ENVIRONMENT /DELETE,ENVIRONMENT/CREATE,VDB/MANAGE_TAGS,VDB/START,BOOKMARK/
SET_TAGS_AT_OBJECT_CREATION,VDB/UPDATE,VDB/DISABLE,DSOURCE/UPDATE,ENVIRONMENT/
DISABLE,VDB_GROUP/DELETE,VDB_GROUP/REFRESH,BOOKMARK/READ,DATABASE_TEMPLATE/
UPDATE,ENVIRONMENT /REFRESH,DATABASE_TEMPLATE/IMPORT,CDB/

MANAGE_TAGS ,DATABASE_TEMPLATE/UNDO_IMPORT,VDB/CREATE,VDB/ENABLE,SOURCE/

MANAGE_TAGS ,ENGINE/SET_TAGS_AT_OBJECT_CREATION,JOB/READ,BOOKMARK/

UPDATE ,DATABASE_TEMPLATE/READ,VCDB/UPDATE,VDB/SET_TAGS_AT_OBJECT_CREATION,VDB/
PROVISION,VDB/SNAPSHOT,DSOURCE/MANAGE_TAGS, ENVIRONMENT /MANAGE_TAGS,DSOURCE/
PROVISION,DSOURCE/REFRESH,DATABASE_TEMPLATE/DELETE,VDB/STOP,ENGINE/MANAGE_TAGS,VDB/
REFRESH, BOOKMARK/CREATE,VDB_GROUP/UPDATE ,BOOKMARK/DELETE ,VDB_GROUP/
MANAGE_TAGS,ENVIRONMENT /SET_TAGS_AT_OBJECT_CREATION,VDB/CREATE_VDBGROUP,VDB_GROUP/
READ,DATABASE_TEMPLATE/CREATE,VDB_GROUP/SET_TAGS_AT_OBJECT_CREATION,VCDB/READ,CDB/
READ, BOOKMARK/REFRESH_FROM_BOOKMARK , BOOKMARK/PROVISION_FROM_BOOKMARK, JOB/

ABANDON , ENVIRONMENT /ENABLE,VCDB/MANAGE_TAGS,VDB/CREATE_BOOKMARK,BOOKMARK/
MANAGE_TAGS,VDB/DELETE,ENVIRONMENT /UPDATE ,PRODUCT_INFO/READ,DSOURCE/READ,VDB_GROUP/
CREATE,CDB/UPDATE , SOURCE /READ,VDB/READ, ENVIRONMENT /READ, ENGINE/READ, SOURCE /UPDATE

Masking role

PRODUCT_INFO/READ,MASKING_JOB/DELETE,ENGINE/UPDATE ,MASKING_JOB_SET/DELETE,JOB/

READ ,MASKING_JOB_SET/UPDATE,CONNECTOR/READ,ENGINE/DELETE ,MASKING_JOB_SET/
REMOVE_JOB,MASKING_JOB_SET/READ,CONNECTOR/UPDATE ,MASKING_JOB/READ,JOB/

ABANDON ,MASKING_JOB_SET/COPY,ENGINE/READ,MASKING_JOB/UPDATE,CONNECTOR/EXECUTE,ENGINE/
CREATE

Owner role

ENVIRONMENT/DELETE,DSOURCE/SNAPSHOT,VDB/START ,MASKING_JOB_SET/
SET_TAGS_AT_OBJECT_CREATION,BOOKMARK/SET_TAGS_AT_OBJECT_CREATION,VDB/

UPDATE ,MASKING_JOB_SET/REMOVE_JOB,VDB/DISABLE,DSOURCE/UPDATE ,ENVIRONMENT/
DISABLE,VDB_GROUP/DELETE,VAULT/READ,VDB_GROUP/REFRESH, BOOKMARK/READ,ACCOUNT/
DELETE,DATABASE_TEMPLATE/UPDATE, ENVIRONMENT /REFRESH,DATABASE _TEMPLATE/

IMPORT ,DATABASE_TEMPLATE/UNDO_IMPORT,ACCESS_GROUP/DELETE,VDB/ENABLE,ENGINE/
SET_TAGS_AT_OBJECT_CREATION,BOOKMARK/UPDATE ,DATABASE_TEMPLATE/READ,VCDB/UPDATE,VDB/
SET_TAGS_AT_OBJECT_CREATION,REPORT_SCHEDULE/READ,VDB/PROVISION,VDB/

SNAPSHOT ,REPORT_SCHEDULE /DELETE ,DSOURCE /PROVISION,DSOURCE/REFRESH,DATABASE_TEMPLATE/
DELETE,VDB/STOP,ACCOUNT/UPDATE,VDB/REFRESH,ACCOUNT/PASSWORD_RESET,ENGINE/

UPDATE ,MASKING_JOB_SET/DELETE,ACCESS_GROUP/READ, VDB_GROUP/UPDATE ,ACCOUNT/

READ, BOOKMARK/DELETE , ENVIRONMENT /SET_TAGS_AT_OBJECT_CREATION,VDB/

CREATE_VDBGROUP, VDB_GROUP/READ, VDB_GROUP/SET_TAGS_AT_OBJECT_CREATION,VCDB/
READ,MASKING_JOB/READ,CDB/READ, BOOKMARK/REFRESH_FROM_BOOKMARK ,REPORT_SCHEDULE/
UPDATE , BOOKMARK/PROVISION_FROM_BOOKMARK, ENVIRONMENT/ENABLE,VDB/

CREATE_BOOKMARK , MASKING_JOB/UPDATE , ENGINE /CREATE_ENVIRONMENT ,CONNECTOR/
EXECUTE,ACCESS_GROUP/UPDATE,VDB/DELETE , ENVIRONMENT /UPDATE,VAULT/DELETE ,MASKING_JOB/
DELETE,ACCOUNT/SET_TAGS_AT_OBJECT_CREATION,MASKING_JOB_SET/UPDATE,DSOURCE/
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READ,CONNECTOR/READ,CDB/UPDATE ,ENGINE/DELETE ,MASKING_JOB_SET/READ,CONNECTOR/
UPDATE, SOURCE/READ,VDB/READ, ENVIRONMENT/READ, ENGINE/READ, SOURCE /UPDATE

E The subsequent DCT release will include the ability to create roles with custom sets of permissions.

5.1.3.4 Example configuration scenario

Access Groups can only be configured and updated via API as of DCT 4.0. Users will have the ability to
perform these configuration steps within the DCT Ul with the 5.0 release.

In this scenario, a DCT administrator will configure a new Access Group “App Team Alpha” who’s membership will
include Accounts with the AD Group attribute CN=Alpha, CN=Teams , DC=delphix , DC=com as well as the

manual addition of a unaffiliated user. This Access group will be “scoped” to have permissions from the DevOps
role over all VDB’s with the {Team: Alpha} tag.

Data assumptions
To create access group with above requirements, let first assume few values to understand the API call:

+ Access group name is App Team Alpha
« DevOpsrole name= "devops"

« For AD users, one of the AD group attribute valueis CN=Alpha, CN=Teams , DC=delphix , DC=com
+ Individual Account with account ID =10

« VDBwithid= "1-VDB-DATASET-1"

+ Scope by object tag: {Team: Alpha}

Option one

Create an access group with all required roles and permissions as mentioned above in a single API call.

APl: POST - https://<hostname>/v2/access-groups

Request Body:
{
"name": "Team Alpha",
"account_dids": [
10

1,
"account_tags": [
{
"key'": "login_groups",
"value": "CN=Alpha, CN=Teams, DC=delphix, DC=com"
}
1,
"policies": [
{

"role_id": "devops",
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"everything": false,
"object_tags": [

{
llkeyll: IlTeamll’
"value": "Alpha"
}
1,
"objects": [
{
"object_id": "1-VDB-DATASET-1",
"object_type": "VDB"
}

Response: 201 - Created

Option two

Create the access group for above mentioned data/requirements by using different API calls as well. Do this using
multiple APIs.

1. Create Access Groups

APl: POST - https://<hostname>/v2/access-groups

Request Body:
{
"name": "Team Alpha"
}

Response: 201 - Created

The Access Group id will appear in the response, as shown:

{
"id": "111111-2222-aaaa-bbbb-123456abcdef",
"name": "Team Alpha",
"single_account": false

}

2. Add account manually

APl: POST - https://<hostname>/v2/access-groups/111111-2222-aaaa-—
bbbb-123456abcdef/account-ids

Request Body:
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{
"account_ids": [
10

]
}

Response: 200 - OK (Updated Access Group)

3. Add AD users automatically for the groups assumed above.

In order to add AD users automatically to this Access Group, we will need to create account tags matching with AD
groups as follows:

APl: POST - https://<hostname>/v2/access-groups/111111-2222-aaaa-
bbbb-123456abcdef/tags

Request Body:
{
"tags": [
{
"key'": "login_groups",
"value": "CN=Alpha, CN=Teams, DC=delphix, DC=com"
}
]
3

Response: 200 - OK (Updated Access Groups)

4. Assign DevOps role to the Access Group.

For adding DevOps role, we will create a policy/scope for the access group as follows:

APl: POST - https://<hostname>/v2/access-groups/111111-2222-aaaa-—
bbbb-123456abcdef/policies

Request Body:

"policies": [
{
"role_id": "devops",
"everything": false

}

Response: 200 - OK (Updated Access Groups)
5. Add tags to Scope/Policy of the Access Group.

Assume the created policyld/scopeldis 99999-2222-aaaa-bbbb-abced92dk3 .
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APl: POST - https://<hostname>/v2/access-groups/111111-2222-aaaa-
bbbb-123456abcdef/policies/99999-2222-aaaa-bbbb-abced92dk3/object-tags

Request Body:
{
"tags": [
{
"key": "Team",
"value": "Alpha"
}
]
}

Response: 200 - OK

6. Add VDB manually.
To add VDB manually, use the below API:

APl: POST - https://<hostname>/v2/access-groups/111111-2222-aaaa-—
bbbb-123456abcdef/policies/99999-2222-aaaa-bbbb-abced92dk3/objects

Request Body:
{
"objects": [
{
"object_id": "1-VDB-DATASET-1",
"object_type": "VDB"
}

Response: 200 - OK

5.1.3.5 User interface

Copy role scope

On the detail page of a role scope, an action is now available to copy it. The default name of the copied scape is
"Copy of [name of the original scope]", which can later be updated with the edit scope wizard. The list of scopes are
sorted by name, allowing for easy access in locating the created copy. To create a scope for a brand new role that is
not yet added to the Access Group, you must first add the role by editing the role tile on the left side of the scope
detail page.
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Data Compliance Insights Admin e
Access Group
< Access Groups 1
Accounts Roles
Roles Edit admin Role Scope
" 0 " Edi
¥ admin SIMPLE 0 Copy # Edit

admin > devops > monitoring >

devops Role Scope

SIMPLE C Edit

¥ devops Dogy 7
monitoring Role Scope D= o 7 Edit
~ monitoring 0 Gopy '

Delete role scope

On the detail page of a role scope, an action is now available to delete it. The delete button is unavailable if the role
scope is the only one of that role. If the scope should still be deleted and the button is unavailable, you must use the
edit role wizard to remove the role entirely, ultimately deleting the role scope.

Remove Role Scope.

Are you sure you want to remove this Role Scope?

5.1.3.6 Advanced scope type
APl Example:

curl --location --request POST '<hostname>/v3/access-groups/{access-group-id}/scopes/
{scopeld}/objects' \
--header 'Content-Type: application/json' \
--data-raw '{
"objects": [
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{
"object_id": "1",
"object_type'": "ACCOUNT",
"permission" : "READ"

}

} ]

Add an always allowed object to Access Group scope
Always allowed objects can be defined as objects that are always allowed for an access group scope. This can be set
as follows:

Add always allowed objects:

curl —--location --request POST '<hostname>/v3/access-groups/{access-group-id}/scopes/
{scope-id}/always_allowed_permissions' \--header 'Content-Type: application/json' \
--data-raw '{
"always_allowed_permissions": [
{
"object_type": "ACCOUNT",
"permission" : "READ"

]
} '

Response: The updated access group scope

Here it means that all objects with object type ACCOUNT and permission READ are allowed with this access group
scope. This will clear out matching object type and permissions, if any in objects attribute of access group scope.

Remove always allowed objects:

curl --location --request POST '<hostname>/v3/access-groups/{access-group-id}/scopes/
{scope-id}/always_allowed_permissions/delete' \--header 'Content-Type: application/
json' \
--data-raw '{
"always_allowed_permissions": [
{
"object_type": "ACCOUNT",
"permission" : "READ"

]
} 1

Response: The updated access group scope

5.1.4 VDB templates

For additional detail on VDB templates, visit the “Configuration Settings for Oracle VDBs” article in the
Continuous Data Engine documentation.
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DCT has implemented a global VDB template system to centrally manage and apply VDB templates for any and all
VDB provisioning workloads. This feature works as an extension of the local VDB template system on Continuous
Data Engines as a means of enforcing VDB configuration standards and policies uniformly.

DCT Admins have the choice of either importing pre-existing VDB templates from a local engine or creating net-new
templates from within DCT.

5.1.4.1 Creatingtemplates

Users can create Database Templates directly via DCT, which can then be used on VDBs across their engines. The
DCT APl interface for creating templates is equivalent to that of on-engines, requiring a name and sourceType, and
optionally taking in a description and the list of config parameters. Here’s a sample CURL command:

curl =X '"POST' \
'<https://<APPLIANCE_ADDRESS>/v2/database-templates'> \
-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

-d l{

"name": "vdb-config-template-1",

"source_type": "OracleVirtualSource"

"parameters": {"configl": "valuel", "config2": "value2"}'}

This will result in a new DCT DatabaseTemplate object, which can then be viewed using the List/Get/Search APIs.

5.1.4.2 Importing templates

Unlike many other Delphix objects, DCT is not automatically pulling in all the Database Templates from registered
engines and creating DCT objects out of them. It is often the case that users have already made arrangements and
have copies of their templates across their engines. DCT does not blindly import the templates to avoid generating
duplicates, leading users to consolidating and clean up. Instead, DCT provides an import API that can be used to
selectively choose which engines they wish to import their templates from, along with an API to undo imports. The
import workflow has a couple of things to be aware of:

« The user cannot be selective of which individual templates to import from an engine. The import APl will pull
ALL templates from that engine.

« Import is allowed only one time per Engine. After an initial import, subsequent imports will be blocked, and
itis assumed that a user will use the DCT APIs to create more templates.

+ Inthe event that an import was done on accident or no longer desired, the undo import API can be called to
delete all the imported templates from the selected engine. This will result in the removal of all DCT
Database Templates that were created as a result of the import.

« Ifanimported template is later used on a VDB running on a different engine than where it was originally
imported from, then the undo import flow is also prohibited, as DCT can no longer safely delete a template
that is in use elsewhere.

Import templates from the engine:

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v2/database-templates/import' \
-H 'accept: */*' \
-H 'Authorization: <API_KEY>' \
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-H 'Content-Type: application/json' \
_d l{
"engine_id": "3"

} ]

Undo the imported templates from engine:

curl -X 'POST' \
"https://<APPLIANCE_ADDRESS>/v2/database-templates/undo-import' \
-H 'accept: */*' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
_d l{
"engine_id": "3"

} '

5.1.4.3 Using templates

DCT Database Templates can be used by specifying the template_id property at VDB provisioning time, or by
updating the template_id on an existing VDB. In either case, DCT will deploy the template to the respective engine
and bind the template with the VDB. When a DCT Database Template currently in use is updated or deleted, those
changes are propagated to the respective VDBs and engines.

If a VDB has the same parameter called out in both VDB template and individual setting, the value
specified in the template will take precedence. The individual parameter value will only be used if the
VDB template is removed.

Updating a VDB to use template_id:

curl =X '"PATCH' \
"https://<APPLIANCE_ADDRESS>/v2/vdbs/1-ORACLE_DB_CONTAINER-1' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d l{
"template_id": "319db966-961c-4977-a444-14d337aa3276"

}l

E Updates to a VDB template will propagate to all associated VDBs.

Data governance - 97



Data Control Tower - Data Control Tower Home

5.1.5 APl metering

5.1.5.1 APl metering instructions

DCT employs a per APl consumption model, which requires APl metering and periodic reporting to Delphix
Customer Success. To support reporting of APl consumption, DCT offers an APl consumption reporting endpoint
called, “api-usage-report”. This report will provide a list of all unique API endpoints and how often they were used
over the specified time period sorted by APl and method.

Required inputs

« File type: CSV or JSON (CSV file types are compatible with most spreadsheet-style software like Excel or
Google Sheets)

« Start/end date: The default start date is “when DCT was installed” and the default end date is the “time
when the report was generated”.

Example cURL call

curl --location --request GET 'https://[Inser_DCT_Server]/v2/reporting/api-usage-
report/?end_date=2022-06-14T09:00-04:00&start_date=2022-06-01T00:00Z"' \

--header 'Content-Type: application/json' \

--header 'Accept: text/csv' \

--header 'Authorization: apk 1.xXxxxxxxx'

Example output

api_endpoint,api_method,api_count
"/v2/management/api-clients",GET,2
/v2/management/engines,GET,1
"/v2/management/engines/search",POST,1
"/v2/reporting/api-usage-report",GET,2

5.1.6 Client telemetry

DCT provides complete flexibility to clients on how to attribute their API calls. DCT captures the value provided in an
optional HTTP header ( X-Dct-Client-Name ) and standard, mandatory HTTP header ( User-Agent ) for the

purpose of attributing an API call. These values are stored as client_name and user_agent inthe backend,
and can be queried in the report. Below are some examples of how this can be used.

Example one

Clients can view the report grouped on the basis of client name and API classification by providinga group_by
query parameter.

curl —--location 'https://[Inser_DCT_Server]/v3/reporting/api-usage-report?
group_by=client_name%2Ckind' \
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--header 'Authorization: <api_key>' \
--header 'Accept: text/csv'

api_endpoint,api_method,api_count,kind,client_name,user_agent,dct_version
,s2,management,client-1,,

, s5,management,client-2,,

, 520 ,management,client-3,,

The group_by parameter supports any combination of properties from api_endpoint, api_method,
kind, client_name, user_agent,and dct_version .All properties function as their name describes,

where kind corresponds to API classification.
Example two

Clients filter the records for a list of particular client names, DCT versions, user agents, or classifications, by
providing corresponding query parameters.

1. Filter the API calls by client names.

curl --location 'https://[Inser_DCT_Server]/v3/reporting/api-usage-report?
group_by=client_name%2Ckind&client_name=clientl%2Cclient2"' \

--header 'Authorization: <api_key>' \

--header 'Authorization: apk <api key>

2. Filter the API calls by API classification.

curl --location 'https://[Inser_DCT_Server]/v3/reporting/api-usage-report?
group_by=client_name%2Ckind&api_metric_kind=automation' \

--header 'Authorization: <api_key>' \

--header 'Authorization: apk <api key>'

B The API query parameters for this report are dynamic; depending on the number of records in the
backend and the granularity of the response requested, API response can be too large to be handled by
DCT. DCT can run out of memory and eventually crash if that is the case. To prevent this from happening,
this report has the maximum limit set to 10,000 records in the APl response. Thus, it is strongly
recommended to always ‘limit’ the scope of the usage response by filtering records on the basis of

start_date and end_date query parameters, or on the basis of client names and/or user agents.

5.2 Central governance workflows

Data Control Tower delivers the management layer for all connected Delphix engines by virtue of its converged
architecture. As such, DCT has the ability to simplify everyday administration of common engine admin tasks. This

section will go over various how DCT exposes object relationships and reports on meaningful use patterns under
insights.
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5.2.1 Managing engines (Continuous Data)

5.2.1.1 Infrastructure

DCT provides a near real-time list of all connected continuous data engines and lists them in an aggregate view.
From the below screen, Delphix administrators can easily view and manage their engine connections.

Data Compliance Insights  Admin

dsources Infrastructure m

View all your connected Delphix engines.

VDBs

Search Search (Al) v
Bookmarks

Environments Status, Name/uuiD Type Host Tags

Test Engine Vintualization y ; .
Onine AZ308308-1325-7111-0256-50042acdBazne 5000 vorxyelphikiwmhy7.vm.cid.sr Add Tags > View>
amaresh-engine’ Unset
« Online 564c4aad-48b1-ad55-7873-79833008418a ono ‘amaresh-engine?.dcol1.delphix.com Add Tags > View>

VDB Config Templates
onfig Templ bhavik-engine Virtualization

@ Onlne ec2242ct-2009-52fe-b8ac-fadaffan7erc 10.0.00

bhavik-engine.dipxde.co AddTags > View >

From this screen, administrators can manage engine connects via the “Connect Engine” button on the top right
corner. By clicking this button, the below dialogue will appear, asking for connection details.

DCT will access the engine as a registered user and, as detailed in the Deployment section, requires both
a username and password as well as admin-level access to the engine.

Connect Engine X

® Engine Details Engine Details

Name

Test Engine
Authentication

Hostname
Security uvo1xyellphlkiwmhy7.vm.cld.sr
Tags Choose Engine Type

@ Virtualization
Summary

(O Masking

5.2.1.2 Engine Overview

Individual engine details can be seen and acted upon by clicking down on a particular engine detailed view. Once
clicked, users will be sent to an "Overview" tab that provides relevant metadata related to the engine.
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Data Compliance Insights  Admin

< mfasructre €St ENgine

Overview Environments dSources VDBs Access

7% B Used Storage 5.30GB.

Used Remaining Storage 70.27GB.
Details Tags Edit
Type Data Engine
Version 9.000

5.2.1.3 Engine-connected Environments

The "Environments" tab presents all environment connections to that particular engine.

Data Compliance Insights  Admin

< mrasrucre €S ENgine

Overview Environments dsources VDBs Access
Search Search (Al) v
Name Hosts IP (Port) DBMS (Version) Config Engine ID Tags
10.160.1.21 Unstructured Files.
Oracle_Source 10.160.1.21 mysql-plugin Standalone 3 AddTags >
10.160.1.21 Oracle (19.3.0.0.0)
10.160.1.61 Unstructured Files
Oracle_Target 10.160.1.61 mysql-plugin Standalone 3 AddTags >
10.160.1.61 Oracle (19.3.0.0.0)
10.160.1.20 Unstructured Files.
Postgres_Source 10,1601 20 postgres-vsck Standalone 3 AddTags >
10.160.1.60 Unstructured Files.
Postgres_Target 10,1601 60 postgres-vadk Standalone 3 AddTags >
Salserver_Source 10.160.1.22 MSSql (14.0.2027.2) Standalone 3 AddTags >
10.160.1.62 Unstructured Files.
Salserver Target 10,1601 62 MSSal (14,0207 2) Standalone 3 AddTags >

5.2.1.4 Local dSources

The "dSources" tab presents all dSources associated with the selected engine. Clicking the "View" button will link
the user directly to the associated dSource page.

Data Compliance Insights  Admin

< mrastucwre €St ENgine

Overview Environments dSources VDBs Access
Search Search (AI) v
Status Name Type Tags
UNKNOWN ApPFS_cust_master Unstructured Files Add Tags > View >
UNKNOWN AppFS_master Unstructured Files Add Tags > View >
UNKNOWN Mysal_master mysql-plugin Add Tags > View >
UNKNOWN Oracle_master Oracle Add Tags > View >
UNKNOWN Postgres_cust_master postgres-vsdk Add Tags > View >
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5.2.1.5 Local VDBs

The "VDBs" tab presents all VDBs associated with the selected engine. Clicking the "View" button will link the user
directly to the associated VDB page to take action.

Data Compliance Insights  Admin

< mfasrucre €St ENgine
Overview Environments dSources VDBs Access

Search Search (AI) v

Status Name T Type Tags

RUNNING AppFS_DEV Unstructured Files Add Tags > View >
UNKNOWN APPFS_MASK Unstructured Files Add Tags > View >
UNKNOWN APPFS_QA Unstructured Files Add Tags > View >
UNKNOWN APPFS_cust DEV Unstructured Files Add Tags > View >
UNKNOWN ApPFS_cust MASK Unstructured Files Add Tags > View >

5.2.1.6 Engine-based Operations Access

Users are able to audit which users have access to this particular engine, what access group they belong to, and the
associated permissions that each user has on this engine. Admins are able to click on the "View" button to access
further details under the access control screen related to that specific user.

Data Compliance Insights  Admin

< wiasewe TSt ENgine Engines

On Greate  Ow GreateEnvionment O Delele  Ow Manage Tags

Overview Environments dsources VDBs Access
O Resd  Ow SetTags at ObjectGreation  Ow Update
u: Access Group P
1 o GREATE_ENVIRONMENT o DELETE View >
John Smith
o John Smith > o- GREATE_ENVIRONMENT o= DELETE View >

5.2.2 Managing dSources

5.2.2.1 Managing dSources

DCT provides the ability to view, search, sort, and filter all dSources within a connected Delphix ecosystem. This
page can be found under the Data section and is used to find and act upon all dSources, if they have the
appropriate access.
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Data Compliance Insights Admin

dSourees

dat your Delphix nfrastructt
VDBs
Search Search (Al) v

Bookmarks
Environments Status Name Type Engine Tags

UNKNOWN ADPFS_cust_master Unstructured Files. Test Engine AddTags > View >
Infrastructure

UNKNOWN AppFS_master Unstructured Files. Test Engine AddTags > View >
VDB Config Templates

UNKNOWN CDOMLOSR421FPDB1 Oracle. bhavik-engine AddTags > View >

UNKNOWN CDOMLOTGS813PDB1 Oracle bhavik-engine AddTags > View >

RUNNING dcol1. delph Oracle amaresh-engine’ AddTags > View >

UNKNOWN DBOMSRBA1718 Oracle. bhavik-engine AddTags > View >

UNKNOWN Mysal_master mysql-plugin Test Engine AddTags > View >

UNKNOWN Oracle_master Oracle. Test Engine AddTags > View >

UNKNOWN Postgres_cust_master postgres-vsdk Test Engine AddTags > View >

UNKNOWN Postgres_master postgres-vsdk Test Engine AddTags > View >

UNKNOWN Suitecrm_master Mssql Test Engine AddTags > View >

UNKNOWN flaskapp Mssql Test Engine AddTags > View >

5.2.2.2 dSource overview

Individual dSource details can be viewed and acted upon by clicking down on a particular dSource's detailed view.
Once clicked, users will be sent to an "overview" tab that provides relevant metadata related to the dSource.

Data Compliance Insights  Admin

¢ asouces  APPFS_cust_master

Overview Timefiow Access

Platform Status

Unstructured Files

Details Tags Edit Environment Details

Platform Unstructured Files Environment Name Postgres_Source
Version Type Single Instance
Enabled False os

size 5.20MB

Engine Test Engine

5.2.2.3 Timeflow visibility

Users are able to view snapshot information by tabbing over to the "timeflow" section, which lists all available
snapshots via a vertical timeline. Users are able to modify snapshot retention periods by clicking on the ellipsis
located to the right of the relevant snapshot.

Data Compliance Insights  Admin

< asouces  APPFS_cust_master

Overview Timeflow Access

N 2 months ago a
Jan 20, 2023

Snapshot
3:08 AM
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5.2.2.4 Access auditing

Users are able to audit what other users have access to a particular dSource, what access group they belong to, and
the associated permissions that each user has on that particular dSource.

(X) Data Compliance Insights  Admin e

¢ dgsouwces  APPFS_cust_master

Overview Timefiow Access
User Access Groups Permissions
1> o MANAGE TAGS o~ PROVISION o READ View >
John Smith
S, John Smith > o- MANAGE TAGS o~ PROVISION o READ View >

5.2.3 Managing VDBs

DCT provides the ability to view, search, sort, and filter all VDBs within a connected Delphix ecosystem. This page
can be found under the Data section and is used to find and act upon all VDB if they have the appropriate access.

Data Compliance Insights  Admin

dSources VDBs
An overview of VDB actoss your Delphix infrastructure.
VDBs
Search Search (Al) v
Bookmarks
Environments Status Name Type Engine Tags
RUNNING ApPFS_DEV Unstructured Files Test Engine Add Tags > View >
Infrastructure
UNKNOWN APPFS_MASK Unstructured Files Test Engine Add Tags > View >
VDB Config Templates
UNKNOWN AppFS_QA Unstructured Files Test Engine Add Tags > View >
UNKNOWN ApPFS_cust DEV Unstructured Files Test Engine Add Tags > View >
UNKNOWN APFS_cust MASK Unstructured Files Test Engine Add Tags > View >
UNKNOWN ApPFS_cust QA Unstructured Files Test Engine Add Tags > View >
UNKNOWN CDOMLOSR421FPDB1_93T Oracle bhavik-engine Add Tags > View >
RUNNING CDOMSHSR-GCGXEX-1679919625365 Oracle amaresh-engine1 Add Tags > View >

5.2.3.1 VDB overview

Individual VDB details can be seen and acted upon by clicking down on a particular VDB detailed view. Once clicked,
users will be sent to an "overview" tab that provides relevant metadata related to the VDB.
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Data Compliance Insights  Admin

< wss AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access

Platform Status

Unstructured Files

Details Tags Edit Environment Details

Type VDB Environment Name Postgres_Target
Platform Unstructured Files Type Single Instance
Version os Linux

Size 30.23MB

Engine Test Engine

5.2.3.2 VDB active timeline

Actionable snapshots are listed on the "active timeflow" tab - from this page, users can refresh, enable, disable,
start, stop, delete, and create bookmarks on the VDB. Navigate to the Continuous Data workflows section, then VDB
operations in the Ul, and see Active timeline Ul for more details.

Data Compliance Insights  Admin

< wss AppFS_DEV

Refresn
Overview Active Timeflow Timeflow History Bookmarks Access

Enable

Today Disable

Mar 27, 2023

Start
Snapshot
11:22 AM Stop

Delete

Create Bookmark

5.2.3.3 VDB timeline history

A chronological history of all non-active timelines (commonly referred to as timeflows) is shown under the
"Timeflow History" tab. From this page, developers can curate their QA or Development work by renaming
timeflows to match their testing history. Developers also have the ability to access old timeflow data by making a
particular timeflow "active". Navigate to the Continuous Data workflows section, then VDB operations in the Ul,
and see Timeline history UI3> for more details.

35 https://portal.document360.io/docs/timeline-history
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Data Compliance Insights  Admin

< wes AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access

Based on source data from:
Jan 20, 2023 3:05 AM

Test 1.0.1
' Jgan 20, 2023 3:06 AM

Active

Based on source data from:
May 4, 2022 4:30 PM

Test 1.0.2
May 4, 2022 4:32 PM

4 Make Active
N 5 months ago

Nov 10, 2022 £ Rename
Snapshot Dok
@ 3a7am
ayear ago o
¥ May4,2022

5.2.3.4 VDB bookmarks

Alist of all bookmarks generated on the selected VDB can be found under the "Bookmarks" tab. This page provides
a list of all bookmarks allowing for general organization and actions (developers can use bookmarks as a refresh or
provision point from the API).

Data Compliance Insights  Admin

< wss AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access
Bookmark Creation Date Tags Actions

Finance-App-1.0.3.2 Mar 27, 2023 11:21 AM View Tags (1) >

5.2.3.5 VDB access

Users are able to audit which users have access to this particular VDB, what access group they belong to, and the
associated permissions that each user has on that VDB. Admins are able to click on the "View" button to access
further details under the access control screen related to that specific user.

Compliance  Insights  Admin

¢ wus  AppFS_DEV

Overview At Timefiow Timeticrer History Bankmaris Aezens

1% - CREATE BOOKMARS o GREATE VDEGROUP iew >

Jatin Smith > o= CREATE_BOOKMARK o CHEATE_VDBGROUP iow >

5.2.3.6 VDB templates

Importing and removing imported VDB templates from connected engines is an available action from the VDB
Config Templates page.
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Home Data Compliance Insights Admin

dSources VDB Conflg Templates e
An overview of VDB Config Templates across your Delphix infrastructure.
Create Template
VDBs
Import Templates
Search
Bookmarks
Remove Imported Templates
Infrastructure Name 1 Template Type Notes
Sample Template Oracle Virtual Source View >
VDB Config Templates
dj0404 template 2- Oracle Virtual Source View >
dj0404 template- Oracle Virtual Source View >
Items per page: 50 ¥ 1-30f3 < >
Import templates

« Toimport a template, select the engines from the list in the import dialog.

Import VDB Config Templates

Source Engine

di0404-1, dj1104-stage

- - |

Remove imported templates

+ To remove a template, select the engines from the list in the remove dialog.
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Remove Imported VDB Config Templates

Source Engine:

dj0404-1, dj1104-stage

Cancel

5.2.4 Managing environments (Continuous Data)

5.2.4.1 Global environments list

DCT provides the ability to view, search, sort, and filter all Continuous Data environments within a connected
Delphix ecosystem. This page can be found under the Data section and is used to find and act upon all environment
connections.

Data Compliance Insights  Admin (2]

dSources Environments

An overview of environments across your Delphix infrastructure.

vDBs
Bookmarks Seareh Search (Al) v
Environments
Name 4 Hosts IP (Port) DBMS (Version) Contig Engine ID Tags
bhavik-src.dipxde.co Unstructured Files
Infrastructure bhavik-src bhavik-src.dipxdc.co Oracle (19.3.0.0.0) Standaions 2 LEEER View >
. bhavik-tgt. dipxdc.co Unstructured Files
bhavik-igt bhavik-tgt.dipxdc.co Oracle (19.3.0.0.0) Standaions 2 LEEER View >
VDB Config Templates
o O 796 thel-79--0agg-qar-74961-27a4593a.dcol1.delphix.com Oracle (12.1.0.2.0)
thel-79--0agg-qar-74961-27 a4593a.dcol1.delphix.com hel-72Gocp. . 74981 274503 ool delphit.cam e turad oy Standalone 1 AddTags > View >
thel-79--e3ub-qar-74961-27a4593a.dcol1.delphix.com Unstructured Files
hel-79--e3ub-qar-74961-27 24593a.dcol1.delphix.com el 7o eauo-car 74561 27ad56%8 deoll detphicom oracle 121000 Standaone 1 AddTags > View >
temsperpage: 50w 1-dof4 < >

5.2.4.2 Manage environments

Selecting a standalone environment in the Data page shows an ellipsis in the top right corner. When the button is
selected, the option to Enable/Disable, Refresh, or Delete the environment appears.
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Data Compliance Insights  Admin

< envionments  bhavik-src

Environment Users Listeners Delete

* oracle Actions -

Host Details Edit Host Tags Edit

5.2.4.3 Edit host details

Selecting a standalone environment in the Data page shows an Edit Host option; it is not yet available for cluster
environments. When the button is selected, the host details window will open, showing the input fields that can be
edited. Select 'Save' to confirm the changes and close the window.

Data Compliance Insights  Admin

< Environments win

Overview Access
Edit Host
Environment Users [ delphix.coni
os
Windows
* \delphix
Version
Windows Server 2019 Standard
Java Development Kit
None
Host Details Edit Host Timezone Edit
Amencallos_Angeles,PST-0800
Total RAM
Host Address 4.00GB S
-delphix.com Processor Type
AMDS4
os
Windows DSP KeyStore Alias
Version
Windows Server 2019 Standard ——
5P KeyStore Path
Java Development Kit
None
SP TrustStare P
Timezone
America/Los_Angeles,PST-0800
e [
Total RAM
4.00GB

5.2.5 Managing bookmarks

5.2.5.1 Global Bookmarks List

DCT provides a near real-time list of all bookmarks across all VDBs and VDB-groups and their associated VDB(s).
From the below screen, Delphix administrators can easily view and manage their bookmark estate.
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Data ‘Compliance Insights Admin

dSources Bookmarks

An overview of Bookmarks across your Delphix infrastructure.

VDBs
Search Search (All) v

Bookmarks
Environments Bookmark vDB Creation Date Tags

BM1 1-ORACLE_DB_CONTAINER-4 Mar 27, 2023 7:29 AM View Tags (1) >
Infrastructure

Finance-App-1.0.3.2 3-APPDATA_CONTAINER-276 Mar 27, 2023 11:21 AM View Tags (1) >
VDB Config Templates

5.2.6 Insights

5.2.6.1 Central governance insights

DCT provides global reporting of real-time statuses. This section will break down all of the reports in the "Insights"
Section. Note: all insight dashboards have the capability of "exporting" to a CSV or JSON format.

5.2.6.2 Global storage summary

This section gives a real-time perspective of block storage capacity on each connected engine as well as relevant
metadata such as capacity consumption percentage and object count.

Data Compliance Insights  Admin

Storage Summary Storage Summary
View a st of al your connected with thelr
VDB Inventory
dsource Inventory Search Search (Al) v Export v
Consumption Metrics Storage Summary

Name Host Used & Froo Total dSources voBs Total

30.93%

bhavik-engine bhavik-engine dipxdc.co cae) 15.05G8 21.80GB 5 2 7

7%

Test Engine wotxyeliphlkiwmhy7.ym.cld.s e 702768 75.56GB 8 25 £
17.84%
amaresh-engine1 ‘amaresh-engine1.dcol1.delphix.com 179168 21.80GB 3 2 5

3.89G8

5.2.6.3 VDB inventory report

This page gives a complete list of all VDBs along with relevant details.
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Data Compliance Insights

Storage Summary VDB Inventory

View alist of all your Delphix VDBs.
VDB Inventory

dSource Inventory Search Search (Al) v Export v
Consumption Metrics

Status o Greation Date Tpe Engine Parent

UNKNOWN ~ Mysal_ MASK Apr 22,2022 2:29 AM mysql-plugin Test Engine Mysql_master

UNKNOWN ~ MySQL DEV Apr 22, 2022 3:50 AM mysql-plugin Test Engine Mysql_MASK

UNKNOWN ~ Mysal_ QA Apr 22,2022 4:04 AM mysql-plugin Test Engine Mysql_MASK

UNKNOWN  Postgres_MASK May 4, 2022 3:33 PM postgres-vsdk Test Engine Postgres master

UNKNOWN  Postgres_DEV May 4, 2022 3:37 PM postgres-vsdk Test Engine Postgres MASK

UNKNOWN  Postgres QA May 4, 2022 3:39 PM postgres-vsdk Test Engine Postgres MASK

UNKNOWN  AppFS_MASK May 4, 2022 3:46 PM Unstructured Files Test Engine AppFS_master

5.2.6.4 dSource inventory report

This page gives a complete list of all dSources along with relevant details including VDB lineage count and storage
consumption sizing.

NG LA . . .
( / ) Data Compliance Insights  Admin

s TC

Storage Summary dSource |nVent0ry

View a list of all your Delphix dSources.
VDB Inventory

dSource Inventory Search Search (All) v Export v

‘Consumption Metrics

dSource P Dependent VDBs Data Source Size dSource Size Saved Space
AGDatabaseSQL2016 2 75.15MB 1.84MB 98%
AppFS_cust_master 3 7.15MB 5.20MB 27%
AppFS_master 3 30.23MB 17.33MB 43%
CDOMLOSR421FPDB1 1 751.21MB 238.06MB 68%
CDOMLOSR421FPDB1 1 761.69MB 241.16MB 68%
CDOMLOSR421FPDB1-test 0 756.64MB 219.42MB 1%

5.2.6.5 Consumption Metrics

This page gives a complete list of all unvirtualized source sizing. This is a critical report for customers using the per
TB pricing model.
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Compliance Insights Admin

Storage Summary Consumption Metrics

An overview of current data source consumption metrics.
VDB Inventory

dSource Inventory Search Search (All) v Export v

Consumption Metrics

Status dSource 1 Platform Engine Last Updated Consumption
UNKNOWN AGDatabaseSQL2016 MSSql amit-engine Mar 27,2023 11:00 PM  16.00MB
UNKNOWN AppFS_cust_master Unstructured Files Test Engine Mar 27, 2023 10:56 PM  0.00B
UNKNOWN AppFS_master Unstructured Files Test Engine Mar 27, 2023 10:56 PM  0.00B
UNKNOWN CDOMLOSR421FPDB1 Oracle bhavik-engine Mar 27,2023 11:00 PM  757.94MB
UNKNOWN CDOMLOSR421FPDB1 Oracle amit-engine Mar 27, 2023 11:00 PM  758.38MB
UNKNOWN CDOMLOSR421FPDB1-test Oracle amit-engine Mar 27, 2023 11:00 PM  753.38MB
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6 Continuous Data workflows

6.1 DevOps TDM

DCT delivers all of the Continuous Data and developer operations necessary to power DevOps and Test Data
Management use-cases. This includes a suite of APIs to drive automation.

DEV Environment

Provision

Refresh Test Environment

Bookmark

Rewind

Teardown

Share QA Environment

-

_—
'--.

~~

Branch

200000006

Integrate
Unified

AP| Gateway and
Central

Management

Using the above APIs, DCT can seamlessly integrate Delphix data into DevOps pipelines by providing a single point
of integration for a broad Delphix deployment.
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Production Data

Source Incremental Incremental Incremental
Dataset Snapshot Snapshot Snapshot

Dev/Test/QA Environment

Compliant Sync Sync
Dataset Update Update
Data Bookmark
G e Collaboration between
ad DeviTest/QA
Build Trigger
Rewind Post-Run
CI/ICD APIs Bookmark Bookmarks
e Link ephemeral test environment Test 1 @
s Provision test data

e Rewind test data Test 2
& Bookmark after failed test

e Share bookmark data

e Teardown test infrastructure

X @&
X @

Test 3

ONON®)

6.2 Developer experience

In addition to automation use cases, DCT provides the APIs and Ul to power developer access to Delphix data and
common Delphix operations. This section will detail all of the major capabilities that make up this revamped
Delphix developer experience.

6.3 Self-service vs. DCT developer experience

Data Control Tower now provides a central experience for developers. Whether a developer prefers to leverage
Delphix via API, integration, or Ul, DCT delivers the ability to quickly access data from any connected Delphix
engine, and the common capabilities to drive application development and testing.

Previously, Delphix offered a local addon application called Self-Service (or Jet Stream) that was attached to
applicable data engines. Self-Service provided an interface to access pre-provisioned datasets encapsulated in
"Self-Service containers", which would be made available by admin configuration.

Data Control Tower has taken the most common operations and use-cases, and has made this experience
accessible to developers via API, integration, and Ul. This article will describe the key use-case and operational
overlap, as well as the differences between the local engine Self-Service experience and DCT's developer
experience.

6.3.1 Key similarities

1. Developer access to Delphix Data
The DCT developer experience is geared toward driving access to data, with all of the same time-based
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operations to enable application development and testing. Operations (accessible via the API, integration,
or Ul) include refresh, rewind, start/stop, enable/disable, bookmark, bookmark share, and timeflow
visibility/access.

Developer timeflow history

A common Ul benefit in Self-Service is the ability to visualize past timeflows (see Timeline history(see page 127)
for more detail), which acts like a testing record. Every time a developer runs a test and rewinds/refreshes,
that past test results are stored in Delphix as a timeflow. DCT has both APl and Ul instrumentation to make
the visualization and curation of timeflows incredibly simple.

Data-as-Code

Developers can use DCT bookmarks to reference a point in time on a VDB (or group of VDBs) with a
developer-set retention period and human-readable name. This is valuable for development teams as they
evolve application code. Whenever a code change necessitates a new database schema, a developer can
bookmark a VDB that is formatted to work with that particular code branch. This empowers development
teams to always have access to a viable test data set for any and code branches of an application.

6.3.2 Key differences

1.

DCT delivers a central interface powered by its converged architecture

This means that developers have a single location to log into in order to access and manipulate their virtual
data sets.

User experience

The DCT developer experience Ul has completely been reworked to make developer access to Delphix data
easy and intuitive. This experience shows itself in three Ul tabs, Active Timeline, Timeline History, and
Bookmarks, that are located in each VDB's detail menu. This experience is meant to be used by all Delphix
users (admins and developers, especially) and will be tailored to the individual based on the DCT Access
Control system.

No template/container model

Previously, engine administrators needed to create templates encapsulating one or more related VDBs and
provision new VDBs into a developer-accessible container. This model required manual administration that
created bottlenecks for data access, which was especially prohibitive for automation use-cases. The benefit
of this model was two-fold: first, containers represented a miniature sandbox for developers (using a Self-
Service user role) and second, bulk operations could be performed on all container-grouped VDBs while
maintaining referential synchronicity, a valuable attribute for integration testing.

DCT Access Control replaces the developer sandbox enabled by Self-Service containers

Developers simply log into DCT and can view and act upon data that they are entitled to access with
operations tightly bounded by their defined role. DCT's Access Control system has the ability to automate
both user membership of access groups and entitlement access via attribute-defined scoped roles. In
addition, roles can be customized in DCT such that granular permissions can be extended and restricted
down to both access group and user levels.

DCT VDB Groups replace the Self-Service container grouping mechanism

Currently only available via API, VDB groups enable the association of one or more VDBs for bulk operations
while maintaining referential synchronicity.

Time operations consolidation

The developer experience Ul consolidates the many time-based operations across Continuous Data and Self-
Service (e.g. refresh, rewind, rollback, restore, reset, etc.) into a single operation; refresh. From the DCT Ul,
clicking refresh will take users to a contextualized screen that simplifies time operations by focusing on what
timeline (and what time) the user would like to align to (parent, self, or relative).

No "branching"

Branching in Self-Service introduced the notion of task-specific timelines, each with its own associated sets
of timeflows. This was a concept that was heavily tied to the "template/container" model and is obviated by
the DCT Access Control system that can enable gated provisioning access to a developer. If a new timeline is
needed for a separate task, you can provision a new VDB.

Continuous Data workflows - 115



Data Control Tower - Data Control Tower Home

DCT has a Delphix-supported integration with ServiceNow, which is commonly used as a developer
resource-request tool. Users can build custom developer-centric workflows with any operation currently
instrumented through the DCT API layer.

6.4 Creating and managing bookmarks

6.4.1 Create new Bookmark

Bookmarks are a critical developer tool that enables the creation of a namable time reference to a snapshot of a
VDB or VDB group. Bookmarks for single VDBs can be created from the DCT Ul by selecting a VDB and expanding
into its detailed view. From the Active Timeline view, users can select the ellipsis in the top right corner and
"Create Bookmark".

Data Compliance Insights  Admin

< VDBs AppFS_DEV

Qverview Active Timeflow Timeflow History Bookmarks Access

R Today

Mar 27, 2023

Snapshot

B 4122 AM Siop

2 months ago
¥ Jan 20,2023

Selecting the "Create Bookmark" button will open a window that enables bookmark naming, setting the custom
retention period for that bookmark, and assigning any relevant tags. Creating bookmarks this way will initiate a
new snapshot operation that will then be associated with that bookmark.
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Create Bookmark b4

Bookmark Narme

Finance-App-1.0.3.2

[C] Retention - Keep Forever

Select Retention Date

6/30/2023, 11:03:55 AM E

| AppTeam: Alpha # Remove

Enter Tag Key Enter Tag Value + Tag

Cancel Create Bookmark

Bookmarks relating to a specific VDB can be found under the bookmarks tab in a VDBs details page. This provides a
curated list of actionable snapshots that represent anything from a relevant test result to a transformed set of
schema that can be associated with a specific branch of code.

Data Compliance Insights  Admin

< voss AppFS_DEV

Overview Active Timeflow Timeflow History Bookmarks Access

Bookmark Creation Date Tags Actions

Finance-App-1.0.3.2 Mar 27, 2023 11:21 AM View Tags (1) >

6.4.2 Bookmark APl Documentation

Some advanced bookmark operations are only available via API at present, formal documentation can be found via
DCT's swagger docs or the Developer resources section. This portion of the bookmarks documentation will discuss

examples of advanced use-cases.
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6.4.3 Create a Bookmark at the current time for multiple VDBs

In cases such as integration testing, bundling multiple VDBs together to represent a complete set of data that a
complex application would run on is helpful. This APl example shows how a single bookmark reference can be
created off of multiple VDBs, to provide a provision point for new testing sets or the creation of a VDB Group that
can be used to maintain referential synchronicity from that bookmark point.

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v3/bookmarks"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \

-d |{
"name": "MyBookmarkl",
"vdb_ids": [

"1-ORACLE_DB_CONTAINER-2",
""2-ORACLE_DB_CONTAINER-2"

} 1

These API calls will return a DCT job to track the creation process. This job ID can then be used to poll the
status via the jobs API. Example response:

{
"bookmark": {
"id": "9e8c7223flaf4694al9ac2c2f7696eda",
"name": "MyBookmarkl",
"creation_date": "2023-03-27T20:56:13.916857Z2",
"vdb_1ids": [
"1-ORACLE_DB_CONTAINER-2",
""2-ORACLE_DB_CONTAINER-2"
1,
"retention": 30,
"expiration": "2023-04-26"
3,
Hjobll: {
"id": "8fe825f5635d45299915c3ch88a17623",
"status": "PENDING",
"type": "BOOKMARK_CREATE",
"target_id": "9e8c7223flaf4694al9ac2c2f7696eda",
"start_time": "2023-03-27T20:56:14.363549Z2"
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6.4.4 Create a Bookmark for a VDB from an existing Snapshot

DCT Bookmarks (as of the 6.0 release) can create bookmarks from existing snapshots. This is particularly useful for
users looking to migrate Self-Service bookmarks to DCT or any developer looking to retroactively create a
bookmark reference.

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v3/bookmarks"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"name": '"MyBookmark2",
"snapshot_ids": [

"1-ORACLE_SNAPSHOT-11"

]

}l

6.4.5 Create a Bookmark for a VDB from an existing Snapshot
Starting in version 7.0, the Ul has an option to create bookmarks from the existing snapshots.

On the VDB detail page, under the Active Timeline tab for each snapshot, a Create Bookmark action is available.
This opens a dialogue that shows a list of inputs for the user to select from, to create a bookmark.

Once the user clicks Create Bookmark in the dialogue, the bookmark will be created for that particular snapshot (if
all the mandatory fields are completed), else errors will be shown.

Data Compliance Insights Admin

< voss JK-VDB-1

Overview Active Timeline Timeline History Bookmarks Access

Mar 22, 2023

4 days ago
Mar 21, 2023

5 days ago

Mar 20, 2023

6 days ago
Mar 19, 2023

<

Snapshot

a 4:01 PM

C Refresh
7 days ago
v £

Mar 18, 2023 = Relention

8 days ago n@ Create Bookmark
Mar 17, 2023
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6.5 VDB operations

The developer experience will continue to see investment and additional capabilities over the next few
releases.

The VDB operations Ul serves as an actionable command center for admins and developers. With this Ul, users can
migrate from using the local engine Ul to leveraging DCT to do their daily VDB-related work. This encompasses both
continuous data as well as any developers leveraging Delphix Self Service. The core benefit of this Ul experience is
the breadth of access coupled with DCT's access control system. Using both together, a user can access and act
upon any data on any connected engine within the boundaries of the entitlement and permissions set by the
admin-driven access control system.

Home Data Compliance Insights Admin admin e

An overview of VDBs across your Delphix infrastructure.

VDBs

Search Search (All) v
Bookmarks
Infrastructure Status Name 1 Type Engine Tags
RUNNING Vdbd_9MO Oracle Ul Trunk Add Tags > View >
VDB Config Templates
RUNNING dbdhcp3_CRW Oracle Ul Trunk View tags (1) > View >

Items per page: 50 1-20f2

To access the VDB operations Ul, users only need to log into DCT and select the detailed view of any particular VDB.

g Users will only be able to see VDBs if they have been granted access via the Access Control system.
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VDB Permissions

‘D Create ‘9 Update
‘D Delete f View
f Refresh P Rewind
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From there, users can perform common operations such as refresh, rewind, and bookmark using the Active
Timeline tab. Developers have additional functionality with the Timeline History tab that exposes non-active
timelines (also known as timeflows).

6.5.1 VDB provision Ul

Users can provision VDBs from the DCT Ul using the Provision VDB button located under the action button on a VDB
details page. The following DBMS types and configurations are supported:

+ Oracle Single Instance
+ Oracle Multitenant (linked CDBs only)
« MSSQL Single Instance

Extending the developer experience capabilities in DCT, users can now provision MSSQL single instance databases
or Oracle single instance multi-tenant databases with linked CDB data platforms from the user interface, using an
intuitive wizard workflow. Located on the VDB page is a Provision VDB button that opens the provisioning wizard.
(Note: non admin users will only be able to see provisionable sources (dsources and/or VDBs), environments, and
engines to which they are authorized to see and act upon).

The provisioning wizard will walk through the following steps:

+ Source: search and select either a dSource or VDB to provision from.

« Provision Point: three options for a provision point, similar to a refresh point.
+ Aselected snapshot
« A specific timestamp (closest snapshot to the timestamp)
+ Alocation ID/number (closest snapshot to the location number)

+ Target Environment: shows compatible environments with compatible repositories, and can optionally
provide privileged credentials.

« Target Configuration: should be prefilled with default configurations. One thing to note here are the tags
which are additive when “Include Tags from Parent” is checked, and you wouldn’t immediately see the tags
from the parent in the editor. Tags are added when the Include Tags from Parent box is checked, you
would not immediately see them from the parent in the editor.

+ Users can also select the engine group and register listeners by expanding the advanced section
below. In DCT, it is recommended to use tags instead of engine groups.
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« Policies: choose a snapshot policy.
« Summary: review the selections that have been made.

The below example walks through a provisioning workflow for an Oracle 11.2 Multitenant VDB (Note: TDE and Auto
VDB restart are supported only for Oracle version 12.2 or higher).

Provision VDB X

Source
® Source

Select an available Source or VDB from which to provision to your VDB.

Provision Point

d VDB: o
Sources s dbdhcp3 Details
Target Environment Name
Search dbdhcp3
Version
Target Configuration Oracle 11.2.0.2.0

dbdhcp3 Environment

Policies Sre Env

1-10f1

Summal
v ltems per page: 25 Y

cancel m

6.5.2 VDB refresh Ul

6.5.2.1 Overview
The VDB refresh wizard in the Data Control Tower Ul offers important engine refresh operations like:

« Self-refresh by snapshot, timestamp, or location
+ Refreshes a VDB back to a point in its own history.
+ Refresh to parent by snapshot, timestamp, or location
« Datais pulled from the VDB provision parent (the dSource or VDB from which the VDB was
provisioned).
+ Refresh to relative by snapshot, timestamp, or location
« Allows selection of data from either the origin dSource of the VDB (which could be the immediate
parent, or parent of parent, etc.) or any VDB sharing the same origin dSource (which could be parent,
child, sibling, or similar relationship).
+ Refresh to bookmark snapshot
+ Refreshes a VDB to a compatible bookmarked snapshot.

In order to refresh from a dSource or VDB, the account performing the action must have the REFRESH
permission on both the VDB being refreshed and the dSource (or VDB) from which the data is being
refreshed.
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6.5.2.2 Userinterface

The self-refresh by snapshot operation can be initiated as an action from the VDB's own active timeline or
timeline history view, using the action menu for snapshots.

< VDBs VDB
ID:
Overview Active Timeline Timeline History Bookmarks Access
Confirm Refresh X
a month ago
Feb 13. 2023 Are you sure you want to refresh to this snapshot? °
napshot
@ )
10:51 AM
' Refresh
2 months ago
v Jan 8. 2023 [=] Retention
6 months ago o
v Sep 20, 2022
3 years ago °
Y Sep 19,2019

All three refresh types can be performed by opening the refresh wizard on the VDB details page. In the first step,
select the refresh source:

Refresh " " X

Select Refresh Source
®  Select Refresh Source

Select the source of the data refresh.

Hetresn Pant Parent Self Relative
Set the data state of this VDB to any available point from Set the data state of this VDB to any available point Set the data state of this VDB to any available point from any
the parent. on this VDB relative VDB

Summary

Next, select the snapshot or point in time to refresh to:
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« For self-refresh, a timeflow from the VDB’s own history must be selected, and then a snapshot within the

selected timeflow.

« For parent refresh, a timeflow from the VDB’s provision parent’s history must be selected, and then a
snapshot within the selected timeflow.

« Forrelative refresh, first a relative dSource or VDB must be selected, then a timeflow, then a snapshot.

For all three refresh types, review the summary page once configurations are complete, then click submit:

Summary

Review the following to confirm your action to refresh VDB "Vdbd_3LT" from the selected source.

This action will create a new timeline
This action will be non-destructive since the existing state will be preserved as an alternate timeline that can be found in Timeline History on the VDB.

Source of Data
VDB2SZ

> Selected VDB

Data Point
Vdbd_3LT

Snapshot 201

Origin DSource Time
Jul 24, 2019 3:00 PM

Refreshing happens asynchronously and takes a various amount of time. The DCT Ul does not currently
show asynchronous job progress or errors, please refer to the engine Ul for this function.

Refresh to Bookmark

Bookmark is available as a Select Refresh Source option in the refresh wizard, which allows you to refresh from
compatible bookmarks. Choose a bookmark from the list and click Next.
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Refresh "VVdb_MIK" X

®  Select Refresh Source Select Refresh Source

Select the source of the data refresh.

Select Bookmark Parent Relative
Set the data state of this VDB to Self Set the data state of this VDB to Poolrark
" . Set the data state of this VDB to . Set the data state of this VDB to
any available point from the any available point from any

parent. any available point on this VDB. relative VDB.

any compatible bookmark.

Summary

Cancel m

Select Refresh Source Select Bookmark

Select a bookmark for data refresh.

® Select Bookmark

Search Search (All) v
Summary
Bookmark Creation Date Tags
my-bookmark-1 Apr 25,2023 4:33 PM Add Tags >
my-bookmark-2 Apr 25,2023 4:34 PM Add Tags >
1to20f2 < < Pagelof1 > >l

Cancel Back m

You can also refresh from a particular bookmark under the VDB details page, via the Bookmarks tab. Choose a
bookmark from the list as the one to refresh from, then click the Actions menu and select Refresh to Bookmark.

Data Compliance Insights

<wes  VVdb_MIK

ID:

Overview Active Timeflow Timeflow History Bookmarks Access
Bookmark Creation Date Tags Actions
my-bookmark-1 Apr 25,2023 4:33 PM Add Tags > Actions :
my-bookmark-2 Apr 25,2023 4:34 PM Add Tags > Refresh to Bookmark

Update Bookmark

Delete

1t020f2 < < Pagelofl
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6.5.3 Active timelines Ul

6.5.3.1 Active Timeline View

Active Timeline can be found by selecting “details” for any VDB located on the VDB list page in DCT and selecting
the “Active Timeline” tab. This view serves as an operations console for any user with the appropriate entitlements
to see and act upon the identified VDB granted by the DCT access control system.

This view shows a vertical timeline-based representation of all actionable points of interest (snapshots) for that
VDB. The snapshot list is chronologically grouped over blocks of time to easily identify relevant snapshots to act
upon. Once the right snapshot is found, users can access a contextualized action menu by selecting the
corresponding ellipsis to the relevant snapshot.

& Contextual snapshot menu: By selecting the ellipsis next to the VDB of interest, users can refresh to a
snapshot or create a bookmark (a nameable and shareable snapshot reference.

Data Compliance Insights  Admin

< was CDOMLOSR421FPDB1_93T

Overview Active Timefiow Timeflow History Bookmarks

5 days ago
Mar 22, 2023 o
Snapshot
G 500pm
CF n
6 days ago
v Mar 21, 2023
7 days ago o

Mar 20, 2023

Alternatively, users can perform common Continuous Data actions via the ellipsis in the top right of the Active
Timeline screen. This menu will offer VDB-wide, generalized operations including:

+ Refresh: This is a generalized operation to realign your VDB's timeline with another. More information can
be found in the Refresh a VDB(see page 122) article.

«+ Start/Stop: A way to manage target host bandwidth.

« Enable/Disable: An administrative operation required for upgrades/migrations.

« Create Bookmark: Create a special reference to a snapshot that has a custom name and retention period.

Data Compliance Insights  Admin

< wss  CDOMLOSR421FPDB1_93T

Ovarview Active Timefiow Timetiow History Bookmarks Access

_ 5daysago
Mar 22, 2023

B 300pm cp

6 days ago
v -

Mar 21, 2023
reie Baokmark

. 7 days agn o

Mar 20, 2023
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6.5.3.2 Additional notes

+ Refresh using the DCT Ul
Data Control Tower has consolidated all contextualized time-based operations (e.g. refresh, rewind,
rollback, restore, reset, etc.) across Continuous Data and Developer products into a general "Refresh". By
clicking refresh, users will be prompted on what timeline they would like to align: Parent, Self, or Relative.
From there, users will be taken to a wizard that will give relevant timeline options and points in time to
perform the refresh.

« Start/Stop
Starting and Stopping are geared toward bandwidth management in a target environment. Stopping a VDB
will place it in stasis such that it can't be accessed, but also won't consume bandwidth. Starting it back up
will re-enable it for regular activity.

« Enable/Disable
Enabling and Disabling are geared toward administrative operations such as VDB migration or upgrade.
Disabling a VDB removes all traces of it, including any configuration files, from the target environment to
which it was provisioned. Re-enabling the VDB will restore those configuration files.

+ Create Bookmark
Bookmarks serve as a human-referenceable representation of time that can work for a single VDBs or VDB
groups. Bookmarks also have the capability to be shared (Refresh to relative in the Refreshing a VDB(see
page 122) article). From the top level menu, users will be able to name the reference and set a unique
retention period.
Bookmarks do not appear in the Active Timeline, to access existing bookmarks, users will have to navigate to
the "Bookmarks" tab on the VDB detail view.

6.5.4 Timeline history Ul

6.5.4.1 Timeline History view

The timeline history view can be found by selecting “details” for any VDB located on the VDB list page in DCT and
selecting the “Timeline History” tab. This view serves as a developer-centric console that shows the complete
history of a VDB including non-active timelines, which is a critical resource for developers as these can contain
information like past test results. Using this page, developers can curate and access the complete chronology of
their testing efforts with operations such as renaming individual timeflows, make active, refresh to snapshot, and
create bookmark to drive organization and access.

6.5.4.2 The Timeline History user interface

If entitled via the DCT Access Control system, developers can see and act upon VDBs in the VDB list view using the
timeline history tab under "details". The timeline history Ul is comprised of a vertical timeline-based representation
of all actionable points of interest (snapshots) for that VDB. The snapshot list is chronologically grouped over blocks
of time to easily identify relevant snapshots to act upon. Once the right snapshot is found, users can access a
contextualized action menu by selecting the corresponding ellipsis to the relevant snapshot.
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< vos V

Qverview Active Timeline Timeline History Bookmarks Access

Based on source data from:
Mar 12, 2023 3:31 AM

DB_ROLLBACK
Mar 20, 2023 3:30 AM

. Timeflow-1 Active
Mar 12, 2023 3:31 AM

“ Today
Mar 23, 2023

Snapshot
3:30 AM

2 days ago
Mar 22, 2023

3 days ago
Mar 21,2023

4 days ago
Mar 20, 2023

5 days ago
Mar 19, 2023

6 days ago
Mar 18, 2023

7 days ago
Mar 17, 2023

ltems per page: 50 ¥ -20f2

6.5.4.3 Non-active timelines

Non-active timelines (often referred to as “timeflows” in Self-Service) are a critical aspect of how Delphix
Virtualization works and an important Developer Tool. Whenever a time-based operation takes place, the previous
timeline (and associated data) becomes non-active and a fresh timeline takes its place.
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VDB 1

i Snapshot A Snapshot B E
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() Non-active timeline creation from "Self-Refresh"
In this scenario, a developer has performed a “self-refresh” (formerly referred to as a “rewind” or
“rollback”). In refreshing Snapshot B, the developer has created a new active timeline that represents a
clean slate starting with the data state of Snapshot B. If the developer wants to refer back to the past
results that are represented on the non-active Timeline, he or she can activate the past timeline by hitting
the “Make Active” button in the DCT User Interface or by refreshing to a point in time by referencing the
non-active Timeline’s ID.

For developers, having the ability to catalog (name and tag) and reference past timelines is a critical aspect of
application development such as performing ad hoc code validation or manual testing. The timeline history Ul in
DCT provides a home for single VDB visibility of all accessible timelines (note: timeline availability is controlled
through capacity management and snapshot retention policies).

6.5.4.4 Time concepts within the Timeline History Tab

DCT’s new user interface highlights different notions of time within Delphix (e.g. dSource, VDB, and VDB lineages)
and how they relate to one another. These time-based relationships are exposed in the Timeline History view to
drive accurate testing for developers.

The “Based on dSource time” designation helps to drive awareness of the relationship between a VDB and its
dSource provision point (in most cases this will equate to the production database’s state at that time), which is
helpful for use cases such as capturing data from a meaningful event. As a VDB refreshes to newer snapshots on a
dSource, those changes of data state are grouped separately on the Timeline History view as they represent
completely different data.

6.5.4.5 Timeflow operations

“Make Active”, a developer can reference any past timeflows and data represented therein by making a timeflow
“Active”. This can be done by simply clicking on the timeflow of interest and selecting “Make Active”.
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VDB 1
i Snapshot A Snapshot B E
: . . Active Timeline :
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; Snapshot B Snapshat C i
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VDE 1 l Make the Non Active Timeline, “Active”
i Snapshot B i
| o oy
i Snapshot A Snapshot B Snapshot C E
! . . Active Timeline ;
Refresh to snapshot

Included within each timeflow are snapshots that can be accessed via a dropdown menu under each timeflow. If
given the right permission, a developer can refresh the VDB to that snapshot. While this may seem similar to “Make
Active”, there are major underlying differences as a “Refresh” will reprovision the VDB based on that point in time,
whereas, “Make Active” simply changes the reference to different blocks of the underlying storage.

VDB 1

i Snapshot A Snapshot B i
: . Active Timeline '
i Snapshot B Snapshot C E
i WO i ¥ E
OB 1 1 Refresh to Snapshot “C” on Non Active Timeline

Snapshot B Snapshot C

Snapshot C ACTIVERlIMTENTE

Create bookmark

On a snapshot will enable developers to convert that snapshot into a DCT Bookmark (see page 109)that enables
developers to assign a name and special retention policy to that time reference. This also enables stronger
collaboration between developers as bookmark references can be used for a sibling refresh operation.
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Rename timeflow

Developers can curate time flows to correspond to tests such that they can easily reference results data. This action
can be performed by clicking the ellipsis on the time flow to reach a drop-down menu. This menu includes the
option to "rename" which will open a dialog box to input a new name. The input is prefilled with the current
Timeflow name by default. Saving the dialog kicks off a job to rename the timeflow. The changes may take a short
time to be reflected in the Ul.

Rename Timeflow

[ DB_PROVISION@2023-03-20T16:23:31

Delete timeflow

Developers have the option to delete time flows via the Ul by selecting the ellipsis next to the corresponding time
flow and selecting "delete". When clicked, this opens a confirmation dialog asking if the user wishes to delete the
timeflow. If the dialog is confirmed, a job is kicked off to delete the timeflow. Note: This menu item is disabled for
the currently-active timeflow.

A~ Test1.0.2
May 4, 2022 4:32 PM
4 Make Active

. 5 months ago

Nov 10, 2022 2. Rename

@ Snapshot W Delete
3:37 AM

a year ago 0

Y May 4, 2022

6.5.4.6 APl documentation

While the DCT Ul provides a visual aspect to timeflow chronology and grouping, the DCT API has all of the necessary
instrumentation to integrate these concepts into automation. The formal documentation can be found via DCT's
swagger docs or the developer resources documentation section. This portion of the timeflow documentation will
provide some general examples:

Get a list of a VDB's timeflows

This simple call will enable the listing of the entire timeflow roster underneath a VDB enabling a developer to take
inventory and action.

curl =X 'POST' \
'"https://<APPLIANCE_ADDRESS>/v3/timeflows/search?limit=50&sort=1id"' \
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-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

-d l{

"filter_expression": "dataset_id eq '\''1-ORACLE_DB_CONTAINER-2'\'""
}l

The UPDATE timeflow API can be used to change a timeflow's name

Once the appropriate timeflow is found, developers can rename the timeflow to align with a naming scheme or
other relevant designations such as a compatible code branch.

curl =X '"PATCH' \
'"https://<APPLIANCE_ADDRESS>/v3/timeflows/1-ORACLE_TIMEFLOW-7"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"name": "Latest on refresh state"

} '

List all the snapshots for a timeflow

Developers can then use the snapshot API to find all relevant "actionable" points in time on the identified timeflow.
The below example shows how to only expose snapshots on a particular timeflow. From there, developers can feed
the relevant snapshot ID into refresh or provision endpoints or create a bookmark reference from that snapshot.

curl -X 'POST' \
"https://<APPLIANCE_ADDRESS>/v3/snapshots/search?limit=50&sort=1d"' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"filter_expression": "timeflow_id eq '\''1-ORACLE_TIMEFLOW-7"'\"'""

}l
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7 Continuous Compliance workflows

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

With the ability to distribute and run jobs, DCT enables advanced Compliance Engine architectures to be
orchestrated and monitored using DCT’s real-time, persistent relationships with connected Compliance Engines.
When syncing a Compliance Engine, DCT will create references for all Compliance jobs on that Engine. These will
show up as unique objects tracked by DCT that can now be leveraged with job move APIs.

7.1 Listing and searching compliance jobs

When a Compliance Engine is registered with DCT, compliance jobs (referred to as MaskingJobs within the DCT API)
on the Engine are automatically ingested and presented as DCT MaskingJob objects.

Example of listing all MaskingJobs:

curl -X '"GET' \
'https://<APPLIANCE_ADDRESS>/v3/masking-jobs' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>'

Example of searching for OnTheFly MaskingJobs:

curl =X 'POST' \
"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/search' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
_d l{
"filter_expression": "is_on_the_fly_masking eq true"

} 1

With the new job move APIs, DCT can now be used to power two advanced masking reference architectures®:
Software Development Lifecycle (SDLC) and Horizontal Scale architectures. SDLC enables the separation of
duties for the development, quality assurance, and production use of masking jobs whereas Horizontal Scale
enables the use of a central configuration engine with the movement of jobs to headless compute engines.

To enable these architectures, DCT has introduced three new operations: Job Copy, Job Execute, and Job Migrate:

« Copy: Supports SDLC by copying a job, but maintaining separate references in DCT.

+ Execute: Supports Horizontal Scale by copying a job, but maintaining the same reference between two
copies. DCT will also keep both of these copies in sync.

+ Migrate: Supports the movement of a single instance from one engine to another.

36 https://documentation.delphix.com/continuous-compliance/docs/working-with-multiple-masking-engines
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7.2 Consolidated operations (intelligent syncing)

DCT has simplified the set of operations required to move a job and its dependencies. Previously, orchestrating
movement of jobs required three separate API calls: Job Sync, Global Object Sync, and Credentials Update (on the
newly created job). DCT has now consolidated all three of these operations into each of the job move APIs. In
addition, if two jobs are held in sync (see Job Execute(see page 143)), DCT will auto update synced jobs whenever one
of those jobs has been modified (i.e. updated rule set, new algorithms, etc.).

B In order to transfer connector credentials with a job as part of the job move, you will need to associate
those credentials using the connector credentials API. See sample code below on how to update

credentials.

Example of updating a MaskingJob with connector credentials:

curl =X 'PATCH' \

'https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead'

\

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H '"Content-Type: application/json'

_d l{
""connector_username": "userl23",
"connector_password": "passwordl23"

} '

7.3 Managing engines (Continuous Compliance)

DCT provides a near real-time list of all connected Continuous Compliance engines and lists them in an aggregate
view. From the below screen, Delphix administrators can easily view and manage their engine connections.

Data Compliance Insights  Admin

Compliance Engines Compliance EngineS
Overview of all compliance engines in your Delphix ecosystem.
Compliance Jobs

Search

Status Name/UUID 4 Type Running Jobs
Masking
9 o

» Online Test Engine 2 9.0.0.0

Masking

» Online Test Masking 9.0.0.0

Connect Engine

Search (All) v
Masking Usage/Total Masking Available Cores Tags
0% _ :
2.00GB 4 View tags (1) > View >
9
o 4 Add Tags > View >

2.00GB

From this screen, administrators can manage engine connects via the “Connect Engine” button on the top right
corner. By clicking this button, the below window will appear asking for connection details.
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DCT will access the engine as a registered user and, as detailed in the Deployment section, requires both
a username and password as well as admin-level access to the engine. For compliance engines, select
"Masking" type when registering an engine.

Connect Engine X

®  Engine Details Engine Details

Name.

R Test Engine 2
Authentication

Hostname

Security uvoltz4micpf5ex4dbg.vm.cld.sr
Tags Choose Engine Type

O Virtualization
Summary

@ Masking

7.3.1 Engine overview

Individual engine details can be seen and acted upon by clicking down on a particular engine detailed view. Once
clicked, users will be sent to an "overview" tab that provides relevant metadata related to the engine.

Data Compliance Insights Admin

< Compliance Engines Test Engine 2

Overview Access

Current Memory Usage
Number of Running Jobs

0 0% 0.00B of 2.00GB
Details Tags Edit
Type
Compliance Engine Data Center: West Coast

Version
9.0.0.0

7.3.2 Engine-based operations access

Users are able to audit which users have access to this particular engine, what access group they belong to, and the
associated permissions that each user has on this engine. Admins are able to click on the "View" button to access
further details under the access control screen related to that specific user.
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Data Compliance Insights  Admin

Engines

A

Compliance Engines TeSt Engine 2

Ow Create Ow Create Environment

Ow Delete  Ow ManageTags ~ Ow Read

johnsmith @company.com

Overview Access
Ow Set Tags at Object Creation ~ Ow Update
User Access Groups Permissions
13 o- CREATE_ENVIRONMENT o~ DELETE View >
John Smith B
John Smith > o= CREATE_ENVIRONMENT o= DELETE View >

7.4 Compliance jobs

7.4.1 Job Ul

7.4.1.1 Global compliance jobs list

When connected to a Continuous Compliance engine, DCT will sync and create references to every compliance job
on the engine. All of those job references can be found in the global compliance list, which is a taggable, filterable,
sortable, and searchable list of all compliance jobs across a connected Delphix ecosystem.

Data Compliance Insights  Admin

Compliance Engines COmplianCe Jobs

Compliance jobs are the configurations that enable you to mask data on your data sources.
Compliance Jobs

Search Search (All) v

Name/ID 1

Drupal 9 Custom App Masking

020e35d2-7d60-482¢-908b-7825¢89ed3e7 View >
Drupal 9 Custom App Masking Vi N
08edd39c-bbe2-4296-9e10-ac255fdc8722 rew
M1-sCRM-Dev View >
473b6938-106a-4969-bc53-d756{33845fa
M1-sCRM-Dev View >
4ed7691e-cab8-48aa-al4a-62339d9a0534 bl
Mask anagrafe View >
36bfd517-30d0-400f-b950-50a8985426eb ©
Mask f

lask anagrafe View >

bbfd11e9-3cc9-4998-bc40-a624f0a15241

7.4.1.2 Compliance job overview

Individual compliance job details can be seen and acted upon by clicking down on a particular compliance job
detailed view. Once clicked, users will be sent to an "overview" tab that provides relevant metadata related to the
VDB.
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Compliance  Insights

¢ complance Jobs  Drupal 9 Custom App Masking

Overview Access Histary

Job Status : SUCCEEDED Run Time : 22sacs
Started at 3:09 AM

Initializing

Gollecting Gonfigurations

Preparing

>

Running Pra-exesution Gustom Driver Tasks
Starting

¥

Running PreSQL Scripts

»

Running PostSQL Scripts

»

Running Post-execution Customn Driver Tasks
Collecting Information

Job Complated

Details Tags Edit

Created
May 16, 2022 3:54 AM

Rule Set
Drupal 9 Gustom app

7.4.1.3 Compliance job access tab

Users are able to audit which users have access to this particular compliance job, what access group they belong to,
and the associated permissions that each user has on this job. Admins are able to click on the "View" button to
access further details under the access control screen related to that specific user.

Data Compliance Insights  Admin

Masking Jobs
¢ Complancedons  Drupal 9 Custom App Masking

Om CANCEL Ow Copy  Ow Delste

Overview Access Histary O~ Execute  Ow ManageTags  Ow MIGRATE
Ow Read Ow Update
User Access Groups Permigsions
1 = CANCEL o= COPY o= DELETE View >
John Smith
i John Smith > = CANCEL  ©=COPY o= DELETE View >

johnemith @company.com

7.4.1.4 Compliance job execution history tab

The compliance jobs page also includes job execution history. Execution information will be recorded and
displayed on this tab, and includes the status (success, running, failed), run time, submit, and end timestamps, and
engine on which it ran. Additionally, clicking the “details” button for an execution will display its report.
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Home Data Compliance Insights

< Compliance Jobs Compl iancedJob1 .
Overview Access History
Search Search (All)
v
Run Time Submit Time End Time Engine Name
0 May 3, 2023 6:44 PM May 3, 2023 6:44 PM em-masking Details >
0 May 3, 2023 6:44 PM May 3, 2023 6:44 PM em-masking-6013.dc... Details >
0 May 3, 2023 6:44 PM May 3, 2023 6:44 PM em-masking-6013.dc... Details >
1to3of3 Page 1 of 1

7.4.1.5 Compliance job execution details

The execution details view includes a list of execution events and the execution log. This is particularly useful when
troubleshooting failed executions.

Details for successful executions may also have events and logs which include relevant information, such
as warnings.
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Error Report

Execution event Information
This section shows exceptions that occured during the job run. More detailed information may be available in Masking logs.

Execution Events

Event Cause Description
JOB_ABORTED UNHANDLED_EXCEPTION Listener refused the connection with the fall...
Logs

2023-05-05 04:44:13, [thread] INFO com.dmsuite.dmsApplicator.masking. XMLGenerator executeMarshalling - Generate request xml started
successfully.

2023-05-05 04:44:13, [thread] INFO com.dmsuite.dmsApplicator.masking. XMLGenerator executeMarshalling - Generate Request xml done
successfully.

2023-05-05 04:44:13, [thread] INFO com.dmsuite.dmsApplicator.masking.transformation.MaskingMarshalling createKettleXML - Generate
Transformation XML started successfully

2023-05-05 04:44:13, [thread] SEVERE com.dmsuite.dmsApplicator.masking.transformation.MaskingMarshalling handleJobGenerationException - An
exception occurred during job generation

java.sgl.SQLException: Listener refused the connection with the following error:

ORA-12505, TNS:listener does not currently know of SID given in connect descriptor

7.4.1.6 Operations

An Operations page is available under the Admin menu to display the list of all the DCT Jobs across Delphix
infrastructures. It displays the relevant details for the operation, such as status, type of job, target id (refers to the id
of the object on which the operation has been performed), start time, last updated time, etc.
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<« C @ localhost:4200/admin/operations hx # 0@ : |

M Gmail @3 YouTube B¥ Maps € Structure-Jira [ DCT Project Setup.. [ NewTab () APIGW-4024 Add.. [E] India Grooming &.. @ GraphiQL Mesh

Data Compliance Insights Admin

Accounts Operations

Operations shows you all the various operations and their status across Delphix infrastructure.
Access Groups

Roles Search

Authentication

Status D Start Time Last Updated Time Target ID Type
Operations @ Completed e15a8dddfoad467bala... Jun 14,2023 5:20 PM (... 6dag4dd2-5708-4a06-b... DATABASE_TEMPLAT... View >
@ Completed 8e58(6fb6d5a4577860d... Jun 14,2023 3:02 PM (... acfc5873-73fc-40fd-a0d. .. DATABASE_TEMPLAT... View >
& Completed 17a0de0c2baf4deegbat. Jun 14,2023 3:02 PM (. 1762ccea-5d30-410a-8. DATABASE_TEMPLAT. View >
@ Completed 0a8df9dd13aad4adabefs Jun 14,2023 2:45 PM (. £209d72d-1a88-42c2-9 DATABASE_TEMPLAT. View >
& completed 960dc381b7fc4de996cd... Jun 14,2023 2:25 PM (... 8002526b-4e9b-48b6-8... DATABASE_TEMPLAT... View >
& Completed 8dabeal2298475c9c4.... Jun 14,2023 11:31 AM ... cfd7bc0f-7077-4ba0-a6... DATABASE_TEMPLAT... View >
@ Completed 50e2i6fc215c471fa19f2... Jun 12,2023 10:23 PM .. 3586a945-235d-4a02-8.... DATABASE_TEMPLAT... View >
© railed b5ee3103{0f943969965... Jun 12,2023 9:18 PM (... Jun 12,2023 9:19 PM (... 1-ORACLE_DB_CONT... VDB_ENABLE View >
@ Completed d21cfc12fe0340d3atab. .. Jun 12,2023 8:32 PM (... cfd7bc0f-7077-4ba0-ab... DATABASE_TEMPLAT... View >

1to 11 0f 11 < Pagetoft > J

Further details regarding the job, such as engine id, error, or warning logs can be viewed by clicking on the view
link, which navigates to the operation details page.

<« G @ localhost:4200/admi ions/0 14¢3b9311ba3dab74{537 o w »0@ :

M Gmail @B YouTube BP Maps € Structure - Jira [ DCT Project Setup.. [ NewTab () APIGW-4024 Add.. [ India Grooming &.. @ GraphiQL Mesh

Home Data Compliance Insights Admin

Operations > 01a4ffa0a8b14e309311baddab74f537
< Operations  01a4ffa0a8b14e3b9311ba3dab74f537

Details Errors Warnings
Status Unable to route to host rhel-84-oracle-19700-src-ui.dlpxdc.co. No warning logs available.
Failed

Type
VDB_ENABLE

Start Time
Jun 12, 2023 8:25 PM

Last Updated
Jun 12, 2023 8:25 PM

Target ID |
1-ORACLE_DB_CONTAINER-21

Engine ID
1
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7.4.2 Copy job

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

The Masking Job Copy operation creates a duplicate of a job with a separate reference for that new copy. This
operation supports SDLC workflows as DCT will maintain unique references for each instance of a masking job,
enabling them to be managed independently.

fCopy Separate Job
References in DCT
@
DEV QA PROD
o
DEV ENGINE ‘_O\\S QA ENGINE PROD ENGINE
) ) )
Delphix _ ____ R Delphix Delphix
'/ \I ,’ ______________ \| '/ _____________ \l
I
| ! ! 1 I 1
| ! ! I I |
! \ L, ! P I
= I > 1
'l DEV_MASK , : DCT_QA MASK ! i DCT_PROD_MASK !
N e e e e e e e e Vs N ___ S /’ S ,J

7.4.2.1 User interface documentation

Job copy can be run via the DCT Ul by accessing a compliance job's detailed view and selecting the ellipsis in the
top right corner and clicking on "copy". This will open a window to select the target engine, the new name of the
transferred job, source and target environment details, and relevant tags.
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Data Compliance Insights

¢ Complancesobs  Drupal 9 Custom App Masking

Exzcute

Job Status : SUCCEEDED

5 Copy Compliance Job Run Time : 22secs
tarted at 3:09 AM

Test Engina 2
Initializing
Collecting Configurations Fra - i 8 Custem

Preparing

stk

>

Aunning Pre-execution Custom Driver Tasks

pedin-placss masict

Starting

»

Running PreSQL Scripts an: flana ¥ Romowe

»

Running PostSOL Scripts Owner: John Smith ¥ Ramows

»

Running Post-execution Custom Driver Tasks

Enlier Tg K [ ‘ +
Collecting Information

Job Completed Cancel

7.4.2.2 APl documentation

For input, the user must specify the target engine along with the environment on the target engine that the job will
be copied onto. The engine and environment pair is what uniquely identifies a copy of the Masking Job. Calling the
COPY API against the same target engine and environment effectively serves as a re-sync and does not create a new
DCT MaskingJob entity.

Example of copying a MaskingJob to engine with ID 2 and environment named ‘prod-env’:

curl =X '"POST' \
"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
copy' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \

_d l{
"target_engine_id": "2",
"target_environment_id": "prod-env"

} ]

MaskingJob sync will not copy connector credentials to another engine. In order to make a copied job executable
outside of DCT, the credentials must be set on the Connector itself. The connectors for a MaskingJob can be
searched for, updated, and tested directly via DCT.

Example of listing connectors for a MaskingJob:
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curl -X 'GET' \
'"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
connectors' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>'

Example of updating a connector’s credentials:

curl =X '"PATCH' \
'<https://<APPLIANCE_ADDRESS>/v3/connectors/2-DATABASE-23'> \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \

_d l{
"username": "USER123",
"password": "passwordl23"

} 1

Example of testing a connector:

curl =X 'POST' \
'"<https://<APPLIANCE_ADDRESS>/v3/connectors/2-DATABASE-23/test'> \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \

7.4.3 Executejob

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

The Execute endpoint creates a duplicate of a job while maintaining a single reference for both job instances. This
operation supports Horizontal Scale workflows, as DCT will maintain a singular reference for all instances of a job
across any number of connected Compliance engines.

As part of this endpoint, DCT will maintain all of these job instances in sync, so they can all be controlled from a
single configuration point (it's recommended to dedicate a select engine or set of engines to the creation and
updating of masking jobs and dependencies) and any changes are automatically propagated to the other job
instances at the time of the next job execute operation. This enables users to identify a masking job on a
configuration engine, copy it over to a dedicated compute engine (or set of engines), and run that job at a regular
cadence through DCT. Whenever the job needs to be updated, the user simply updates the job on the configuration
engine.

Since all jobs connected via the job execute operation are under a single reference, every time a job is
run, its run statistics will report back to DCT and will be recorded under that singular job reference.
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Executing a MaskingJob requires only a reference to a target engine as input. DCT will take care of syncing the job to
the target engine and executing it. DCT will create and manage the environment where the job is copied onto.

Example of executing a MaskingJob on engine with ID 2:

curl -X '"POST' \

'"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
execute' \

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

_d l{

"engine_id": "2"

} 1

This will return a DCT job that can be further polled for status updates. The job will only transition to the
COMPLETED state when the entirety of the sync and execution has completed on the target engine.

When a MaskingJob is executed via DCT and the job is synced to the target engine, the default Connector is used for
execution. Masking job sync never copies credentials, for security reasons. Since having credentials set on the
target connector is required for execution, DCT enables this by allowing users to store connector credentials within
DCT itself. ADCT MaskingJob now contains properties for the connector credentials. The expectation is that users
will pre-store the credentials by using the UPDATE APl on the MaskingJob. MaskingJob execution has a hard
requirement that credentials be saved within a MaskingJob prior to allowing execution.

Example of updating a MaskingJob with connector credentials:

curl -X 'PATCH' \

'"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead'
\

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

_d l{
"connector_username": "userl23",
"connector_password": "password1l23"

} 1

Once a MaskingJob execution has been initiated, the EXECUTION APIs can be used to view and cancel running
executions as well as search through execution history. Note that canceling an execution is a best-effort action that
does not interrupt any of the job sync that may occur prior to the execution.

Example of searching for executions of a particular MaskingJob:
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"https://<APPLIANCE_ADDRESS>/v3/executions/search' \

-H 'accept: application/json' \

-H 'Authorization: <API_KEY>' \

-H 'Content-Type: application/json' \

-d '{

"filter_expression": "masking_job_id eq '\''d53812ce-9186-485d-
a388-44bc52087ead'\''"
}l

Example of canceling an execution if and only if it is in the RUNNING state (denoted by the expected_status
query parameter):

curl -X '"POST' \
'"https://<APPLIANCE_ADDRESS>/v3/executions/11397caa-6006-4eba-b575-ae3ad00c3762/
cancel' \
-H 'accept: */*' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
_d l{
"expected_status": "QUEUED"
}l

7.4.3.1 Userinterface

Execute a compliance job with the Execute action, available in the action menu on the top right corner of the job
details page. This will open a window that lists Compliance engines with which a job needs to be executed. Once
selected, click the "Execute" button to start the job on the selected engine. The screenshot below shows a selected
engine.

7.4.4 Migrate job

& Compliance Engines limit any syncing operations while a profiling or masking job is running. When using
DCT job move, execute, or migrate operations, please ensure that the target Compliance Engine is in an
idle state. Future Compliance enhancements to DCT will remove this limitation.

The Migrate endpoint moves a job from one engine to another without any duplicates. This endpoint is useful for
consolidating masking jobs (i.e. moving jobs to a fresh engine ahead of the original being retired or consolidating
two development engines into a single one for administrative simplicity). This means that a job will continue to
have only a single instance with no additional jobs being created. This job will maintain its same reference within
DCT.
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Example of finding all MaskingJobs originating from engine with ID 2:

curl =X 'POST' \
'https://<APPLIANCE_ADDRESS>/v3/masking-jobs/source-engines/search' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \
-d '{
"filter_expression": "source_enigne_id eq "\''2"'"\''"

} 1

Example of migrating a MaskingJob to new source engine with ID 3 and placing it in the ‘prod-env’
environment:

curl =X 'POST' \
"https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead/
migrate' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>' \
-H 'Content-Type: application/json' \

_d l{
"target_engine_id": "3",
"target_environment_id": "prod-env"

} ]

7.4.5 Deletejob

Calling the DELETE API on a MaskingJob will effectively remove the record from DCT (and its execution history) as
well as delete the actual masking job on the source engine and on any other engine where the job has been copied
to (as a result of execution). The APl includes a force option to prevent the action from failing in the event that an
engine is unreachable.
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Example of deleting a MaskingJob with the force option:

curl -X 'DELETE' \
'https://<APPLIANCE_ADDRESS>/v3/masking-jobs/d53812ce-9186-485d-a388-44bc52087ead?
force=true' \
-H 'accept: application/json' \
-H 'Authorization: <API_KEY>'

This will return a DCT Job that can be further polled for status updates. Note that if the force option is used and
there are ignored errors, details about those errors will be included in the error_details and warning_message
fields of the DCT Job as follows:

"jOb": {
"id": "722ba51cf70e4e32adbd192b07304bb5",
"status": "COMPLETED",
"type'": "MASKING_JOB_DELETE",
"error_details": "Unable to connect to the engine.",
"warning_message": "Failed to remove local MaskingJob, engineId: 3

localMaskingJobId: 7.",

"target_id": "d53812ce-9186-485d-a388-44bc52087ead",
"start_time": "2022-01-02T05:11:24.148000+00:00",
"update_time": "2022-01-02T06:11:24.148000+00:00"

}
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8 Integrations

Data Control Tower provides a global integration layer for a connected Delphix ecosystem, whether that is a single
or dozens of globally distributed engines, DCT drive a scalable approach to integrating Delphix into any custom
script or automation toolchain.

Aside from the comprehensive API layer (see API references(see page 150) for more detail), DCT powers automation
through Delphix-built and supported integrations with popular applications such as Terraform, ServiceNow, etc.

To see a current list of Delphix integrations, please visit Delphix Integrations®’ for more detail.

37 http://ecosystem.delphix.com
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9 Developer resources

9.1 APIrequests and reporting

9.1.1 Introduction

This article showcases example requests to the various data APIs supported by DCT.

DCT provides interactive APl documentation that allows users to experiment with the APIs in their web browser.
The interactive APl documentation can be accessed by entering the hostname for DCT and the /api path into a

browser's address bar. For example, if DCT is running on host gateway.example.com3, then enter https://
gateway.example.com/api into the browser's address bar.

To simplify development, Python and Go programming libraries are available. The Python bindings can be found
on PyPi here3. The latest version can be installed with the following command:

pip install delphix-dct

The Go bindings can be found on go.dev here®?,

9.1.2 Engines

This section showcases some examples of querying the Engines endpoint for information about connected Delphix
Virtualization Engines. These examples leverage the generated Python bindings:

import delphix.api.gateway

import delphix.api.gateway.configuration

import delphix.api.gateway.api.management_api

cfg = delphix.api.gateway.configuration.Configuration()
cfg.host = "https://localhost/v2"

# For example purposes
cfg.verify_ssl = False

# Replace the string with your own API key

cfg.api_key['ApiKeyAuth'] = 'apk 3.tEd4DXFce'
api_client = delphix.api.gateway.ApiClient(configuration=cfg)
engines_api = delphix.api.gateway.api.management_api.ManagementApi(api_client)

print(engines_api.get_registered_engines())

The result should appear similar to the following:

38 http://gateway.example.com/
39 https://pypi.org/project/delphix-dct-api/
40 https://pkg.go.dev/github.com/delphix/dct-sdk-go
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{'items': [{'connection_status': 'ONLINE',
'cpu_core_count': 2,
'data_storage_capacity': 23404216320,
'data_storage_used': 11589626880,
'"hostname': 'avm.delphix.com',

'id': 1,

"insecure_ssl': True,
'memory_size': 8589934592,

'name': 'vmname',

"password': Hkkkxxx!',

'status': 'CREATED',

'tags': [,

'type': 'UNSET',
'unsafe_ssl_hostname_check': False,
'username': 'admin',

'uuid': 'ec2fbfea-928b-07f8-94c4-29feab14624f',
'version': '6.1.0.0'}]}

9.2 APl references

To access the API list for DCT version 8.0.0, click the link below and the .html file with the API content will download.

AP13.3.0 (DCT v8.0.0).h...

(see page 150)
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